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I. Prise en main

Cette première partie constitue une introduction aux logiciels SIG de manière générale et à QGIS
en particulier.

Notions abordées :

Qu'est-ce qu'un SIG?
Ajout de données vecteur
Propriétés d'une couche
La table attributaire
Formats de données vecteur
Espace de travail : le projet QGS

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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I.1 Qu'est-ce qu'un SIG ? (un peu de théorie...)

Définitions
Qu'est-ce que la géomatique ?
Qu'est-ce qu'un Système d'Information Géographique ?

Les données des SIG
Une organisation par couches
Deux grands types de données : vecteur et raster
Les données vecteur : à chaque géométrie ses attributs (et vice-versa)
Des données sur les données : les métadonnées
A quoi sert un SIG ?

Définitions

Qu'est-ce que la géomatique ?

La géomatique est l'ensemble des techniques de traitement informatique des données
géographiques (Journal O@ciel, 1994). Elle regroupe donc les outils et méthodes permettant
l'acquisition, le stockage, le traitement et la diffusion de données à référence spatiale.

Qu'est-ce qu'un Système d'Information Géographique ?

C'est un système permettant de gérer des informations localisées géographiquement. Ce système
est composé de :

données
logiciels
matériel informatique
savoir-faire
utilisateurs

Par abus de langage, un SIG signifie souvent aujourd'hui le logiciel utilisé dans un SIG.

Les données des SIG

Une organisation par couches

Les données sont organisées sous forme de couches superposables.
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Source : pôle ARD, adess (domaine public)

Lancez le logiciel QGIS. Ouvrez un projet : 

Sélectionnez le projet senegal.qgs situé dans TutoQIS_01_PriseEnMain/projets, cliquez sur
Ouvrir.

Trois couches de données sont a@chées dans QGIS, correspondant aux villes, rivières et
régions du Sénégal.

Deux grands types de données : vecteur et raster

On distingue généralement deux types de données : vecteur et raster.

Exemple de données vecteur, l'exemple du Sénégal : régions sous forme de polygones, rivières sous forme de lignes
et villes sous forme de points (source : pôle ARD, adess, domaine public).

Les données vecteurs se déDnissent uniquement par des coordonnées. On trouvera des données
vecteurs de type point, ligne et polygone. Un point sera déDni par un couple de coordonnées XY,
une ligne ou un polygone par les coordonnées de leurs sommets. Une couche vecteur sera soit de
type point, soit de type ligne, soit de type polygone, mais ne pourra contenir de données de deux
types diGérents (sauf dans le cas particuliers de certains formats qui ne seront pas abordés dans
ce tutoriel).

On pourra choisir par exemple de représenter des cours d'eau sous forme de ligne, des villes sous
forme de points...

Les données vecteur sont généralement moins volumineuses que les données raster. Quelques
exemples de formats vecteur : SVG, AI, SHP...

Les données raster, ou images, sont constituées de pixels. En zoomant sur un raster, on Dnit par
distinguer les pixels. Chaque pixel possède une valeur correspondant par exemple à sa couleur,
ou à son altitude. Un raster est caractérisé par la taille d'un pixel, ou résolution. Exemples de
données raster : carte IGN scannée, photographie aérienne, image satellite...

Menu Projet → Ouvrir
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Exemple de données raster (source :
IGN).

Quelques exemples de formats raster : JPG, TIFF, PNG...

Les données vecteur : à chaque géométrie ses attributs (et vice-versa)

On distingue deux composantes dans les données utilisées dans un SIG : spatiale et attributaire.
La composante spatiale est constituée de la localisation et la géométrie d'un objet, donc de ses
coordonnées. La composante attributaire est constituée des données qui y sont associées. Par
exemple, la composante spatiale d'un département sera le polygone représentant ce
département, et sa composante attributaire sera son nom, son code, sa population...

Données spatiales et attributaires d'une couche SIG (source : données Geofla
IGN)

Le lien entre composante spatiale et attributaire constitue une diGérence fondamentale avec les
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logiciels de dessin (DAO) type AutoCAD.

Ouvrez le projet depts_france.qgs qui se trouve situé dans le dossier
TutoQIS_01_PriseEnMain/projets.

Ouvrez la table attributaire de la couche de départements : 

Sélectionner un département dans la table attributaire, en cliquant sur le numéro de la ligne.
Le département correspondant apparaît dans une couleur diGérente (jaune par défaut) dans la
carte.

Vous pouvez ensuite cliquer sur l'outil zoomer sur la sélection pour zoomer sur ce
département

Vous pouvez maintenant faire l'inverse : sélectionner un département sur la carte, au
moyen de l'outil de sélection. La ligne correspondante passe alors en surbrillance dans
la table attributaire.

Vous pouvez choisir Ne montrer que les entités sélectionnées  dans la liste déroulante en
bas à gauche de la table, pour ne voir que les lignes correspondant aux départements
sélectionnés.

Pour que la fenêtre de la table attributaire soit "ancrée" dans QGIS : menu Préférences → Options →
Source de données : cocher la case Ouvrir la table d'attributs dans une fenêtre intégrée. Contrairement
à ce qui est écrit, cette modification est prise en compte directement sans besoin de redémarrer QGIS.

Des données sur les données : les métadonnées

ADn de savoir quelles sont les utilisations que l'on peut faire d'une donnée, il est indispensable de
posséder des informations sur la manière dont a été fabriquée cette donnée, sa date, ses limites
éventuelles d'utilisation... Ces « données sur la donnée » constituent ce qu'on appelle des
métadonnées. Elles peuvent se présenter sous diverses formes : un simple Dchier texte, une Dche
PDF...

Vous pouvez voir ici les métadonnées de la couche Corine Land Cover :
www.geocatalogue.fr/Detail.do?id=7665 [↗]

Il existe aujourd'hui des normes régissant la manière dont sont construites ces métadonnées :
nombres de rubriques présentes, choix des rubriques... Ceci permet de construire des catalogues

Clic droit sur le nom de la couche → Ouvrir la table d'attributs
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de métadonnées, et facilite in fine l'échange de données entre organismes.

La métadonnée ci-dessus est tirée du catalogue de métadonnées de l'IGN, le géocatalogue :
www.geocatalogue.fr [↗]

A quoi sert un SIG ?

Un SIG permet de saisir, représenter, interroger, et mettre à jour l’information géographique. Il
peut notamment répondre aux questions suivantes :

où : localisation, étendue
quoi : quelles informations
comment : analyse spatiale
quand : analyse temporelle
et si... : modélisation

Les SIG sont utilisés aujourd'hui dans des domaines très variés : géographie, géologie, écologie,
urbanisme, archéologie, économie...

On peut par exemple chercher à répondre à la question : "la taille des parcelles de vignes est-elle
corrélée avec la pente et l'altitude de la parcelle, sur une zone donnée?"

Les données nécessaires seront une couche contenant les parcelles de vignes, et un Modèle
Numérique de Terrain (MNT) [↗] de la zone d'étude. La résolution du MNT devra être su@sante
en comparaison de la taille moyenne des parcelles.

Le SIG va permettre de croiser les parcelles et le MNT pour aboutir à une couche de parcelles où
seront renseignées pour chaque parcelle par exemple sa taille, sa pente moyenne, son altitude
moyenne. Ces données pourront être ensuite visualisées dans le SIG, et/ou être le point de départ
d'analyses statistiques dans un autre logiciel.
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I.2 Manipuler de l'information géographique

Ajout d'une couche de données vecteur
L'interface de QGIS
Propriétés d'une couche

Changer la représentation d'une couche
Connaître l'emplacement d'une couche

Ajout d'une couche raster
Propriétés d'une couche raster : modifier le style

Ajout d'une couche de données vecteur

Lancez QGIS. Pour ajouter une couche vecteur, trois solutions, au choix :

cliquer sur l'icône Ajouter une couche vecteur

utiliser le raccourci clavier ctrl + majuscule + v

Type de source et encodage : laissez les valeurs par défaut. Pour en savoir plus sur ce qu'est
l'encodage : http://fr.wikipedia.org/wiki/Codage_de_caractères [↗]

Cliquez sur Parcourir et sélectionnez la couche depts_aqui_geofla.shp située dans le dossier
TutoQGIS_01_PriseEnMain/donnees.

Cliquez sur Ouvrir : vous pouvez voir à l'écran les départements aquitains.

L'interface de QGIS

Menu couche → Ajouter une couche vecteur...
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On peut distinguer 6 zones dans QGIS :

1. Menus

2. Barres d'outils . On y trouve la même chose que dans les menus, mais sous forme d'icônes.
Pour savoir que fait un outil, passez la souris au-dessus et lisez l'infobulle. Pour rajouter ou
enlever des barres d'outils, clic-droit n'importe où dans cette zone sauf sur un outil désactivé,
cocher ou décocher les barres d'outils voulues.

3. Liste des couches chargées, aussi appelée table des matières ou table of contents  (TOC). Si
plusieurs couches sont présentes, vous pouvez en modiDer ici l'ordre d'a@chage. Pour faire
apparaître ou disparaître cette zone : menu Vue → Panneaux → Couches

4. Panneaux supplémentaires, par exemple le panneau Parcourir. Pour ajouter des panneaux,
Menu Vue → Panneaux

5. Zone de visualisation. On peut zoomer ou se déplacer dans cette zone.

6. Barre d'état. On y trouve les coordonnées du point où se trouve la souris, l'échelle...

Testez les différents boutons de zoom et de déplacement.

Pouvez-vous déterminer l'eGet de chacun d'entre eux? A noter : on peut aussi zoomer et
dézoomer en utilisant la molette de la souris, ainsi que le trackpad.
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Vous pouvez aussi vous déplacer dans la carte (équivalent de l'outil "main") en maintenant la
touche espace appuyée, quelque soit l'outil en cours dans QGIS. Le même résultat est obtenu
en maintenant la molette de la souris enfoncée (clic molette prolongé).

Propriétés d'une couche vecteur

Pour accéder aux propriétés de la couche, clic-droit sur le nom de la couche dans la table des
matières, (ou bien double-clic sur le nom de la couche).

Vous avez accès ici à plusieurs propriétés, notamment :

1. la manière dont la couche est représentée, dans la rubrique Style. Vous pouvez par
exemple changer ici la couleur des départements

2. l'emplacement de la couche, dans la rubrique Général

Changer la représentation d'une couche

Dans les propriétés de la couche, rubrique Style :

Cliquez sur Remplissage simple.

Propriétés 
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1 . Dans la partie Couleurs, vous pouvez modiDer la couleur du fond et de la bordure des
départements.

2. Vous pouvez également modiDer le style de remplissage : plein, vide, hachures... ainsi que le
style de la bordure  : ligne continue, pas de bordure, pointillés...

3. La largeur de la bordure  peut aussi être modifiée.

Essayez de donner à votre couche ces différents styles :

  

Connaître l'emplacement d'une couche

La couche est stockée à l'endroit indiqué dans la partie Source de la couche. Cet emplacement

Dans les propriétés de la couche, rubrique Général : pouvez-vous dire à quel endroit est
stockée la couche depts_aqui_geofla sur votre ordinateur?
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Ajout d'une couche raster

Comme lors de l'ajout d'une couche vecteur, vous avez plusieurs possibilités pour ajouter une
couche raster :

cliquer sur l'icône Ajouter une couche raster
utiliser le raccourci clavier ctrl + majuscule + r

varie bien sûr en fonction de l'endroit où vous avez enregistré les données du tutoriel. 

Menu couche → Ajouter une couche raster...
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Rendez-vous dans le dossier TutoQGIS_01_PriseEnMain/donnees et sélectionnez la couche
srtm_aqui.tif.

Cliquez sur Ouvrir : la couche s'affiche.
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Il s'agit d'un modèle d'élévation numérique [↗] : chaque pixel possède une valeur correspondant à
l'altitude en mètres des éléments présents au sol. Si une forêt est présente, ce sera donc l'altitude
du sommet des arbres qui sera mesurée et non l'altitude du sol, idem si des bâtiments sont
présents.

Après avoir sélectionné la couche srtm_aqui.tif en cliquant sur son nom dans la table des
matières, utilisez l'outil Identi@er les entités pour cliquer sur un point du raster et connaître
l'altitude de ce point.
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Par exemple, ici, c'est un point d'altitude 66 mètres qui a été identifié.

Propriétés d'une couche raster : modifier le style

Comme pour accéder aux propriétés d'une couche vecteur, clic-droit sur le nom de la couche
dans la table des matières, Propriétés (ou bien double-clic sur le nom de la couche).

Pour une couche raster, les diGérentes rubriques des propriétés sont un peu diGérentes de
celles d'une couche vecteur ; on retrouve néanmoins les rubriques Général et Style.

Rendez-vous dans la rubrique Style :

Pour ce raster, les valeurs minimum sont représentées en blanc et les valeurs maximum en
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noir : plus l'altitude est élevée, plus le point est foncé.

Vous pouvez modiDer les valeurs minimum et maximum, et inverser les couleurs en
choisissant Noir vers blanc  au lieu de Blanc vers noir . Cliquez à chaque fois sur Appliquer en
bas de la fenêtre pour voir le résultat de vos changements.
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I.3 Formats de données SIG

Formats vecteur : SHP et TAB
Format Shapefile ou SHP : un "standard"
Format TAB (MapInfo)

Un exemple de format raster : le GeoTIFF
Application

Réduire la fenêtre de QGIS. Ouvrir dans l'explorateur de Dchiers de votre ordinateur le dossier
TutoQGIS_01_PriseEnMain/donnees

Si dans Windows, vous ne voyez pas les extensions de tous les Jchiers : dans la fenêtre, Outils → Options des
dossier, onglet Affichage, décocher la case "Masquer les extensions dont le type est connu".

Formats vecteur : SHP et TAB

Format Shapefile ou SHP : un "standard"

Le format shapeDle a été créé par ESRI, l'auteur notamment du logiciel ArcGIS. Ce format est
aujourd'hui l'un des standards du SIG et est couramment utilisé par les logiciels libres de SIG.

Un fichier SHP est en fait composé de plusieurs fichiers, dont 3 sont obligatoires :

SHP : contient les informations spatiales
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DBF : contient les informations attributaires
SHX : fichier d'index

Le format DBF impose certaines limitations pour les noms de colonnes : maximum 10 caractères,
éviter les accents...

Un 4ème fichier est aussi bien utile :

PRJ : contient le code du système de coordonnées et éventuellement de la projection

Pour que le shapeDle s'ouvre correctement, tous ces Dchiers doivent avoir exactement le même
nom. QGIS peut ouvrir et éditer les fichiers SHP.

Format TAB (MapInfo)

Ce format a été créé pour le logiciel MapInfo. Comme pour le SHP, un Dchier au format TAB est en
fait composé de plusieurs fichiers :

MAP : données spatiales (avec le système de coordonnées)
DAT : données attributaires
TAB : structure de la couche
ID : lien entre les fichiers DAT et MAP
IND : fichier d'indexation (facultatif)

QGIS peut ouvrir des Dchiers au format TAB, mais il ne peut pas les éditer; il faudra pour cela les
enregistrer au format SHP.

Un exemple de format raster : le GeoTIFF

Vous avez peut-être déjà manipulé des images au format TIF. Les TIF utilisés dans les logiciels SIG
possèdent des informations en plus par rapport aux TIF "classiques" : quel type de coordonnées
est utilisé, quelles sont les coordonnées de l'image... Il s'agit alors d'un cas particulier de TIF
nommé GeoTIFF.

L'extension du Dchier reste TIF. Cependant, chargé dans un logiciel SIG, ce TIF s'a@chera
directement au bon endroit.

D'autres fichiers peuvent être associés à un raster :

QML : ce Dchier facultatif sauvegarde le mode de représentation du raster : du noir vers le
blanc, valeur minimum et maximum. S'il n'est pas présent, le raster s'a@chera avec des
paramètres par défaut. Il est propre à QGIS.

AUX.XML : ce Dchier parfois présent sauvegarde des statistiques et parfois le système de
coordonnées de l'image. Il permet d'accélérer l'a@chage et certains traitements. Ce Dchier
est également lisible par le logiciel ArcGIS.

TFW : souvent appelé "World file" [↗], ce fichier stocke les coordonnées de l'image et la taille
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des pixels. Ce type de Dchier existe pour plusieurs formats d'image : l'extension sera JGW
pour un JPG, PGW pour un PNG etc. Ce Dchier n'est pas nécessaire si les informations sont
déjà contenues dans l'en-tête de l'image (ce qui est le cas pour notre GeoTIFF). Les world Dle
sont de moins en moins utilisés dans les SIG ; ils peuvent cependant être utiles pour un
logiciel non SIG ou pour un format d'image ne permettant pas le stockage d'informations de
localisation dans son en-tête.

Application

Le dossier contient 4 couches au format SHP : depts_aqui_geofla, senegal_regions_gadm,
senegal_rivieres_fao et senegal_villes_geonames, une couche au format TAB :
depts_france_geofla et une couche au format GeoTIFF avec un Jchier de style QML et un Jchier
AUX.XML associés : srtm_aqui.

Combien de couches sont présentes dans le dossier
TutoQGIS_01_PriseEnMain/donnees? En quel format est chaque couche ?

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 20/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


I.4 Espace de travail (projet QGS)

Qu'est-ce qu'un projet dans un logiciel SIG?
Comment un projet appelle-t-il les données?

Qu'est-ce qu'un projet dans un logiciel SIG?

Un projet est un espace de travail. Sauvegarder un projet équivaut à sauvegarder le style utilisé
pour chaque couche, le zoom... mais pas les données!

senegal.qgs situé dans le dossier TutoQGIS_01_PriseEnMain/projets.
Modifiez le zoom et le style des couches.

Sauvegardez votre projet sous un nouveau nom : clic sur l'icône correspondante, ou
bien 

Enregistrez votre projet dans le répertoire TutoQGIS_01_PriseEnMain/projets, sous le nom
senegal_02.qgs . Cette opération crée un fichier au format QGS.

Le fichier QGS est l'équivalent du WOR sous MapInfo et du MXD sous ArcGIS.

Masquez QGIS, et ouvrez ensuite ce fichier QGS au moyen d'un éditeur de texte type bloc-notes
: vous pouvez y trouver le chemin des couches chargées dans le projet, la description des
couleurs utilisées... Fermez ce fichier.

Il n'est bien sûr pas utile de comprendre en détail le contenu du Dchier QGS, mais il est important
de noter qu'il ne s'agit que d'un @chier texte, qui va "appeler" les données . Si vous fournissez à
un collègue votre seul Dchier QGS, sans les données correspondantes, ce collègue ne pourra pas
visualiser les données.

Comment un projet appelle-t-il les données?

Le chemin des couches peut être stocké de deux manières dans le fichier QGS :

1. soit par rapport  à l'emplacement du QGS
2. soit "en dur", sous la forme du chemin en entier

1. Par exemple, ../donnees/senegal_regions_gadm.shp signiDe qu'il faut remonter d'un dossier
par rapport au dossier dans lequel est situé le projet, puis descendre dans le dossier donnees
pour y trouver la couche senegal_regions.shp

2. Un exemple de chemin "en dur" :

Ouvrez le projet 

Menu Projet → Sauvegarder sous...
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D:/Travail/SIG/TutoQGIS_01_PriseEnMain/donnees/senegal_regions_gadm.shp

Dans QGIS, par défaut les chemins sont sauvegardés en relatif , ce qui permet de transmettre à
un collègue un dossier avec par exemple un sous-dossier données et un sous-dossier projets.

Si vous désirez changer ce comportement pour un projet, 
, changez la propriété Enregistrer les chemins de relatif à absolu.

Si vous déplacez des couches et que vous ouvrez ensuite un projet QGS qui utilise ces
couches, vous obtiendrez un message d'erreur : le chemin des couches a changé et ne
correspond plus à ce qui est indiqué dans le QGS!

Il sera néanmoins possible de spécifier à nouveau les emplacements des couches du projet.

Menu Projet → Propriétés du projet... → rubrique
Général 
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II. Géodésie

La géodésie est la science qui étudie la forme et les dimensions de la Terre. Cette deuxième partie
abordera les diGérentes manières d'exprimer des coordonnées, et comment cela se traduit-il dans
un logiciel SIG.

Notions abordées :

ellipsoïde et géoïde
coordonnées géographiques
coordonnées projetées
système de coordonnées d'une couche
système de coordonnées d'un projet

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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II.1 Introduction à la géodésie

Bref historique
Deux notions préliminaires : géoïde et ellipsoïde

Bref historique

La géodésie est la science qui étudie la forme et les dimensions de la Terre, en tenant compte de
son champ de pesanteur..

La géodésie est une science ancienne; on attribue à Eratosthène [↗] la première mesure de la
circonférence de la Terre, qu'il évalua à environ 39 375 km, mesure proche de la réalité puisque les
estimations actuelles donnent environ 40 075 km.

Deux notions préliminaires : géoïde et ellipsoïde

La surface de la Terre est très irrégulière et complexe on peut la modéliser de diGérentes
manières.

La sphère est le modèle le plus simple.

L'ellipsoïde est une sphère aplatie, plus simple à modéliser. On le déDnit généralement par ses
demis-axes (a, b et c) et son centre ( O).

Ellipsoïde (Source : Peter Mercator, Wikimedia Commons, licence Creative Commons Attribution-Share Alike 3.0
Unported).

Le géoïde est une surface perpendiculaire en tout point à la direction de la gravité (Dl à plomb).
Cette surface passe par le niveau moyen des mers. Les altitudes sont mesurées par rapport au
géoïde depuis les années 1960 (altitude normale). On peut considérer le géoïde comme un sphère
cabossée. C'est une représentation exacte mais compliquée à utiliser.
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Géoïde (Source : NASA, Wikimedia Commons, domaine public)

Il existe une inDnité d'ellipsoïdes, qui peuvent coïncider avec la surface de la Terre sur toute leur
surface (ellipsoïde global) ou seulement sur une partie de leur surface (ellipsoïde local). A l'inverse,
il n'existe qu'un seul géoïde.

Géoïde et ellipsoïdes (Source : pôle ARD, adess, domaine public)
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II.2 Des coordonnées, oui mais dans quel système?

Systèmes de coordonnées
Qu'est-ce qu'un système de coordonnées?
Quelques exemples de systèmes de coordonnées

Coordonnées en deux dimensions : les projections
Qu'est-ce qu'une projection?
Trois grands types de projections : cylindriques, coniques et azimutales
A chaque projection ses déformations
Quelques exemples de projections

A retenir
Quelques ressources internet

Les coordonnées peuvent être exprimées en degrés, en mètres... et dans des référentiels
diGérents. Un même point aura des coordonnées diGérentes selon le système de coordonnées
utilisé.

Systèmes de coordonnées

Qu'est-ce qu'un système de coordonnées?

Un système de coordonnées est un système utilisé pour mesurer des coordonnées. Il peut être
déDni par un ellipsoïde. Un point sera alors localisé par ses coordonnées géographiques,
exprimées par la latitude Ф, la longitude λ, et la hauteur ellipsoïdale h mesurée suivant la normale
à l'ellipsoïde.
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Coordonnées géographiques : latitude et longitude (source : pôle ARD, adess, domaine
public).

Longitude et latitude sont des mesures d'angles et peuvent être exprimées en degrés, en grades
ou en radians.

Attention à ne pas confondre la hauteur ellipsoïdale, mesurée par rapport à l'ellipsoïde, et l'altitude normale
mesurée par rapport au géoïde. Avant les années 1960, les altitudes étaient mesurées par rapport au niveau de
la mer (altitude orthométrique).

Quelques exemples de systèmes de coordonnées

Il existe de nombreux systèmes de coordonnées. Ils sont recensés par l'EPSG (European Petroleum
Survey Group) qui a attribué un code à chacun. Quelques exemples :

WGS84 (World Geodetic System 1984) :  
Système global initialement mis au point par le département de la défense des États Unis en 1984,
mis à jour en 2004. Son exactitude est métrique, et son ellipsoïde se nomme IAG-GRS80.

RGF93 (Réseau Géodésique Français 1993) :  
Système global obtenu par densiDcation des points du réseau mondial associé ETRS89. Il s'agit du
système officiel français. Ce système est facilement compatible avec le WGS84 par exemple.

ED50 (European Datum 1950) :  
Système européen mis en place à la suite de la seconde guerre mondiale. Son ellipsoïde associé se
nomme Hayford 1909.

NTF (Nouvelle Triangulation de la France) :  
Système local issu de mesures réalisées depuis la Dn du XIXème jusqu'en 1991. Son ellipsoïde
associé est Clarke 1880 et son méridien d'origine Paris.

En France, le système NTF a été abandonné au proJt du système RGF93 qui présente une meilleure compatibilité
avec les autres systèmes mondiaux. Il existe toutefois encore aujourd'hui de nombreuses données utilisant le
système NTF.
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Certains systèmes seront adaptés à une zone précise, d'autre à la Terre entière. Plusieurs
systèmes coexistent souvent pour une même zone, en raison par exemple de l'avancée des
techniques ou de règlements.

Un même point aura des coordonnées différentes selon le système utilisé pour les mesurer .
Le tableau ci-dessous montre les coordonnées de Paris dans différents systèmes.

Coordonnées de Paris mesurées dans différents systèmes.

Système de coordonnées Code Latitude (en degrés) Longitude (en degrés)

WGS84 EPSG:4326 48,856700 2,351000

ED50 EPSG:4230 48,857615 2,352286

RGF93 EPSG:4171 48,856700 2,351000

NTF EPSG:4807 48,856769 0,014494

On sait maintenant comment un point peut être dé@ni par 3 coordonnées X, Y et Z.
Comment représenter maintenant la Terre en 2 dimensions, pour en faire une carte par
exemple?

Coordonnées en deux dimensions : les projections

Qu'est-ce qu'une projection?

Le principe est de projeter des données 3D sur une surface plane . Il y aura donc forcément
des déformations : pensez à une peau d'orange qu'on écrase, et qui va se déchirer.

On appelle projection cartographique le système de correspondance entre les coordonnées
géographiques (donc mesurées avec un système de référence) et les points du plan de projection.

De nombreuses méthodes de projections existent, chacune adaptée à un usage différent.

Lorsqu'on utilise une projection, on parle de coordonnées projetées. Ces coordonnées sont par
définition bidimensionnelles, et seront exprimées généralement en unités métriques.

Une projection permet donc de représenter sur une surface plane une partie d'un modèle
ellipsoïdal, mais aussi :

d'obtenir des valeurs métriques plus facilement exploitables que les valeurs angulaires de
latitude et longitude
de rendre plus facile une évaluation des distances

Trois grands types de projections : cylindriques, coniques et azimutales

Dans tous les cas, on va projeter la surface de la Terre sur une forme que l'on peut dérouler pour
obtenir une surface plane : un cylindre, un cône ou un plan. On distingue ainsi les projections
cylindriques, coniques et azimutales. Il existe d'autres types de projections.
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Projection cylindrique, conique et azimutale (Source : Traroth, Wikimedia Commons, licence GFDL).

A chaque projection ses déformations

On peut aussi classer les projections selon leurs propriétés. On distingue ainsi :

les projections équivalentes qui conservent les surfaces
les projections conformes qui conservent les angles.
les projections aphylactiques, ni conformes ni équivalentes. Elles peuvent être
équidistantes, c'est-à-dire conserver les distances sur les méridiens.

Une projection ne peut être à la fois conforme et équivalente.

Pour visualiser les déformations liées à une projection, on peut utiliser les indicatrices de Tissot.
Ce sont des cercles identiques dessinés sur la Terre avant projection, qui se retrouveront donc
déformés après projection. Si la projection déforme les angles, les cercles seront transformés en
ellipses, si elle déforme les surfaces les cercles auront des surfaces différentes.

Quelques exemples de projections

Projection cylindrique conforme de Mercator  
Cette projection conserve les angles, mais déforme de plus en plus les surfaces au fur et à mesure
qu'on se rapproche des pôles. Elle est largement utilisée, notamment par Google.
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Projection de Mercator (source : Eric Gaba – utilisateur Wikimedia Commons : Sting, licence
GFDL).

Projection cylindrique équivalente de Peters  
Cette projection permet une vision juste des proportions des surfaces des continents, mais ne
garde pas les bonnes formes au contraire de la carte de Mercator. Elle permet notamment d'éviter
de sous-dimensionner les pays du Sud.

Projection de Peters (source : Eric Gaba – utilisateur Wikimedia Commons : Sting, licence
GFDL).

Projection conique conforme de Lambert  
Contrairement aux projection de Mercator et Peters, cette projection est utilisée pour représenter
seulement une partie du globe. Suivant ses paramètres, la zone couverte sera diGérente.
L'illustration montre la projection Lambert 93, projection o@cielle française : les déformations
sont minimisées pour la France.
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Projection Lambert 93 (source : pôle ARD, adess, domaine public)

Projection azimutale équidistante du pôle sud  

Projection azimutale équidistante pôle sud (source : pôle ARD, adess, domaine public)

Projection Transverse Universelle de Mercator (UTM)  
Il s'agit en fait d'une série de projections, le monde étant divisé en 60 fuseaux [↗] de 6° de
longitude. Une projection diGérente est utilisée pour chaque fuseau : le cylindre utilisé subit à
chaque fois une rotation légèrement diGérente. Ceci permet de minimiser les déformations. La
France est ainsi traversée par 3 fuseaux : 30, 31 et 32. Cette projection peut être associée au
système WGS84, ou ED50 par exemple. 
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Projection UTM : rotation d'un cylindre autour de la Terre.
Par Javiersanp (Travail personnel) [CC-BY-SA-3.0 [↗] ou GFDL [↗]], via Wikimedia

Commons [↗]

Un même point aura des coordonnées diRérentes selon la projection utilisée  (et le système
associé à cette projection). Ci-dessous, les coordonnées de Paris mesurées dans diGérents
sytèmes et projections.

Coordonnées de Paris mesurées dans différents systèmes et projections.

Système et projection Code X (en mètres) Y (en mètres)

Mercator EPSG:54004 261712.122 6218386.300

Peters SR-ORG:22 185368.909 6753027.140

RGF93 Lambert93 EPSG:2154 652381.068 6862047.100

Azimutale équidistante pôle sud EPSG:102019 632368.408 15402681.400

Il existe d'autres types de projections, ni cylindriques, conformes ou azimutales.

En résumé, la projection parfaite n'existe pas  ; il faut essayer de faire au mieux pour l'usage
auquel on destine la carte (à ce sujet, vous pouvez voir ce Dlm [↗]). Par exemple, les cartes
utilisées pour la navigation conservent généralement les angles et non les distances. L'échelle de
la carte influe également sur le choix de la projection.

A retenir

On peut exprimer les coordonnées d'un point :

sous forme de coordonnées géographiques en degrés : latitude, longitude, hauteur
ellipsoïdale. Ces coordonnées sont calculées dans un système géodésique de référence,
sans utilisation de projection
sous forme de coordonnées en projection en mètres (représentation plane), calculées dans
un système géodésique de référence et avec une projection cartographique

Exemple : les coordonnées de Paris peuvent être exprimées sous forme de coordonnées
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géographiques en degrés dans le système RGF93, ou bien sous forme de coordonnées projetées
en mètres dans le même système RGF93 avec en plus utilisation de la projection Lambert 93.

Il est à noter que la projection Lambert 93 a été conçue pour être utilisée uniquement avec le système RGF93.

Chaque ensemble système de coordonnées et projection s'il y en a une, ou simplement système
de coordonnées, est référencé par un code, généralement défini par l'EPSG.

Pour simpli@er, dans le reste de ce tutoriel, le système de coordonnées et sa projection
associée s'il y en a une seront nommés SCR (Système de Coordonnées de Référence) suivant
la terminologie utilisée par QGIS.

Quelques ressources internet

Comprendre le principe des projections : la carte impossible [↗]
Liste des systèmes de coordonnées avec leurs codes EPSG ou autre :
http://spatialreference.org/ [↗]
Pour mettre en évidence les déformations liées à la projection Google Mercator :
mapfrappe [↗]
Comparaison de projections : http://bl.ocks.org/syntagmatic/3711245 [↗]
Aide au choix d'une projection : http://people.oregonstate.edu/~savricb/selectiontool/ [↗]

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 33/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

https://www.onf.ca/film/carte_impossible#temp-share-panel
http://spatialreference.org/
http://mapfrappe.blogspot.fr/2011/01/mapfrappe-examples-index.html
http://bl.ocks.org/syntagmatic/3711245
http://people.oregonstate.edu/~savricb/selectiontool/
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


II.3 Couches et projets : à chacun son système

SCR du projet
SCR d'une couche
Projection à la volée

SCR du projet

A partir de QGIS, regions_france.qgs situé dans le dossier
TutoQGIS_02_geodesie/projets.

Toutes les couches chargées dans ce projet seront affichées dans le SCR du projet. Quel est ce
SCR? Trois manières pour accéder à cette information :

, rubrique SCR

Icône statut de la projection  tout en bas à droite de la fenêtre de QGIS 

raccourci clavier Ctrl+Maj+P → rubrique SCR

La fenêtre suivante s'ouvre :

ouvrez le projet 

Menu Projet → Propriétés du projet... 
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SCR du projet.

1. Projection à la volée : cette fonctionnalité sera décrite dans la partie Projection à la volée.

2. Partie "recherche" : vous pouvez taper ici un code ou un nom pour rechercher un SCR précis.

3 . Liste des derniers SCR utilisés (cette partie peut être vide). Cette liste permet d'accéder
facilement aux SCR que vous utilisez souvent.

4 . Liste de tous les SCR disponibles dans QGIS . Ils sont classés selon 3 grandes rubriques :
systèmes de coordonnées géographiques, systèmes de coordonnées projetés et systèmes de
coordonnées déDnis par l'utilisateur (soit qu'ils aient été créés par vous-même, soit qu'ils aient été
lus par QGIS dans une couche).

5. SCR actuellement utilisé par le projet

La rubrique SCR de la fenêtre des propriétés du projet permet donc de modiDer le système de
coordonnées du projet, ou bien simplement de vériDer quel est ce système, ce que nous nous
bornerons à faire pour le moment.

A votre avis, quel est le SCR du projet?

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 35/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/2_3_scr_projet.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


Notez également que le code du SCR du projet est indiqué tout en bas à droite de la fenêtre de
QGIS, dans la barre d'état de QGIS (cf. I.2 Interface de QGIS).

SCR d'une couche

Nous allons maintenant nous poser la question de savoir dans quel SCR est la couche
Reg_France_Geofla_L93.

et allez dans la rubrique Général.

Lire le SCR d'une couche.

Vous avez donc pu constater que notre projet et la couche qui y est présente ont deux SCR
différents. Comment cela est-il possible?

Le projet est en WGS84, comme indiqué dans la partie 5 de la fenêtre.

Ouvrez les propriétés de cette couche 

Cette couche est en RGF93 / Lambert-93, code EPSG 2154.

A votre avis, quel est le SCR de la couche Reg_France_Geofla_L93 ?

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 36/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/2_3_barre_etat_scr.png
illustrations/tous/2_3_scr_couche.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


Projection à la volée

La projection à la volée est une fonctionnalité qui permet d'a@cher des couches dans un autre
SCR que le leur, le SCR du projet.

Ainsi, la couche Reg_France_Geofla_L93 est a@chée en WGS84 bien que son SCR soit le RGF93
Lambert93. Il s'agit bien uniquement d'une question d'a@chage, le SCR de la couche n'est pas
modifié.

A partir du moment où la projection à la volée est activée dans un projet, toutes les couches
affichées dans ce projet le seront dans le SCR du projet.

Il est donc possible de superposer plusieurs couches dans des SCR diGérents. C'est ce que nous
allons vérifier!

Ajoutez la couche ne_110m_admin_0_countries.shp au projet. VériDez son SCR. Les deux
couches doivent se superposer correctement ; si ce n'est pas le cas vériDez que la projection à la
volée soit bien activée (cf. SCR du projet).

La projection à la volée est une fonctionnalité particulièrement utile dans un logiciel SIG, à
partir du moment où vous travaillez avec des données dans des SCR variés. Pour la suite de
ce tutoriel, nous vous recommandons de l'activer par défaut dans QGIS.

Pour activer par défaut la projection à la volée : , rubrique SCR :

Cochez la case Activer la projection à la volée par défaut . Ainsi, chaque projet que vous
créerez dans QGIS aura automatiquement cette fonctionnalité activée.

Pour vériDer d'un coup d’œil si la projection à la volée est activée, regardez l'icône du statut de la

Menu Préférences → Options 
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projection tout en bas à droite de la fenêtre de QGIS, dans la barre d'état :

si la projection est à la volée est activée, l'icône et le code du SCR du projet sont gris foncé 

si la projection est à la volée est désactivée, l'icône et le code du SCR sont gris clair 

Attention, si vous ouvrez un projet déjà existant pour lequel la projection à la volée n'est pas activée, elle restera
inactive dans ce projet tant que vous ne l'aurez pas activée puis sauvegardé à nouveau ce projet.
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II.4 Passer d'un système de coordonnées à un autre

Modifier le SCR du projet
Modifier le SCR d'une couche
Redéfinir le SCR d'une couche

Modifier le SCR du projet

Vous avez pu constater dans la partie II.3 Couches et projets : à chacun son système  que les
couches d'un projet sont a@chées dans le SCR du projet. Comment modiDer le SCR du projet pour
afficher les couches dans le SCR de votre choix?

Nous allons modiDer le SCR du projet monde.qgs du WGS84 vers Robinson [↗] (code EPSG
53030).

A partir de QGIS, ouvrez le projet monde.qgs situé dans le dossier
TutoQGIS_02_Geodesie/projets

(Si vous avez déjà un autre projet du tutoriel ouvert, il est inutile de le sauvegarder).

Ce projet comporte une couche de pays, une couche avec les indicatrices de Tissot (cf. partie II.2 A
chaque projection ses déformations), et une couche de graticule, c'est-à-dire de méridiens et de
parallèles distants ici de 15 degrés.

, rubrique SCR :

Elles sont toutes les 3 en WGS84, code EPSG 4326 (pour le vériJer, allez dans les propriétés de la
couche, rubrique Général).

Dans quel SCR sont les 3 couches du projet?

Ouvrez les propriétés du projet 
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1. Vérifiez que la projection à la volée soit bien activée.

2. Tapez robinson dans cette partie, ou bien 53030.

3 . Le Dltre est activé dans la liste des derniers SCR utilisés. Selon si vous avez déjà utilisé
Robinson, cette partie sera donc ou vide ou avec une ou deux lignes correspondant à ce
système.

4. Le Dltre est également activé dans la liste de tous les SCR disponibles : seuls les SCR dont le
nom contient "Robinson" sont affichés. Sélectionnez Sphere Robinson, code EPSG 53030 .

5. Vous devez voir dans cette partie le SCR que vous venez de sélectionner.

Cliquez sur OK.

La couche de pays est désormais a@chée en Robinson. Son SCR n'a cependant pas été modiDé,
ce que vous pouvez vériDer (cf. partie II.3.2). Observez les modiDcations apportées aux pays et
aux indicatrices de Tissot.

Répétez cette manipulation pour que le SCR du projet passe en :

Mercator, code EPSG 54004
Projection azimutale équidistante du pôle Sud, code EPSG 102019
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RGF93 / Lambert-93, code EPSG 2154

Nous allons maintenant repasser le projet en WGS84. Puisqu'il existe dans ce projet des
couches en WGS84, vous pouvez utiliser un raccourci pour cela : 

Le SCR du projet est maintenant le même que celui de la couche, c'est-à-dire WGS84.

Vous avez pu constater que modi@er le SCR du projet ne modi@e pas les données. Cette
manipulation permet de visualiser les données dans le SCR de votre choix, à des @ns
cartographiques par exemple.

Modifier le SCR d'une couche

Nous avons vu que QGIS gère le cas où plusieurs couches dans diGérents SCR sont a@chés dans
un même projet. Cependant, certaines manipulations nécessitent que toutes les couches soient
dans le même SCR. Par ailleurs, par souci de clarté et pour éviter les erreurs, on peut vouloir
travailler avec des couches dans le même SCR.

Pour toutes ces raisons, il est utile de savoir modifier le SCR d'une couche.

Cette manipulation implique de recalculer les coordonnées de tous les objets de la couche
dans un autre SCR.

Par exemple, si la couche d'origine est en WGS84 et contient un point correspondant à la ville de
Paris, et que le but est d'obtenir une couche en RGF93 / Lambert-93 , les coordonnées initiales du
point (48,856700 2,351000 en WGS84) seront recalculées pour devenir (652381.068 6862047.100)
en RGF93 / Lambert-93.

Cette manipulation crée une nouvelle couche . La couche d'origine et la couche résultat se
superposeront exactement dans QGIS si la projection à la volée est activée, puisqu'elles
contiendront exactement les mêmes objets.

L'objectif sera ici de créer une nouvelle couche pays dans la projection de Bonne (code EPSG
54024).

Pour cela, 

La fenêtre suivante apparaît :

Le RGF93 / Lambert-93 est un système adapté à l'emprise de la France; tout le reste du monde est
donc de plus en plus déformé au fur et à mesure qu'on s'éloigne de la France.

Qu'observez-vous dans ce dernier cas? A quoi cela est-il dû?

Clic-droit sur une couche (n'importe laquelle puisqu'elles sont toutes trois en WGS84) → DéDnir
le SCR du projet depuis cette couche

clic-droit sur la couche ne_110m_admin_0_countries → sauvegarder sous...
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Format : laisser ESRI Shapefile pour que la couche qui sera créée soit au format SHP

Sauvegarder sous :  cliquer que le bouton Parcourir, rendez-vous dans le répertoire
TutoQGIS_02_Geodesie/donnees et tapez le nom de la couche qui va être créée :
ne_110m_admin_0_countries_bonne

Codage : laisser la valeur par défaut System

SCR : choisir SCR de la sélection, puis cliquez sur le bouton Parcourir en-dessous et
sélectionnez le SCR World Bonne, code EPSG 54024

laissez les autres options par défaut...

...sauf la case Ajouter les @chiers sauvegardés à la carte , que vous pouvez cocher aDn
que la nouvelle couche soit directement ajoutée dans QGIS

Cliquez sur OK.

Si vous avez bien coché la case correspondante, la couche est automatiquement ajoutée à la
carte. Sinon, ajoutez-là dans QGIS.

VériDez dans ses propriétés que son SCR soit bien World Bonne. Vous pouvez si vous le voulez
modifier également le SCR du projet en World Bonne :
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Modi@er le SCR d'une couche crée une nouvelle couche. Cette manipulation est utile pour
pouvoir eRectuer ensuite des traitements sur les données, ou pour éviter toute source de
confusion en ayant uniquement des données dans le même SCR.

Redéfinir le SCR d'une couche

Il existe une autre manipulation souvent confondue avec le fait de modiDer le SCR d'une couche :
redé@nir le SCR d'une couche . Dans ce cas, les coordonnées ne sont pas recalculées et aucune
nouvelle couche n'est créée, le SCR associé à la couche est simplement modifié.

Pour reprendre l'exemple utilisé plus haut d'une couche en WGS84 contenant un point
correspondant à la ville de Paris de coordonnées (48,856700 2,351000), si le SCR de cette couche
est redéDni en RGF93 / Lambert-93, les coordonnées du point resteront (48,856700 2,351000) mais
ces coordonnées seront renseignées comme étant mesurées dans le SCR RGF93 / Lambert-93.

Le point ne sera donc pas a@ché, ou a@ché à un endroit aberrant, puisqu'il n'est pas possible de
trouver de telles coordonnées dans ce SCR (en RGF93 / Lambert-93, les X varient de 100 000 à 1
200 000 et les Y de 6 000 000 à 7 100 000).

Redéfinir le SCR d'une couche n'est donc utile que dans deux cas bien précis :

le SCR n'est pas dé@ni du tout , ce qui peut arriver par exemple pour certaine couches
trouvées sur internet. Il faudra alors retrouver dans quel SCR a été initialement créée la
couche
le SCR est mal défini  (quelqu'un a donc déjà effectué cette manip à tort)

Pour être sûr de vous rendre compte si une couche n'a pas de SCR déDni, rendez-vous dans le
menu , rubrique SCR :Préférences → Options 
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Pour l'option Quand une nouvelle couche est créée ou quand une couche est chargée sans
SCR, choisissez l'option Demander le SCR.

Ainsi, si vous chargez une couche dont le SCR n'est pas déDni, QGIS vous avertira et vous
demandera de spéciDer un SCR pour cette couche (ce sera cependant à vous de retrouver le SCR
initial dans lequel aura été créée cette couche).
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III. Recherche et ajout de données

Vous avez maintenant vos premières bases sous SIG, et les systèmes de coordonnées n'ont plus
de secrets pour vous... Il est temps de s'attaquer à une question cruciale en SIG : comment trouver
des données ?

Selon votre problématique et votre zone d'étude, les réponses seront bien sûr très diGérentes.
Nous vous fournirons ici quelques pistes, à vous d'aller plus loin !

Notions abordées :

télécharger des données sur internet
flux WMS et WFS
données XY

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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III.1 Recherche de données SIG sur internet

Données vecteur : quelques exemples
Limites administratives du Kenya
Cours d'eau du Kenya

Données raster : quelques exemples
Quelques sites utiles

Il est possible de trouver sur internet des données déjà géoréférencées, c'est-à-dire possédant
déjà des coordonnées, donc directement utilisables dans un SIG. Ces données peuvent être
vecteur ou raster.

Dans le cas de données vecteur, le format le plus courant est sans doute le shapeDle ; on
trouvera aussi des données dans d'autres formats, par exemple TAB (MapInfo), GeoJSON...

Dans le cas de données raster, on pourra trouver par exemple des données au format geotiG (TIF
géoréférencé, c'est-à-dire avec des coordonnées lui permettant de se superposer correctement à
d'autres couches).

Parfois, on ne trouvera que des données non géoréférencées (carte papier par exemple, ou
simple image trouvée sur internet). Ce cas sera traité dans la partie 4 : géoréférencement.

Données vecteur : quelques exemples

Limites administratives du Kenya

Il existe de nombreux sites permettant le téléchargement de données shapeDle sur des thèmes
variés. Nous allons ici supposer que vous cherchez les limites administratives d'un pays précis.

Pour cela, rendez-vous sur le site : http://www.gadm.org/ [↗]

Trouvez sur ce site la rubrique téléchargement, et téléchargez les limites administratives du
Kenya au format shapeDle. Décompressez le Dchier ZIP obtenu dans votre répertoire de
travail.

Lancez QGIS si ce n'est pas déjà fait, ou bien créez un nouveau projet sans sauvegarder
l'ancien.

A partir de QGIS, chargez la couche KEN_adm5.shp.

Au cas où le téléchargement échouerait, cette couche est également disponible dans le dossier
TutoQGIS_03_RechercheDonnees/donnees.
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Réussissez-vous à faire apparaître les grandes régions du Kenya (champ NAME_1) à partir de
cette couche ?

Pour cela, allez dans les propriétés de la couche → rubrique Style  et choisissez Catégorisé
comme type de légende, sélectionnez le champ de classiDcation : NAME_1. Cliquez ensuite sur
Classer en bas à gauche de la fenêtre .

Cliquez sur Appliquer pour voir les changements (ou bien cliquez sur OK pour appliquer les
changements + fermer la fenêtre) : vous pouvez voir les régions du Kenya.
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Vous venez de réaliser votre première analyse thématique!

Cette manip permet de représenter de la même manière tous les éléments ayant la même valeur
pour un champ donné.

Peut-être avez-vous remarqué que dans l'exemple ci-dessus, une palette de couleur aléatoire a été
utilisée pour représenter les régions ? Comment créer une telle palette ?

Bonus : création et utilisation d'une palette de couleur aléatoire

Ouvrez à nouveau les propriétés de la couche KEN_adm5.shp, rubrique Style.

et choisissez Nouvelle palette de couleur
tout en bas de la liste. Une fenêtre vous invitant à choisir le type de palette à créer apparaît :

Choisissez aléatoire, cliquez sur OK. Une fenêtre permettant le choix des paramètres de notre
palette apparaît :

Cliquez sur la liste déroulante Palette de couleur 
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A vous de tester et choisir des paramètres qui vous conviennent; vous pouvez éventuellement
augmenter le nombre de classes. Cliquez sur OK.

Un nom vous est demandé pour cette palette ; tapez le nom de votre choix.

Cliquez sur le bouton pour eGacer les classes déjà créées puis sur Classer et enDn
sur Appliquer ou OK pour voir les changements.

Cours d'eau du Kenya

De nombreuses ressources sont également disponibles sur le site de la Food and Agriculture
Organisation (FAO)

Rendez-vous sur http://www.fao.org/geonetwork/ [↗]

Ce site est un catalogue de métadonnées, utilisant le logiciel GeoNetwork [↗]. Il est possible d'y
faire une recherche par thématique, mot clé... Certaines des données sont ensuite
téléchargeables ; on y trouve aussi bien des données vecteur que des données raster.

Vous pouvez par exemple y rechercher les cours d'eau du Kenya. Choisissez le Kenya dans la
liste déroulante des pays, dans la colonne gauche de la page, puis cliquez sur Hydrology and
Water Resources dans la liste de catégories qui se trouve dessous.

EGacer tout 
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Prenez connaissance des métadonnées de Rivers of Kenya - AFRICOVER et téléchargez ces
données. Affichez ensuite la couche correspondante ke-rivers.shp dans QGIS.

Au cas où le téléchargement échouerait, cette couche est également disponible dans le dossier
TutoQGIS_03_RechercheDonnees/donnees.

Vous pouvez remarquer un léger décalage entre les deux couches, visible là où les cours d'eau
semblent suivre les frontières. En eGet, les deux couches ne proviennent pas du même organisme
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et ont des niveaux de précision différents...

Données raster : quelques exemples

Les données raster seront par exemple des images satellite, des fonds de carte, des modèles
numériques de terrain (MNT) [↗]...

Nous allons ici voir où trouver un modèle d'élévation pour le Kenya.

Un modèle d'élévation numérique (Digital Elevation Model ou DEM)  se rapproche d'un MNT,
mais il ne mesure pas l'altitude au sol mais l'altitude des éléments présents au sol. Si une forêt est
présente, ce sera donc l'altitude du sommet des arbres qui sera mesurée et non l'altitude du sol,
idem si des bâtiments sont présents.

On trouve sur internet deux DEM en libre accès : le modèle ASTER issu d'une collaboration
NASA/METI (Ministry of Economy, Trade and Industry of Japan) et le modèle SRTM issu d'une
collaboration NASA/NGA (National Geospatial-Intelligence Agency). Nous allons voir ici le cas du
SRTM.

rendez-vous sur http://dwtkns.com/srtm/ [↗] et cliquez sur une des cases recouvrant le Kenya
(par exemple la dalle srtm_44_12) :

Téléchargez la dalle au format GeoTIFF, dézippez ensuite le fichier obtenu.

Ajoutez le fichier TIF téléchargé au moyen de l'icône Ajouter une couche raster.
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Au cas où le téléchargement échouerait, cette couche est également disponible dans le dossier
TutoQGIS_03_RechercheDonnees/donnees.

Quelques sites utiles (en vrac...)

L'annuaire de données de l'incontournable GeoRezo, portail francophone de la géomatique 
http://georezo.net/annuaire/donnees-c-4.html [↗]

Natural Earth : données à l'échelle mondiale : limites administratives, hydrographie,
bathymétrie, fonds de carte raster... 
http://www.naturalearthdata.com/downloads/ [↗]

FAO (Food and Agriculture Organisation) : catalogue de métadonnées donnant accès à un
large éventail de données vecteur ou raster, en particulier sur les pays du Sud. 
http://www.fao.org/geonetwork/ [↗]

CUB (Communauté Urbaine de Bordeaux) : données thématiques sur la CUB 
http://data.lacub.fr/themes.php [↗]

OpenStreetMap : extractions de données au format SHP ou OSM, fourni par Geofabrik : 
http://download.geofabrik.de/openstreetmap/ [↗]

IGN : nombreuses données disponibles pour la France, certaines gratuites pour les
établissements de recherche 
http://professionnels.ign.fr/catalogue [↗]

THEIA : structure nationale inter-organismes ayant pour vocation de faciliter l’usage des
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images satellite 
http://www.theia-land.fr/ [↗]

GADM : limites administratives accessibles par pays 
http://www.gadm.org/ [↗]

DIVA-GIS : site du logiciel SIG libre DIVA, où sont aussi disponibles des données vecteur sur
les limites administratives, l'hydrographie, le transport, la population... classées par pays 
http://www.diva-gis.org/gdata [↗]

ASTER : modèle d'élévation, données mondiales téléchargeables par dalles 
http://asterweb.jpl.nasa.gov/gdem.asp [↗]

SRTM : modèle d'élévation, données mondiales téléchargeables par dalles 
http://dwtkns.com/srtm/ [↗]

Global Land Cover Facility : images satellites 
http://glcfapp.glcf.umd.edu:8080/esdi/ [↗]
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III.2 Ajout de données via des Vux

Qu'est-ce qu'un flux WMS ou WFS?
Ajout de données via un flux WMS : carte géologique
Ajout de données via un flux WFS : cours d'eau
Avantages et inconvénients des flux

Qu'est-ce qu'un flux WMS ou WFS?

Il est possible de visualiser directement dans un SIG des données accessibles sur un serveur, sans
devoir préalablement les télécharger sur votre ordinateur. Ceci se fait via des dux. Les deux types
de dux les plus courant permettant ceci sont les Vux WMS (Web Map Service)  et WFS (Web
Feature Service).

Les flux WMS [↗] vont vous permettre d'afficher des couches raster, non modifiables.
L e s dux WFS [↗] vous permettront d'a@cher des couches vecteur, non directement
modifiables mais que vous pourrez ensuite télécharger au format shapefile.

Ajout de données via un flux WMS : carte géologique

Lancez QGIS si ce n'est pas déjà fait, ou bien créez un nouveau projet.

Ajoutez-y la couche dept_creuse_geofla.shp que vous trouverez dans le dossier
TutoQGIS_03_RechercheDonnees/donnees.

Donnez au projet le même SCR que la couche dept_creuse_geofla.shp.

Nous allons maintenant ajouter au projet la carte géologique de la France au 1/50 000è via un dux
WMS.

Cliquez sur l'icône Ajouter une couche WMS, ou bien Menu Couche, Ajouter une
couche WMS...
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Cliquez sur le bouton Nouveau pour créer une nouvelle connexion. La fenêtre suivante
apparaît :
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Nom : tapez le nom de votre choix, par exemple BRGM

URL : tapez l’URL suivante, qui correspond à l'adresse du serveur WMS du BRGM :
http://geoservices.brgm.fr/geologie

Laissez les autres paramètres tels quels et cliquez sur OK. Vous voilà à nouveau dans la fenêtre
d'ajout d'une couche WMS :

Après avoir vériDer que votre connexion est bien sélectionnée dans la liste déroulante en
haut de la fenêtre, cliquez sur Connexion

Rendez-vous dans la rubrique 1 GEOLOGIE et sélectionnez la couche correspondant à la
carte géologique image de la France au 1/50 000 .

Cliquez sur Ajouter

Vous devriez obtenir quelque chose de similaire à ceci :
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Il peut être nécessaire de changer l'ordre des couches en les faisant glisser dans la table des
matières, et de modifier le style de la couche du département de la Creuse.

Ici, l'adresse du serveur WMS vous était fournie; si vous cherchez des adresses de dux, deux
solutions : une recherche internet, ou bien l'onglet Recherche de serveurs de la fenêtre d'ajout
d'une couche WMS :

Dans cette fenêtre, vous pouvez taper du texte dans la partie Recherche, voir la liste des serveurs
contenant ce texte, et ajouter une ligne de cette liste à la liste de vos connexions visible dans
l'onglet Couche, grâce au bouton Ajoutez les lignes sélectionnées à la liste des serveurs WMS .
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Ajout de données via un flux WFS : cours d'eau

Le but va être ici d'ajouter les cours d'eau de la BD Carthage [↗] du Sandre (Service
d'Administration Nationale des Données et Référentiels sur l'Eau).

Cliquez sur l'icône Ajouter une couche WFS , ou bien 

Cliquez sur le bouton Nouveau pour créer une nouvelle connexion. La fenêtre suivante
apparaît :

Nom : tapez le nom de votre choix, par exemple BD Carthage

Menu Couche, Ajouter une
couche WFS...
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URL : tapez l’URL suivante, qui correspond à l'adresse du serveur WFS du Sandre :
http://services.sandre.eaufrance.fr/geo/zonage

Laissez les autres paramètres tels quels et cliquez sur OK. Vous voilà à nouveau dans la fenêtre
d'ajout d'une couche WFS :

Après avoir vériDer que votre connexion est bien sélectionnée dans la liste déroulante en
haut de la fenêtre, cliquez sur Connexion

Sélectionnez la couche correspondant aux cours d'eau de plus de 100km (COURDO1) ,
vers le bas de la liste.

Cliquez sur Ajouter

Vous devriez obtenir quelque chose de similaire à ceci :
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Il peut être nécessaire de changer l'ordre des couches en les faisant glisser dans la table des
matières, et de modiDer le style de la couche du département de la Creuse. Vu qu'il s'agit ici
d'un flux WFS et non WMS, il est également possible de modifier le style des cours d'eau.

De même, s'agissant d'un dux WFS, il est possible de sauvegarder les cours d'eau au format
shapefile : clic droit sur la couche, sauvegarder sous...

Avantages et inconvénients des flux

Un inconvénient d'utiliser des dux est le temps de chargement et la nécessité d'avoir une
connexion internet.

Cependant, ils vous assurent de toujours visualiser la dernière mise à jour des données, vous
évitent d'encombrer vos ordinateurs et vous permettent de transmettre des projets QGS à des
collègues en étant sûr que ceux-ci puissent en visualiser les données (s'ils sont connectés à
internet).

En résumé, c'est probablement l'usage que vous ferez des données qui vous fera opter pour l'une
ou l'autre solution.
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III.3 Ajout de données ponctuelles à partir d'un @chier
texte

Qu'y a-t-il dans le fichier texte?
Visualisation des données dans QGIS

Ajout d'une couche avec un SCR inconnu : préparer le terrain
Visualisation des données sous QGIS

Création du shapefile de points

Nous avons vu quelques pistes pour rechercher et a@cher des données au format SIG dans QGIS,
que ce soit en les téléchargeant ou via des dux. Il arrive aussi de disposer d'un tableau avec deux
colonnes X et Y : comment utiliser ces données dans un SIG ?

Nous prendrons ici l'exemple d'un Dchier au format CSV [↗]. Pour information, il est possible de
créer un Dchier au format CSV à partir d'un Dchier ODS (LibreO@ce) ou XLS (Microsoft O@ce) par
exemple.

Qu'y a-t-il dans le fichier texte?

Dans l'explorateur de votre ordinateur, ouvrez le Dchier villes_bhutan_geonames.csv situé
dans le dossier TutoQGIS_03_RechercheDonnees/donnees à l'aide d'un éditeur de texte
simple (pas dans un tableur) : par exemple, WordPad dans Windows, TextEdit sous Mac, gedit
sous Ubuntu.

Le format CSV est un format relativement simple : il contient des colonnes séparées
habituellement par des virgules, parfois par des points-virgules, tabulations ou autre. La première
ligne contient les en-têtes de colonnes.

Combien de colonnes y a-t-il dans le fichier villes_bhutan_geonames.csv ?
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Fermez le fichier sans enregistrer les éventuelles modifications, quittez l'éditeur de texte.

Ce Dchier contient donc une liste de villes du Bhoutan [↗], avec pour chaque ville diGérentes
informations telles que sa population, son élévation, sa latitude et sa longitude.

Visualisation des données dans QGIS

Le Jchier comporte 9 colonnes : geonamesid, name, asciiname, latitude, longitude, country code,
population, dem et modification date.

La latitude de la ville de Timphu est 27.46609 (la colonne "latitude" est la 4ème colonne : la réponse
se trouve donc dans la 4ème colonne de la ligne correspondant à Timphu.

Quelle est la latitude de la ville de Timphu?

En vous rendant sur http://download.geonames.org/export/dump/readme.txt dans un navigateur
internet, vous pouvez lire la déJnition suivante pour la colonne dem (dans la partie "The main
'geoname' table has the following Jelds" ) : digital elevation model, srtm3 or gtopo30, average
elevation of 3''x3'' (ca 90mx90m) or 30''x30'' (ca 900mx900m) area in meters, integer. srtm
processed by cgiar/ciat.

Il s'agit donc de la valeur d'un modèle d'élévation numérique [↗], correspondant
approximativement à l'altitude. Différents modèles ont été utilisés, à différentes résolutions.

A quoi correspond la colonne "dem" ? Pouvez-vous trouver la réponse dans les
métadonnées ?

Comme précisé dans le Jchier de métadonnées, les coordonnées sont mesurées en degrés décimaux
dans le SCR WGS84.

Dans le cas d'un Jchier avec des coordonnées en latitude et longitude et un SCR inconnu, il s'agit
fréquemment de coordonnées en WGS84.

A votre avis, dans quel SCR sont mesurées la latitude et la longitude? Pouvez-vous trouver
cette info dans les métadonnées?
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Ajout d'une couche avec un SCR inconnu : préparer le terrain

Dans la mesure où nous allons ajouter des données issues d'un Dchier texte à QGIS, QGIS ne
pourra pas lire dans quel SCR ont été mesurées ces coordonnées : ce sera à nous de le préciser au
logiciel.

Lancez QGIS si ce n'est pas déjà fait, ou bien créez un nouveau projet sans sauvegarder
l'ancien.

Pour être sûr que QGIS vous demande dans quel SCR sont les coordonnées du Dchier texte,
rendez-vous dans le menu , rubrique SCR :

Pour l'option Quand une nouvelle couche est créée ou quand une couche est chargée sans
SCR, choisissez l'option Demander le SCR si ce n'est pas déjà fait. Cliquez sur OK.

Visualisation des données sous QGIS

A partir de QGIS, chargez la couche ne_10m_admin_0_countries.shp située dans le
dossier TutoQGIS_03_RechercheDonnees/donnees.

Cliquez sur l'icône Ajouter une couche de texte délimité , ou bien allez dans le 

Préférences → Options 

Menu
Couche → Ajouter une couche de texte délimité
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Cliquez sur le bouton Parcourir et sélectionnez le fichier villes_bhutan_geonames.csv

Nom de la couche :  vous pouvez laisser villes_bhutan_geonames ou bien tapez le nom
de votre choix

Format de fichier :  choisir CSV (virgule)

Enregistrements : vérifiez que la case en-têtes de 1ère ligne  soit bien cochée

Dé@nition de la géométrie : choisir point, puis les colonnes X et Y : longitude et
latitude

Cliquez sur OK. Zoomez sur la couche de points et ouvrez sa table attributaire :
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Les villes ont bien été ajoutées à QGIS sous la forme d'une couche de points.

Création du shapefile de points

Regardez à quel emplacement  est stockée votre couche. Vous pouvez observer que cet
emplacement fait référence à un fichier CSV et non à un fichier SHP.

Par ailleurs, si vous sélectionnez la couche de villes dans la table des matières, vous pouvez
constater que l'icône pour passer en mode édition est désactivée, au contraire de notre couche de
pays. La couche de villes n'est donc pas éditable.

Icône édition activée :  Icône édition désactivée : 

Ces indices laissent à penser que bien que nous puissions visualiser les villes dans QGIS, aucun
SHP n'a été créé, ce qui est d'ailleurs logique dans la mesure où QGIS ne nous a demandé à aucun
moment de choisir un emplacement pour cette couche.

En fait, nous avons seulement créé une couche temporaire, uniquement stockée dans le
projet QGS en cours. Comment faire pour sauvegarder cette couche?
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Il su@t pour cela de faire un 

Cliquez sur Parcourir pour sélectionner l'emplacement où la couche sera créée et lui
donner un nom

Cochez la case Ajouter les fichiers sauvegardés à la carte

Laissez les autres paramètres par défaut

Cliquez sur OK ; la couche est ajoutée à QGIS, vous devez donc avoir deux couches de villes
identiques au premier abord; cependant, l'une est temporaire et l'autre permanente.

pour éviter toute confusion (en vous aidant éventuellement
de son emplacement pour déterminer laquelle est-ce).

En ouvrant la table attributaire de la nouvelle couche, vous pouvez constater que les noms de champs ont
été tronqués à 10 caractères (« country co » au lieu de « country code » par exemple). Ceci est une limitation
liée au format DBF utilisé pour les shapefile (cf. partie I.3.1a).

Félicitations ! L'ajout de données ponctuelles à partir d'un Dchier texte dans QGIS n'a désormais
plus de secrets pour vous !

clic-droit sur la couche villes_bhutan_geonames, Sauvegarder
sous...

Supprimez la couche temporaire 
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IV. Géoréférencement

Le géoréférencement, ou calage, consiste à donner des coordonnées à une image.

Notions abordées :

Principe du géoréférencement
Points de calage
Types de transformation
Erreur Moyenne Quadratique (EMQ)
Rééchantillonnage
Vérification du géoréférencement

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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IV.1 Principe du géoréférencement

Qu'est-ce que le géoréférencement?
Géoréférencer par rapport à quoi? Deux méthodes

En se basant sur les informations contenues dans l'image
En se basant sur des informations contenues dans une autre couche

Qu'est-ce que le géoréférencement?

Les données SIG que nous avons utilisées jusqu'ici ont toutes des coordonnées, ce qui nous
permet de les superposer correctement dans une logiciel SIG. A l'inverse, dans le cas d'une image
simplement scannée, une carte ancienne par exemple, le logiciel ne possède pas d'informations
de coordonnées ; il placera cette image simplement en considérant que le coin en haut à gauche a
les coordonnées 0,0.

Le géoréférencement, ou calage, consiste à attribuer des coordonnées à une image . Cette
image pourra ensuite être superposée à d'autres couches dans un logiciel SIG, et servir par
exemple de fond de carte ou être numérisée. Le géoréférencement s'applique uniquement aux
données raster (il existe d'autres méthodes pour les données vecteur qui ne seront pas abordées
ici).

Lors du géoréférencement, il faudra aussi préciser dans quel SCR est notre image.

Géoréférencer par rapport à quoi? Deux méthodes

Pour donner des coordonnées à une image, il est possible de se baser soit sur des informations
contenues directement dans l'image, par exemple si l'image est une carte avec un carroyage, ou
soit sur une autre couche déjà existante et correctement calée (vecteur ou raster).

En se basant sur les informations contenues dans l'image

si on connaît précisément les coordonnées de quelques points sur l'image, grâce à un carroyage
avec des amorces de coordonnées, on va pouvoir se servir de ces coordonnées pour
géoréférencer l'image.

Il faut néanmoins connaître le système de coordonnées utilisé, ce qui peut nécessiter des
recherches.
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Calage grâce à un carroyage avec amorces de coordonnées (Source de l'image : Wikimedia [↗], domaine public)

En se basant sur des informations contenues dans une autre couche

Si l'image ne possède pas d'indications de coordonnées, il va falloir utiliser une couche déjà
géoréférencée possédant une zone commune avec l'image à géoréférencer. On pourra alors
indiquer que tel point sur l'image correspond à tel point sur la couche déjà géoréférencée. Cette
méthode sera employée pour caler des photographies aériennes par exemple.

La carte résultante aura le même système de coordonnées que la couche de référence. La
précision du calage dépend alors notamment de la précision de la couche de référence.
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Calage grâce à une couche de référence (Source de l'image à caler : Wikimedia [↗], domaine public, source des
données de référence OpenStreetMap [↗] © les contributeurs d’OpenStreetMap).

Dans l'illustration ci-dessus, l'image de gauche est géoréférencée en utilisant le fond de carte
OpenStreetMap [↗]. Des points que l'on peut facilement identiDer sur les deux images (par
exemple des intersections de routes) servent de points de calage.
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IV.2 Géoréférencement : les préliminaires

Découverte de l'image à caler
Accéder au module de géoréférencement

Si tout va bien...
Si le module n'est pas accessible...

Notre but sera ici de caler une carte de l'île d'Oahu (Hawaii) de 1902 (source : Wikimedia [↗]. Une
fois cette carte calée, vous pourrez la superposer à d'autres données dans QGIS.

La première étape consiste à prendre connaissance de cette carte, et à vériDer que le module de
géoréférencement de QGIS soit activé.

Découverte de l'image à caler

Où se situe l'île d'Oahu? Rendez-vous par exemple sur Wikipedia pour le savoir :
http://fr.wikipedia.org/wiki/Oahu [↗].

A partir de l'explorateur de Dchiers de votre ordinateur, ouvrez l'image
Oahu_Hawaiian_Islands_1906.jpg située dans le dossier TutoQGIS_04_Georef/donnees.

Accéder au module de géoréférencement

Si tout va bien...

Le module de géoréférencement de QGIS est normalement accessible via le menu

L'île est située approximativement aux coordonnées 21° 28' Nord et 157° 59' Ouest (SCR WGS84).

Quelles sont les coordonnées de l'île d'Oahu ? Dans quel SCR sont mesurées ces coordonnées
?

Aucune mention d'un SCR n'est faite sur cette carte. Nous pouvons néanmoins être sûr qu'il s'agit d'un
système géographique (non projeté) puisque les coordonnées sont exprimées en degrés.

Connaître quel système a été utilisé ici nécessiterait des recherches, en se basant sur la date de la carte
et la zone couverte. Nous allons supposer ici, pour les besoins de l'exercice, que les coordonnées sont
en WGS84 (ce qui n'est évidemment pas le cas, ce système datant de 1984). Nous vériJerons que ce
choix nous donne une précision acceptable.

Pouvez-vous dire dans quel système sont mesurées les coordonnées de cette carte ?
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.

Si le module n'est pas accessible...

Si vous n'avez pas accès au géoréférenceur à partir du menu raster, vériDer que l'extension est
installée et activée via le menu .

Allez dans la rubrique installées pour voir la liste des extensions installées, tapez "géo"
(attention, l'accent est important) dans Rechercher pour limiter les résultats, et cochez la case
de l'extension géoréférenceur GDAL.

Si jamais l'extension n'était pas visible dans la rubrique installées, allez dans la rubrique En
obtenir plus, recherchez le géoréférenceur et installez cette extension.

Raster → Géoréférencer → Géoréférencer 

Extension → Installer/Gérer les extensions 
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IV.3 Points de calage : avec un carroyage

Création du premier point
Quelques astuces pour créer les points suivants

Nous allons créer ici des points de calage, c'est-à-dire attribuer leurs coordonnées à plusieurs
points de l'image.

Pour ce faire, nous utiliserons la première méthode décrite dans la partie IV.1  : nous nous
baserons sur le carroyage de cette carte pour créer les points de calage (la deuxième méthode
sera abordée dans la partie IV.6).

Création du premier point

Lancez QGIS ou créez un nouveau projet. Il est inutile d'ajouter la carte d'Oahu à QGIS  (si
vous le faites néanmoins, proDtez-en pour observer qu'en l'absence d'informations de
localisation pour cette image, QGIS positionne son coin supérieur gauche aux coordonnées
(0,0).

Ouvrez la fenêtre du géoréférenceur.
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Dans cette fenêtre, ajoutez au géoréférenceur l'image à caler en cliquant sur l'icône
Ouvrir un raster, ou bien .

Sélectionnez la carte de l'île d'Oahu : fichier Oahu_Hawaiian_Islands_1906.jpg.

Une fenêtre s'ouvre demandant le SCR de l'image; puisque nous avons décidé de partir du
principe que les coordonnées de cette carte était en WGS84, .

La carte s'affiche dans la fenêtre du géoréférenceur.

Il s'agit maintenant de renseigner les coordonnées de plusieurs points, en se basant sur les
indications de la carte. Vous pouvez par exemple commencez par le point en haut à gauche :

menu Fichier → Ouvrir un raster 

choisissez ce SCR 
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VériDez que l'icône Ajouter un point soit bien sélectionnée et cliquez à l'intersection
des deux lignes du carroyage :

Après avoir saisi les coordonnées, cliquez sur OK.

Le point apparaît sous forme d'une ligne dans la table des points de contrôle, sous la carte dans la

Ce point est situé aux coordonnées -158° 15' Est (longitude négative car le point est à l'ouest du
méridien de Greeenwich) et 21° 40' Nord (latitude positive car le point est au Nord de l'équateur).

QGIS propose de saisir les coordonnées en degrés minutes secondes sous la forme dd mm ss.ss. Ici,
nous avons juste des degrés et des minutes : le point a donc pour coordonnées -158 15 Est et 21 40
Nord.

Comment saisir les coordonnées de ce point ?
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fenêtre géoréférenceur :

Que signifient les différentes colonnes de cette table?

on/oR : indique si le point sera pris en compte ou non pour le géoréférencement. Permet
de ne pas prendre en compte certains points qui semblent apporter trop d'erreurs, tout en
les gardant en mémoire.

id : identiDant du point. Peut aider à repérer de quel point il s'agit sur la carte, dans le
fenêtre du géoréférenceur comme dans celle de QGIS.

srcX et srcY : coordonnées du point dans l'image non géoréférencée, c'est-à-dire en
considérant que le pixel en haut à gauche de l'image a pour coordonnées 0,0.

dstX et dstY : les coordonnées que l'on souhaite faire prendre à ce point, exprimées dans le
SCR choisi précédemment. Ces coordonnées sont en degrés décimaux (ici, -158°15' a été
converti en -158,25 degrés décimaux).

dX[pixels] et dY[pixels] :  la diGérence entre les coordonnées qu'on souhaiterait voir
prendre le point (dstX et dstY) et les coordonnées que prendra eGectivement le point après
le géoréférencement. En eGet, en fonction du type de transformation choisi et du nombre
de points de calage, il n'est pas toujours possible de faire coïncider exactement les points
avec les coordonnées souhaitées.

residual[pixels] : l'erreur associée à ce point, calculée à partir de dX[pixels] et dY[pixels].
Cette erreur est égale à la racine de la somme des carrés de dX[pixels] et dY[pixels], soit : 
√ ( dX[pixels] ² + dY[pixels] ² )

Dans notre table, les colonnes dX[pixels], dY[pixels] et residual[pixels] ne sont pas encore
remplies, car nous n'avons pas encore déDni le type de transformation à eGectuer lors du
géoréférencement. Cette notion sera abordée dans la partie suivante. En attendant, continuons à
ajouter des points de calage pour en avoir par exemple six.

Quelques astuces pour créer les points suivants

Procédez de la même manière pour rajouter 5 autres points de calage. Faites en sorte que ces
points soient bien répartis sur l'image.

Pour visualiser les identiDants et/ou les coordonnées des points sur la carte du géoréférenceur
: :Menu Paramètres → Configurer le géoréférenceur 
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Si vous faites une erreur, vous pouvez supprimer un point en cliquant sur l'icône
Effacer un point, puis sur le point à effacer.

Vous pouvez également déplacer un point déjà créé en cliquant sur l'icône Deplacer les
points de contrôle, puis en faisant glisser le point à déplacer.

Une fois vos points créés, vous pouvez les sauvegarder au moyen du menu
ou bien en cliquant sur l'icône

correspondante.

Cette manipulation crée un Dchier avec l'extension .POINTS. Par défaut, ce Dchier aura le même
nom et sera dans le même dossier que l'image que vous êtes en train de caler. Ces points de
calage pourront être chargés dans le géoréférenceur au moyen du menu 

.

Voici à quoi ressemble la fenêtre du géoréférenceur une fois tous les poins de calage
correspondant à des intersections du carroyage renseignés :

Fichier → Enregistrer les points de contrôle sous... 

Fichier → Charger les
points de contrôle 
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Vous n'êtes pas obligé de renseigner autant de points ! Six suffiront pour notre calage.

Les points qui serviront à caler notre image sont maintenant créés. Comment faire pour utiliser ces
points pour caler notre image ?
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IV.4 Paramétrage du géoréférencement

Type de transformation, ou comment calculer les nouvelles coordonnées des points ?
Qu'est-ce qu'une transformation?
Quelques types de transformations
Choisir une transformation

Rééchantillonnage, ou comment calculer les valeurs des pixels ?
Mode de compression utilisé pour la création de la nouvelle image
Les autres paramètres

Raster de sortie
SCR cible
Carte et rapport PDF
Définir la résolution de la cible
Transparence
Charger directement le raster dans QGIS

Une fois tous les paramètres choisis...

Avant de pouvoir procéder au géoréférencement proprement dit, il va nous falloir déDnir plusieurs
paramètres.

Ces paramètres sont accessibles dans le menu 
ou bien en cliquant sur l'icône correspondante.

Paramètres → Paramètres de
transformation 
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Nous allons passer en revue ces différents paramètres.

Type de transformation, ou comment calculer les nouvelles
coordonnées des points ?

Qu'est-ce qu'une transformation?

Lors du calage, l'image subit une transformation, aDn de faire coïncider au maximum les points de
départ avec les coordonnées spéciDées par l'utilisateur. Une transformation est en fait une
formule mathématique transformant les coordonnées de départ vers les coordonnées voulues.

Il existe divers types de transformations, adaptées à des usages diGérents. Chaque
transformation, si on l'utilise avec un nombre de points de calage supérieur à son minimum,
renverra une erreur correspondant à la diGérence entre les coordonnées "idéales" voulues par
l'utilisateur et les coordonnées eGectivement calculées lors de la transformation (erreur résiduelle
residual[pixels] de la table des points de contrôle, voir plus haut).

Quelques types de transformations

QGIS permet les transformations suivantes :
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linéaire (2 points minimum) : type le plus simple, ne déforme pas le raster. Cette
transformation est rarement suffisante pour des images scannées.

Helmert (2 points minimum) : cas particulier de transformation polynomiale d'ordre 1.

transformation polynomiale d'ordre 1 , ou transformation a@ne (3 points minimum) : elle
préserve la colinéarité (3 points alignés le resteront) et permet seulement changement
d'échelle, translation et rotation.

transformation polynomiale d'ordre 2  (6 points minimum) : permet une distorsion du
raster.

transformation polynomiale d'ordre 3  (10 points minimum) : le degré de distorsion
possible est plus important que pour une transformation d'ordre 2.

Thin Plate Spline (TPS)  (1 point minimum) : méthode récente, permettant de prendre en
compte des déformations locales. Cette transformation est utile lorsqu'on dispose
d'originaux de très mauvaise qualité.

projective (4 points minimum) : une des transformations les plus complexes, qui ne
conserve pas le parallélisme. Un carré sera transformé en quadrilatère.

Choisir une transformation

Quelques éléments vous ont été donnés dans la description des types de transformation pouvant
vous aider à choisir l'une ou l'autre transformation. En pratique, le choix est souvent di@cile et
requiert de tester plusieurs transformations et de les comparer si l'on recherche une bonne
précision.

Ici, nous nous bornerons à choisir une transformation simple et rapide.

Sélectionnez la transformation polynomiale 1 dans la liste déroulante de la fenêtre de
paramétrage.

Rééchantillonnage, ou comment calculer les valeurs des pixels ?

Si on utilise une transformation qui déforme le raster d'origine (transformation polynomiale
d'ordre supérieur à 1, ou transformation de type Spline par exemple), la valeur (couleur) de
chaque pixel du nouveau raster sera déterminée par un calcul en se basant sur le raster original.

Cette valeur sera diGérente selon la méthode de rééchantillonnage choisie. QGIS, comme d'autres
logiciels SIG, propose trois méthodes de rééchantillonnage :
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Plus proche voisin :  le nouveau pixel prend la valeur du pixel de l'ancien raster le plus
proche. Cette méthode est la plus rapide, et est utilisée principalement pour des données
catégorisées (occupation du sol par exemple) puisqu'elle ne crée pas de nouvelles valeurs.

Linéaire : la valeur du nouveau pixel est déterminé à partir des valeurs des 4 pixels les plus
proches. Cette méthode est utilisée pour des données continues et permet un lissage du
raster.

Cubique : la valeur du nouveau pixel est déterminée à partir des valeurs des 16 pixels les
plus proches. Ceci provoque moins de distorsion géométrique de l'image mais nécessite un
temps de calcul relativement long. Par ailleurs, il y a plus de possibilités d'obtenir avec cette
méthode de nouvelles valeurs de pixel par rapport aux valeurs de départ.

Le choix d'une méthode de rééchantillonnage a surtout une induence dans le cas où un la taille
des pixels est importante par rapport à la taille des objets qui seront étudiés sur l'image, par
exemple une photo aérienne où chaque maison est constituée de seulement quelques pixels.

Dans notre cas (carte scannée avec une bonne résolution), le choix du type de rééchantillonnage
influencera peu le résultat.

Ici, nous allons donc choisir la méthode la plus simple et la plus rapide : plus proche voisin.

Mode de compression utilisé pour la création de la nouvelle image

La compression permet d'obtenir un raster moins volumineux, mais peut provoquer une perte de
qualité. Une image compressée peut par ailleurs être illisible par certains logiciels.

QGIS propose les méthodes suivantes :

NONE : pas de compression

LZW : utilisé pour les images au format GIF et TIF. Assez largement utilisé, permet une
compression jusqu'au 1:10
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PACKBITS : oGre une compression moindre que la méthode LZW, mais ce format est plus
courant

DEFLATE : similaire à LZW, mais principalement prise en charge par les logiciels Adobe

Notre image de base étant peu volumineuse, nous allons choisir le type NONE.

Les autres paramètres

Raster de sortie

SpéciDez ici le nom et l'emplacement de l'image géoréférencée qui sera créée, en cliquant sur
l'icône à droite de la ligne Raster de sortie.

Choisissez à quel endroit vous souhaitez créer cette couche, et donnez-lui un nom, par
exemple Oahu_Hawaiian_Islands_1906_pol1_wgs84.tif.

SCR cible

Comme décidé en partie IV.1, nous allons partir du principe que les coordonnées de cette carte
sont exprimées dans un système proche du WGS84.

Cliquez sur l'icône à droite de la ligne SCR cible.

Choisissez le SCR WGS 84, code EPSG 4326, en vous aidant éventuellement de la partie filtre.
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Cliquez sur OK.

Le SCR WGS84 (code EPSG 4326) doit normalement être sélectionné comme SCR cible :

Carte et rapport PDF

La carte PDF permettra de visualiser le décalage qu'aura subi chaque point de contrôle. Le rapport
PDF comportera notamment les coordonnées et erreurs pour chaque point.

Cliquez sur les icônes à droite des lignes carte PDF et rapport PDF pour spéciDer un nom (à
votre convenance) et l'emplacement (par exemple dans le même dossier que l'image de
départ) pour la carte et le rapport qui seront créés.

Au Dnal, ces lignes seront remplies suivant l'emplacement et le nom que vous aurez choisi, par
exemple :
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Définir la résolution de la cible

Laisser cette case décochée pour que l'image créée ait la même résolution que l'image de
départ.

Transparence

Employer 0 pour la transparence : cette option est utile principalement pour les photographies
aériennes ou satellites et permet de ne pas visualiser les pixels noirs (bords de l'image), ce qui
serait gênant dans notre cas.

Laissez cette case décochée.

Charger directement le raster dans QGIS

Charger dans QGIS lorsque terminé : cocher cette case pour que le nouveau raster soit chargé
automatiquement dans QGIS une fois le géoréférencement effectué.

Une fois tous les paramètres choisis...

...Cliquez sur OK : les paramètres sont sauvegardés... Mais rien ne semble se passer. Rendez-vous
dans la partie suivante pour l'étape finale !
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IV.5 Lancer le géoréférencement

Vérification avant calage : les erreurs
Erreur par pixel
Erreur globale : Erreur Quadratique Moyenne

Lancement du géoréférencement
Vérification de la précision du calage

Lecture de la carte et du rapport PDF
Vérification par superposition d'une autre couche

Vérification avant calage : les erreurs

Erreur par pixel

Maintenant que le type de transformation est renseignée, les erreurs pour chaque pixel ont été
calculées dans la table des points de contrôle :

Comme indiqué dans la partie IV.3.1 :

les colonnes dX[pixels] et dY[pixels] correspondent à la diGérence entre les coordonnées
qu'on souhaiterait voir prendre le point (dstX et dstY) et les coordonnées que prendra
eGectivement le point après le géoréférencement. Cette valeur variera selon le type de
transformation choisie.

La colonne residual[pixels] correspond à l'erreur associée à ce point, calculée à partir de
dX[pixels] et dY[pixels]. Cette erreur est égale à la racine de la somme des carrés de
dX[pixels] et dY[pixels], soit : 
√ ( dX[pixels] ² + dY[pixels] ² )

Classez les points par erreur décroissante, en cliquant deux fois sur l'en-tête de colonne
residual[pixels].
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Avez-vous dans votre table des points avec des valeurs d'erreur très importantes par rapport
aux autres ? Pouvez-vous en trouver la cause ? Vous pouvez décocher les points aberrants
dans la colonne on/off.

Vous ne devriez normalement pas obtenir des erreurs résiduelles supérieures à 10 ; si
nécessaire, supprimez et recréez des points de calage.

Erreur globale : Erreur Quadratique Moyenne

Tout en bas de la table des points de contrôle est indiqué le type de transformation utilisée
(polynomiale 1 dans notre cas) et l'erreur moyenne :

En plus de l'erreur résiduelle calculée par pixel, la transformation renvoie une erreur globale
appelée Erreur Quadratique Moyenne (EMQ)  ou bien Root Mean Square (RMS). Cette erreur est
calculée de la manière suivante :

EMQ = √ ( ( Somme dX[pixels] ² + Somme dY[pixels] ² ) / ( nb points – nb points min ) )

Vous pouvez donc constater que si le nombre de points utilisés est égal au nombre de points
minimum associé à la transformation, l'EMQ est considérée comme nulle. Une erreur nulle n'est
donc pas forcément révélatrice d'un calage précis...

VériDez que votre EMQ soit inférieure à 5. Si les erreurs de chacun de vos points sont
suffisamment faibles, comme vérifié plus haut, cela devrait être le cas.

VériDez ce qui se passe si vous décochez tous les points (colonne on/oG) sauf trois. Cochez un
quatrième point. Cochez à nouveau tous les points, sauf ceux ayant éventuellement des
valeurs d'erreur aberrantes.

Lancement du géoréférencement
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Pour procéder au géoréférencement proprement dit : 
ou bien cliquez sur l'icône correspondante.

Une barre de progression d'affiche, le processus peut être relativement long, patientez...

Une fois le géoréférencement terminé, l'image calée s'a@che dans QGIS (en plus de s'a@cher dans
la fenêtre du géoréférenceur).

Fermez la fenêtre du géoréférenceur.

Vérification de la précision du calage

Lecture de la carte et du rapport PDF

Ouvrez tout d'abord la carte PDF, qui se situe à l'emplacement que vous avez choisi
précédemment.

Cette carte montre le déplacement des diGérents points de calage. Attention, ce déplacement
n'est pas représenté à l'échelle de l'image, mais selon une échelle en pixels située en bas à gauche
de l'image.

Par exemple, le point 0 en haut à gauche s'est déplacé d'environ 2 ou 3 pixels vers le bas et un
peu moins d'un pixel vers la gauche. Vous pouvez constater que cette information coïncide avec
celle de la table des points :

Menu Fichier → Commencer le
géoréférencement 
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En eGet, les informations des cases dX[pixels] et dY[pixels] indiquent un déplacement de 2,77
pixels en Y (vers le bas) et -0,82 pixels en Y (vers la gauche). Ces chiGres seront diGérents dans
votre cas, mais ils seront cohérents avec votre carte PDF.

Le rapport PDF contient les mêmes informations que la carte PDF, présentées de manière
légèrement différente.

Vérification par superposition d'une autre couche

Une bonne manière de vériDer l'exactitude du géoréférencement est de superposer notre couche
calée à une couche déjà correctement géoréférencée.

Ici, nous allons utiliser la couche de pays de NaturalEarth [↗].

Si ce n'est pas déjà fait, ajoutez à QGIS votre carte calée de l'île d'Oahu.

Ajoutez ensuite la couche shapeDle ne_10m_admin_0_countries, disponible dans le dossier
TutoQGIS_04_Georef/donnees.

Les deux couches doivent normalement se superposer (ajustez éventuellement le style de la
couche de pays).

Félicitations, votre géoréférencement a fonctionné ! Vous pouvez si vous le voulez découvrir
l'autre méthode pour géoréférencer, en se basant sur une couche déjà calée, dans la partie
suivante.
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IV.6 Points de calage : en se basant sur une couche de
référence

Installation de l'extension OpenLayers
Ajout des données OpenStreetMap
Création des points de calage

Comme expliqué dans la partie IV.1.2, il est également possible de se baser sur une couche de
référence pour géoréférencer une image.

La manipulation sera la même que décrite dans les précédentes parties, sauf en ce qui concerne la
création des points de calage. Seule cette partie sera donc décrite ici.

L'image que nous allons caler est une carte de Doncaster East, dans la banlieue de Melbourne
(source : Wikimedia [↗]).

Pour caler cette carte, nous allons nous baser sur les données OpenStreetMap [↗].
OpenStreetMap est une base de données cartographique libre ; on décrit souvent ce projet
comme un "wikipedia cartographique".

Installation de l'extension OpenLayers

Accéder aux données OpenStreetMap dans QGIS requiert l'utilisation d'une extension nommée
OpenLayers. Cette extension permet également d'a@cher les données Google Maps, Bing,
Yahoo...

Ouvrez tout d'abord un nouveau projet QGIS.

Pour installer OpenLayers : : la fenêtre du
gestionnaire d'extensions s'ouvre.

Menu Extension → Installer/Gérer les extensions 

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 91/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

http://commons.wikimedia.org/wiki/File:Doncaster_east_locality_map.PNG
http://www.openstreetmap.org/
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


Dans la rubrique Tout, tapez « open » dans la partie Rechercher pour limiter les résultats,
sélectionner OpenLayers Plugin puis cliquez sur Installer l'extension  en bas à droite de la
fenêtre.

Fermez la fenêtre du gestionnaire d'extensions.

Le menu OpenLayers est maintenant visible dans le menu Internet (avant la version 2.6 de
QGIS, vous la trouverez dans le menu Extension). Nous n'allons pas utiliser tout de suite cette
extension.

L'a@chage de données OpenLayers se fait plus facilement lorsque vous avez déjà zoomé sur une
zone su@samment petite dans QGIS. Avant d'ajouter les données OpenStreetMap, nous allons
donc zoomer sur notre zone, Doncaster East.

Ajout des données OpenStreetMap
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Ajoutez tout d'abord la couche ne_10m_admin_0_countries, située dans le dossier
TutoQGIS_04_Georef/donnees.

Zoomez sur l'Australie, et plus particulièrement sur la zone de Melbourne :

Ajoutez maintenant les données OpenStreetMap : 
.

Zoomez éventuellement un peu, et si ce n'est pas déjà le cas passez la couche de pays par-
dessus la couche OSM :

Comme vous pouvez le voir dans le coin en bas à droite de la fenêtre, ou bien menu Projet,
propriétés du projet, le projet est en WGS84 EPSG:4326 (cf. partie II.3.1).

Dans quel système de coordonnées est votre projet ?

menu Extension → OpenLayers Plugin → Add
OpenStreetMap Layer 

Le projet est maintenant en WGS84 projection Pseudo Mercator, EPSG:3857.

Dans quel système de coordonnées est votre projet ?

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 93/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/4_6_zoom_melbourne.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


A l'ajout de données de l'extension OpenLayers, le SCR du projet est automatiquement
modifié en WGS84 Pseudo-Mercator, qui est le SCR utilisé notamment par Google Maps.

Il est toujours possible de modiDer à nouveau le SCR du projet ; cependant, tant que des données
OpenLayers sont a@chées, cela pourrait donner lieu à des bugs d'a@chage. Pour la suite des
opérations, nous travaillerons donc uniquement en Pseudo-Mercator.

Zoomez maintenant sur Doncaster East (pour vous aider : carte OpenStreetMap de Doncaster
Est [↗]).

Nous allons maintenant pouvoir procéder à la création des points de calage.

Création des points de calage

Ouvrez la fenêtre du géoréférenceur et ajoutez l'image à caler :
Doncaster_east_locality_map.PNG située dans le dossier TutoQGIS_04_Georef/donnees (si
nécessaire, aidez-vous pour cela du début de la partie IV.3.1).

Lorsque QGIS vous demande dans quel SCR est cette image, choisissez le WGS84 Pseudo-
Mercator EPSG:3857.
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Cliquez sur une intersection de routes, par exemple entre Reynolds Road et Blackburn Road. La
fenêtre de saisie des coordonnées apparaît : cliquez sur le bouton Depuis le canevas de la
carte.

Dans la fenêtre de QGIS, cliquez sur cette intersection sur les données OSM : les coordonnées
de la fenêtre de saisie sont automatiquement remplies avec les coordonnées du point sur
lequel vous venez de cliquer.
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Cliquez sur OK.

Premier point : à gauche, dans la fenêtre de QGIS (données OSM) et à droite, dans la fenêtre du géoréférenceur.

Procédez de la même manière pour obtenir au moins six points de calage.

Ensuite, choisissez les paramètres du géoréférencement (cf. partie IV.4) : vous pouvez choisir
les mêmes que précédemment, mais n'oubliez pas de sélectionner le SCR WGS84 Pseudo-
Mercator EPSG:3857 au lieu du WGS84 EPSG:4326.

Lancez le calage (cf. partie IV.5).

Une fois le calage terminé, vous pouvez en vériDer la précision en donnant de la transparence à
votre image calée (dans les propriétés de la couche, rubrique Transparence) :

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 96/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/4_6_coord_remplies.png
illustrations/tous/4_6_point_0.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


L'image est calée, son SCR est WGS84 Pseudo-Mercator (vous pouvez le vériDer en allant dans les
propriétés de la couche, rubrique Général). Si vous désirez modiDer le SCR de cette couche,
comme indiqué dans la partie II.4.2, clic-droit sur le nom de la couche, Sauvegarder sous...
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V. Numérisation

La numérisation consiste à « dessiner » par exemple les contours de parcelles en se basant sur
une couche déjà existante, ordinairement un raster. On obtient ainsi une couche vecteur, plus
facilement exploitable. Le principe est le même que lorsqu'on superpose une feuille de papier
calque à une carte pour y dessiner les éléments qui nous intéressent. Il est ensuite possible de lier
des données attributaires à cette couche.

Dans ce chapitre, nous allons numériser des données de la carte de l'île d'Oahu (Hawaii) de 1902
(source : Wikimedia [↗] ) géoréférencée dans le chapitre précédent. Si vous ne l'avez pas
géoréférencée, pas de problème : elle est inclue dans les données du chapitre.

Notions abordées :

Création d'une couche vide
Numérisation de points, lignes et polygones
Remplir les données attributaires
Notions de topologie

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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V.1 Création d'une couche vide

Choix du type (point, ligne, polygone) et du SCR
Définition des colonnes de la table attributaire

Ajout d'une colonne
Suppression d'une colonne

Enregistrement de la couche

Le but va être ici de créer une couche de points qui contiendra les école et les postes de l'île
d'Oahu, qui sont représentées dans la carte sous forme de points bleus ou rouges :

Choix du type (point, ligne, polygone) et du SCR

La première étape consiste à créer une couche vierge, qui accueillera les données que nous allons
créer.

Dans QGIS, ouvrez un nouveau projet

Rendez-vous dans le ou bien
cliquez sur l'icône correspondante (vous pouvez aussi utiliser le raccourci clavier
Ctrl+Maj+N).

La fenêtre suivante apparaît :

Menu Couche → Nouveau → Nouvelle couche shapeDle... 
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Type : choisir Point
SCR : aDn que cette couche soit dans le même système que la carte, vériDer que le SCR
soit bien le WGS84

Ne cliquez pas encore sur OK...

Définition des colonnes de la table attributaire

Vous pouvez ensuite choisir les champs que contiendra la table attributaire, c'est-à-dire les
colonnes de la table. Trois types de champs sont possibles : texte, entier et décimal (nombre à
virgule).

Ici, nous allons créer une couche avec un seul champ dans la table, qui renseignera le type de
bâtiment (ce champ aura donc deux valeurs possibles : école ou poste).

Il sera toujours possible d'ajouter ou de supprimer des champs par la suite !

Ajout d'une colonne

Pour ajouter une colonne :
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Nom : ce sera le nom de la colonne, tapez par exemple type

Type : le type de données que contiendra la champ. Ici, données texte permettra de
taper du texte dans cette colonne

Largeur : pour un champ de type texte, ceci correspond au nombre maximum de
caractères que pourra contenir le champ. Les mot "école" et "poste" comportent tous
deux 5 caractères : une largeur de 5 su@rait ici. Pour avoir un peu de marge (supposons
que l'on veuille par la suite ajouter un 3ème type de bâtiment), choisissons une largeur
de 10.

Cliquez ensuite sur le bouton Ajouter à la liste d'attributs  pour créer ce champ.

Suppression d'une colonne

Nous allons supprimer le champ id créé par défaut. Pour cela, sélectionnez la ligne du champ
id et cliquez sur le bouton Supprimer l'attribut.
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Terminez en cliquant sur le bouton OK pour valider vos choix.

Enregistrement de la couche

Dans la fenêtre qui apparaît alors, choisissez :

l'emplacement (par exemple dossier TutoQGIS_05_Numerisation/donnees)

et le nom : batiments_oahu (dans tous les cas le nom de doit comporter que des lettres
non accentuées, des chiffres ou le caractère _ )
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Cliquez sur Enregistrer pour créer la couche. Elle est automatiquement ajoutée à QGIS.

Vous pouvez vérifier son SCR (propriétés de la couche, rubrique Général) :

Vous pouvez également ouvrir sa table attributaire, qui ne doit contenir qu'une seule colonne
nommée type et aucune ligne.

Pour ajouter maintenant des données à cette couche, rendez-vous au chapitre suivant...
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V.2 Ajout de points dans une couche

Rendre une couche éditable
Ajout d'un point
Modification d'un point

Déplacement
Modification des données attributaires

Quitter le mode édition

Nous allons ajouter à la couche créée dans le chapitre précédent les points correspondant aux
postes et aux école de la carte de l'île d'Oahu.

Créez un nouveau projet QGIS, et ajoutez-y :

la carte géoréférencée Oahu_Hawaiian_Islands_1906_wgs84.tif située dans le dossier
TutoQGIS_05_Numerisation/donnees

la couche vide créée dans le chapitre précédent : batiments_oahu.shp

Rendre une couche éditable

Par défaut, toutes les couches ajoutées dans QGIS sont « verrouillées » donc non modiDables
(modifier la couleur, le style ne modifie pas les données mais seulement leur représentation).

Pour rendre une couche éditable, que ce soit pour modiDer les données de la table attributaire ou
la géométrie d'un élément, il faut donc passer en mode édition. Nous allons faire cette
manipulation pour la couche batiments_oahu afin de pouvoir y ajouter des points.

Vérifiez tout d'abord que votre couche de bâtiments soit au-dessus de la carte.

Pour passer en mode édition : 

ou bien :

sélectionnez la couche dans la table des matières puis cliquez sur l'icône Basculer en
mode édition

ou encore :

sélectionnez la couche dans la table des matières puis 
.

Certains outils de la barre d'outil d'édition deviennent actifs, et dans la table des matières un
symbole de crayon apparaît à gauche du nom de la couche :

Clic droit sur le nom de la couche → Basculer en mode édition

Menu Couche → Basculer en mode
édition 

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 104/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


La couche est maintenant modifiable.

Dans QGIS, le passage en mode édition est géré « par couches » : certaines couches peuvent être
éditables et d'autres non. Il est facile de voir dans la tables des matières quelle couche est
éditable.

De manière générale, il vaut mieux quitter le mode édition dès que vous n'en avez plus
besoin, et limiter le nombre de couches éditables.

Les couches raster ne sont jamais modiDables : si vous sélectionnez la carte de l'île d'Oahu, le
passage en mode édition n'est pas possible pour cette couche.

Ajout d'un point

Commencez par repérer une école ou une poste, représentées respectivement par un point
bleu ou rouge, par exemple la poste de la baie de Kaneohe :

Assurez-vous que votre couche de bâtiments soit bien sélectionnée dans la table des
matières, puis cliquez sur l'icône Ajouter une entité.

Cliquez sur l'école ou la poste que vous avez choisie; une fenêtre s'ouvre vous demandant de
renseigner les attributs pour ce point (un seul attribut dans notre cas). Renseignez le type de
bâtiment et cliquez sur OK.
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Le point s'affiche sur la carte, avec le style de la couche (ici un rond turquoise) :

Si vous ouvrez la table attributaire de la couche, vous pouvez voir une ligne correspondant au
point que vous venez de créer.

Ajoutez d'autres points pour les écoles et postes de l'île.
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N'oubliez pas de sauvegarder vos modiDcations en sélectionnant la couche puis en
cliquant sur l’icône sauvegarder les modifications.

Vous pouvez modiDer le style des points dans les propriétés de la couche, rubrique Style
(cf.partie partie I.2.3a).

Comment faire pour représenter les données comme dans la légende de la carte, les
écoles sous forme de rond bleu et les postes de rond rouge ?
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Modification d'un point

Il peut arriver bien sûr de vouloir modiDer un point déjà existant, soit que vous vouliez le déplacer,
soit que vous souhaitiez modifier ses données attributaires.

Déplacement

Imaginons qu'un de vos points soit mal placé et que vous vouliez le déplacer.

La couche doit être en mode édition.

Sélectionnez votre couche de bâtiments dans la table des matières, puis cliquez sur
l'icône Déplacer une entité.

Le curseur prend la forme d'une croix blanche. Cliquez sur le point à déplacer, et faites-le
glisser en maintenant le bouton de la souris enfoncé. Relâchez le bouton de la souris une fois le
point à l'emplacement de votre choix.

Modification des données attributaires

Que faire dans le cas où vous voulez modiDer les données attributaires d'un point, par exemple le
passer de poste à école?

La couche doit être en mode édition.

Ouvrez la table attributaire de la couche.

Double-cliquez sur la case de la table à modiDer. Vous pouvez ensuite modiDer le texte de cette
case.

Quitter le mode édition

Une fois vos ajouts et modiDcations terminées, il est important de quitter le mode édition, pour
plusieurs raisons :

éviter de faire de modifications par erreur
sauvegarder les modifications effectuées
certains outils SIG ne peuvent fonctionner sur une couche en cours d'édition

Choisissez le style catégorisé sur la colonne type, cliquez sur classer puis double cliquez sur
chacun des symboles pour les modiJer à votre convenance. Cliquez sur OK pour valider et fermer la
fenêtre.
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Sélectionnez votre couche dans la table des matières et cliquez sur l'icône basculer en
mode édition.

Une fenêtre apparaît vous demander si vous souhaitez :

Fermer sans enregistrer :  quitte le mode édition sans sauvegarder vos modifications
Annuler : ne quitte pas le mode édition
Enregistrer : quitte le mode édition en enregistrant vos modifications.

Cliquez sur Enregistrer.

L'icône de crayon à côté de nom de la couche disparaît :
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V.3 Saisie des données attributaires : en savoir plus

Saisir les données : à la création de l'entité ou dans la table
Pour une saisie plus facile : les outils d'édition

Cette partie est tout à fait optionnelle pour suivre la suite du chapitre. Elle pourra néanmoins vous
faire gagner du temps si vous vous apprêtez à saisir des données sous QGIS...

Saisir les données : à la création de l'entité ou dans la table

Vous avez remarqué que la saisie des données attributaires se fait dans une fenêtre qui apparaît
directement après avoir créé une entité.

Il est possible de modifier ce comportement :

Rendez-vous dans le menu :

Dans la rubrique Numérisation, cochez la case Supprimer les fenêtres d'avertissement lors
de la création de chaque entité. Cliquez sur OK pour valider et fermer la fenêtre.

Créez un nouveau point dans la couche de bâtiments : aucune fenêtre ne s'a@che. Si vous
ouvrez la table attributaire, vous pouvez voir que le point créé a un type NULL (valeur par
défaut).

Menu Préférences → Options 

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 110/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/5_3_options_fenetre.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


Il est ensuite possible de rentrer les données attributaires directement dans la table. La
calculatrice de champ oGre la possibilité de remplir plusieurs cases avec une requête (cf. partie
VII.3).

Pour une saisie plus facile : les outils d'édition

Il est possible de déDnir des règles pour la saisie d'attributs : vous pouvez par exemple saisir vos
données en choisissant une valeur dans une liste déroulante.

Ouvrez les propriétés de la couche batiments_oahu créée en V.1 , rubrique Champs.

Cliquez sur Edition de ligne.

Cette fenêtre propose diGérents outils pour faciliter la saisie. Le mode Edition de ligne est le
mode par défaut que vous avez utilisé jusqu'ici.

Par exemple, il est possible de faciliter la saisie de date à l'aide d'un calendrier, de voir un champ
sous forme de case à cocher, de créer des listes déroulantes...

Sans passer en revue tous les outils possibles, nous nous bornerons à créer une liste déroulante
avec les deux valeurs « ecole » et « poste » .
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Cliquez sur Liste de valeurs dans la colonne de gauche.

Ajoutez les valeurs ecole et poste dans la colonne Valeur du tableau (vous pouvez laisser la
colonne Description vide).

Cliquez sur OK.

Passez en mode édition si ce n'est pas déjà fait. Ouvrez la table attributaire.

Double-cliquez dans une case : une liste déroulante avec les deux valeurs poste et école
apparaît.

Notez que cette liste déroulante sera également utilisable dans la fenêtre de saisie des attributs, si
la case Supprimer les fenêtres d'avertissement lors de la création de chaque entité  des
options de numérisation est décochée (cf. plus haut).
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Pour en savoir plus, les différents outils d'édition sont décrits dans le manuel QGIS [↗].
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V.4 Numériser des lignes

Création d'une couche de lignes
Ajout d'une ligne

Première ligne
Quelques astuces

Modification du tracé d'une ligne

Nous avons vu précédemment comment numériser des points. Comment procéder quand le but
est de numériser des lignes ? Nous allons numériser des fleuves de la carte de l'île d'Oahu.

Création d'une couche de lignes

Reportez-vous à la partie V.1 pour créer une couche de ligne, en choisissant cette fois :

le type ligne
un seul champ de type texte, de longueur 80, nommé nom (il contiendra le nom des
fleuves)
nommez cette couche fleuves_oahu.

VériDez que cette couche soit bien chargée dans votre projet, ainsi que la carte
Oahu_Hawaiian_Islands_1906_wgs84.tif

Ajout d'une ligne

Première ligne

Zoomez sur un fleuve, par exemple dans le nord est de l'île, dans la région de Makaha :
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Passez en mode édition pour votre couche de fleuves.

Cliquez sur l'icône Ajouter une entité (vous remarquerez que cette icône varie en
fonction du type de la couche éditée, point, ligne ou polygone).

Cliquez sur le début du deuve pour créer un premier sommet, puis rajoutez d'autres points à
votre ligne. Pour terminer, faites un clic-droit n'importe où.

Quelques astuces

Si pendant la numérisation vous avez des difficultés à voir votre ligne : menu Préférences,
Options, rubrique Numérisation : réglez l'épaisseur de la ligne, par exemple 2, et la couleur.
Pour la , n'oubliez pas de mettre le cana alpha, c'est-à-dire la transparence, à 255
pour éliminer toute transparence (une fois la ligne terminée, elle prend le style spéciDée
dans les propriétés de la couche)

Supprimer le dernier point créé :  touche suppr ou retour arrière (backspace)

Se déplacer tout en numérisant :  utilisez les dèches du clavier, ou bien maintenez la
molette de la souris ou la touche espace enfoncée et bougez la souris

Abandonner la ligne en cours :  terminez-la avec un clic droit, puis si les fenêtres de saisie
d'attributs sont activées cliquez sur annuler, sinon utilisez ctrl + z

Modification du tracé d'une ligne

Il est possible de modiDer le tracé d'une ligne existante en déplaçant des sommets, en en
rajoutant ou supprimant.

couleur 
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VériDez que vous êtes bien en mode édition pour la couche de deuves. Sélectionnez-la
dans la table des matières, puis cliquez sur l'icône Outil de nœud.

Cliquez sur une ligne existante : les sommets prennent la forme de carrés rouges.

Si vous cliquez sur un sommet, il est sélectionné et devient bleu. Vous pouvez grâce à l'outil de
nœud :

déplacer un sommet en le faisant glisser

supprimer un sommet : cliquez dessus pour le sélectionner, puis appuyez sur la touche
suppr

rajouter un sommet : double-cliquez sur la ligne à l'endroit où vous voulez créer un
sommet. Vous pouvez ensuite déplacer ce nouveau sommet.

Une fois vos modiDcations terminées, n'oubliez pas de quitter le mode édition en
enregistrant vos modifications.
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V.5 Numériser des polygones

Création d'une couche de polygones
Ajout d'un polygone
Découpage d'un polygone
Frontière commune entre 2 polygones : comment est-elle gérée ?
Ajout d'un élément en s'appuyant sur un autre : l'accrochage
Éviter les intersections entre polygones jointifs

Pour numériser des polygones, les choses se compliquent un peu... Nous n'allons pas ici
numériser toutes les zones de l'île, mais passer en revue quelques techniques d'édition de
polygones au moyen de quelques exemples.

Création d'une couche de polygones

Reportez-vous à la partie V.1 pour créer une couche de polygones, en choisissant cette fois :

le type polygone

deux champs de type texte, de longueur 80, nommés type1 et type2 (ils contiendront les
types de zone, tels qu'indiqués dans la légende)

nommez cette couche zones_oahu.

VériDez que cette couche soit bien chargée dans votre projet, ainsi que la carte
Oahu_Hawaiian_Islands_1906_wgs84.tif

Ajout d'un polygone

Nous allons commencer par numériser la réserve forestière de l'île :
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Passez en mode édition pour votre couche de polygones. Zoomez sur la réserve forestière.

Cliquez sur l'icône Ajouter une entité qui a pris la forme d'un polygone.

Cliquez sur un point du polygone, puis ajoutez d'autres sommets comme pour une ligne. La
forme du polygone évolue au fur et à mesure.
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Lorsque le polygone est complet, faites un clic droit n'importe où pour le terminer. Il est inutile
de cliquer à nouveau sur le premier sommet !

Vous pouvez maintenant remplir les données attributaires pour ce polygone, par exemple en
donnant la valeur "Forest Reserves" en type1, et aucune valeur en type2.

Découpage d'un polygone

La partie Nord de notre réserve est occupée par des terres publiques (Public Lands) puis par une
réserve fédérale (Federal Reservation). Comment diviser notre polygone pour faire apparaître ces
zones ?

VériDez que la barre d'outils Numérisation avancée soit activée : Numérisation avancée doit
être cochée dans le .

Dans la barre d'outils Numérisation avancée, cliquez sur l'icône Séparer les entités.

Cliquez à l'extérieur du polygone, puis de l'autre côté du polygone en suivant la ligne selon
laquelle le découper. Terminez par un clic droit n'importe où. Il est possible de créer des points

Menu Vue → Barres d'outils 
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à l'intérieur du polygone mais il faut terminer par un point à l'extérieur du polygone.

Procédez de la même manière pour découper la bande de terrain public de Waimano, et la
petite langue de terre de Aiea.

Frontière commune entre 2 polygones : comment est-elle gérée ?

A l'aide l'outil de nœud  (cf. partie V.4.3), déplacez un sommet de la petite langue de
terre d'Aiea.
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A l'aide de l'outil de sélection, sélectionnez successivement le polygone d'Aiea, et celui
qui l'entoure.

Rendez-vous maintenant dans le et cochez la case
Activer l'édition topologique  en bas à gauche de la fenêtre.

Déplacez à nouveau un sommet d'un des polygones et sélectionnez successivement les deux
polygones.

Ajout d'un élément en s'appuyant sur un autre : l'accrochage

Pour rajouter un élément qui en touche un autre, il est possible de s'aimanter sur les sommets ou
les segments de l'élément déjà existant. Cette propriété n'est bien sûr pas propre seulement aux
couches de polygones mais fonctionne aussi pour les couches de lignes et de points.

Ceci permet de faire en sorte que deux polygones soient parfaitement contigus, sans aucun trou
ou superposition.

Par exemple, comment faire pour rajouter la partie Ouest de la bande de Waimano en s'aimantant
aux polygones déjà existants ?

Les deux polygones ne sont plus jointifs. Le déplacement d'un sommet d'un des polygones n'a pas
eu d'effet sur le sommet correspondant du deuxième polygone.

Que constatez-vous ?

Menu Préférences → Options d'accrochage 

Les deux polygones sont toujours jointifs. Le déplacement d'un sommet d'un des polygones a
provoqué le déplacement du sommet correspondant du deuxième polygone.

Que constatez-vous ?
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Rendez-vous dans le Menu Préférences → Options d'accrochage :

Cette fenêtre permet de déDnir à quelle(s) couche(s) le curseur sera aimanté, s'il sera aimanté
uniquement par les sommets ou également par les segments, et à quelle distance d'un sommet
ou segment l'aimantage prend effet.

Par exemple, pour être automatiquement aimanté à votre couche de polygone dès que votre
curseur approche à moins de 10 pixels d'un sommet de cette couche, cochez la case de
zones_oahu, choisissez le mode sur un sommet et fixez la tolérance à 10 pixels.

Cliquez sur l'icône Ajouter une entité, et approchez-vous d'un sommet d'un polygone déjà
créé : votre curseur est aimanté par ce sommet, qui apparaît alors en rose.

ProDtez-en pour numériser la partie Est de la bande d'Aiea, de manière à ce que les deux
parties soient parfaitement jointives.

Éviter les intersections entre polygones jointifs

L'accrochage est une propriété pratique pour quelques sommets, mais si vous souhaitez créer un
polygone contigu à une autre sur une longue portion (par exemple le polygone en pointillés bleus
sur la carte), cela peut être fastidieux de cliquer un à un sur tous les sommets communs.

Pour éviter cela, rendez-vous à nouveau dans le menu Préférences → Options d'accrochage et
cochez la case Éviter les intersections pour la couche zones_oahu.

Cliquez sur l'icône Ajouter une entité, et dessinez un par exemple le polygone en pointillés
bleu correspondant à la surface des terres forestières qui ne sont pas en réserve. Ce polygone
est contigu sur une longue portion à des polygones que vous avez déjà créés : ne suivez pas les
bords pour cette partie mais contentez-vous de passer au milieu des polygones déjà existants.

Faites un clic droit pour terminer le polygone : les parties du polygone que vous venez de
dessiner qui étaient superposées à des polygones déjà existants ont été automatiquement
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supprimées.
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V.6 Quelques notions de topologie

Qu'est-ce que la topologie ?
Définition et exemples
Pourquoi faire attention la topologie ?

Pour aller plus loin : comment vérifier la topologie d'une couche ?
Vérification simple
Utilisation du vérificateur de topologie

Corriger les erreurs de topologie : quelques pistes

Au cours de la dernière partie notamment, nous avons vu comment éviter que deux polygones
soient "presque" jointifs, au moyen de propriétés telles que l'accrochage, ou par l'utilisation
d'outils de découpage par exemple. Nous avons également vu comment utiliser le mode d'édition
topologique de QGIS.

Nous allons ici en apprendre un peu plus sur ce qu'est la topologie, et comment vériDer la
topologie d'une couche.

Qu'est-ce que la topologie ?

Définition et exemples

La topologie [↗] est la « partie de la géométrie qui considère uniquement les relations de position
» (Aur.-Weil 1981).

En géomatique, la topologie est utilisée pour décrire les relations entre les géométries des entités.
Des règles de topologie peuvent être définies, et les erreurs de topologie détectées.

Par exemple, on peut décider qu'il ne doit y avoir aucune superposition de polygones dans une
couche :

Ou bien qu'il ne doit pas y avoir de trous entre les polygones :
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Les règles de topologie peuvent aussi mettre en jeu plusieurs couches. Par exemple, tous les
points d'une couche doivent être dans un polygone d'une autre couche :

Il est bien sûr possible de combiner plusieurs règles. Vous trouverez dans le manuel de QGIS [↗] la
description d'un certain nombre de règles de topologie.

Pour en savoir plus, vous pouvez également consulter cet article du portail SIG  [↗].

Pourquoi faire attention à la topologie ?

Ne pas respecter les règles de topologie peut poser des problèmes lors de l'utilisation d'outils
d'analyse spatiale, qui donneront alors des résultats inattendus.

Pour aller plus loin : comment vérifier la topologie d'une couche ?

Cette partie est pour « aller un peu plus loin » : vous pouvez donc passer directement à la partie
suivante si vous le désirez !

Vérification simple

Pour vériDer rapidement la topologie d'une couche, rendez-vous dans le menu
:Vecteur → Outils de géométrie → Vérifier la validité de la géométrie 
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Sélectionnez la couche zones_oahu et cliquez sur OK : les éventuelles erreurs sont listées, un
double clic sur une erreur zoome dessus.

Utilisation du vérificateur de topologie

Le vériDcateur de topologie est un outil plus perfectionné qui permet de spéciDer un certains
nombre de règles, et de de voir les erreurs à ces règles.

Pour accéder au vériDcateur de topologie : 
:

menu Vecteur → VériDcateur de topologie →
Vérificateur de topologie 
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Cliquez sur le bouton Configuration pour ajouter ou supprimer des règles de topologie. Nous
allons ajouter une règle pour interdire les superpositions de polygones dans la couche
zones_oahu.

Sélectionnez la couche zones_oahu dans la liste déroulante, puis la propriété must not
overlap et cliquez enfin sur le bouton Ajouter une règle. Cliquez sur OK.

Pour visualiser les erreurs à cette règle, cliquez sur le bouton Valider tout du vériDcateur de
topologie.

La liste des éventuelles erreurs apparaît; il est possible de zoomer sur une erreur en double-
cliquant sur la ligne correspondante.

Corriger les erreurs de topologie : quelques pistes

Pour corriger les erreurs de topologie d'une couche, vous pouvez procéder « à la main » , en
corrigeant les erreurs une à une avec les outils d'édition de QGIS. Cliquer sur la ligne
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correspondant à une erreur dans le vérificateur de topologie zoome sur cette erreur.

Si vous avez un grand nombre d'erreurs à corriger, vous pouvez aussi utiliser des outils de
correction automatique, notamment ceux de grass. Ces outils sont disponibles dans QGIS via la

. Tapez clean dans le filtre pour accéder à l'outil v.clean.

En double-cliquant sur cet outil, une aide est accessible dans l'onglet Help, ou bien ici :
http://grass.osgeo.org/grass65/manuals/v.clean.html [↗]. Regardez également ici [↗] pour plus de
documentation.

boîte à outils du menu Traitements 
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VI. Sélectionner des données : les requêtes

A partir d'une couche vecteur, il est possible de sélectionner des éléments répondant à un ou
plusieurs critères, en se basant sur les données contenues dans la table attributaire  ou bien
sur la position de ces éléments .

Vous pouvez ainsi sélectionner par exemple des communes dans la population est supérieure à
10 000 habitants, ou les communes à l'intérieur d'un département...

Ceci vous permet par exemple de compter le nombre d'éléments répondant à vos critères, ou
bien de créer une nouvelle couche à partir de votre sélection, pour y réaliser ensuite d'autres
traitements.

Notions abordées :

Requêtes attributaires
Requêtes spatiales
Opérateurs
Fonctions
Utiliser une sous-sélection

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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V I . 1 Sélectionner des éléments en fonction de leurs
données attributaires : requêtes attributaires

Faire une requête simple
Créer une nouvelle couche à partir d'une sélection
Quelques opérateurs
Combiner plusieurs critères
Quelques exemples à tester

Nous allons voir ici comment utiliser les données de la table attributaire pour sélectionner des
éléments d'une couche, par exemple comment sélectionner les départements dans le nom
commence par « A » .

Beaucoup d'opérateurs sont disponibles pour les requêtes attributaires; nous ne les passerons
pas tous en revue mais allons simplement utiliser quelques uns des plus courants.

Pour une description de tous les opérateurs et fonctions possibles : voir le manuel de QGIS [↗]
(cette partie correspond à la calculatrice de champ mais est valable également pour les requêtes
attributaires).

Faire une requête simple

Ajoutez la couche departements située dans le dossier TutoQGIS_06_Requetes/donnees.

Ouvrez la table attributaire de cette couche.

Pour sélectionner le département du Nord (59), vous pouvez cliquez sur le numéro de la ligne
correspondante ou bien directement sur ce département sur la carte. Vous pouvez aussi utiliser
par une requête attributaire.

Dans la barre d'outils située en haut de la table attributaire, cliquez sur l'icône Sélectionne les
entités en utilisant une expression.

Cette icône est aussi accessible dans la barre d'outils attributs, à condition que vous ayez au préalable
sélectionné la couche dans la table des matières.

La fenêtre de requête attributaire s'ouvre :
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Pour faire une requête simple, par exemple pour sélectionner le département du Nord :

Cliquez sur Champs et valeurs dans la colonne de gauche : la liste des champs de la
table apparaît

Double-cliquez sur le champ NOM_DEPT pour le faire apparaître dans la case
Expression en bas de la fenêtre (notez les guillemets doubles)

Cliquez sur l'opérateur =

Cliquez sur le bouton Charge toutes les valeurs uniques pour voir dans la case Valeurs
de champs la liste des valeurs uniques du champ sélectionné (ici, NOM_DEPT)

Double-cliquez sur la valeur 'NORD' (notez les guillemets simples)

A ce stade, la case Expression doit contenir : "NOM_DEPT" = 'NORD'

Cliquez sur le bouton Sélection en bas de la fenêtre

Il est également possible de taper la requête « à la main » directement dans la case Expression. Attention
dans ce cas à bien respecter la syntaxe utilisée par QGIS : par exemple, les noms de champs sont entourées
de guillemets doubles et les chaînes de caractères de guillemets simples.

La fenêtre de requête attributaire ne se ferme pas automatiquement ; vous pouvez ou la
fermer en cliquant sur le bouton Fermer ou bien simplement la déplacer pour vériDer sur la
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carte le résultat de votre sélection.

Vous pouvez lire le nombre d'éléments sélectionnés en haut de la table attributaire :

Vous venez d'eGectuer une requête attributaire simple. Il est important de comprendre qu'une
requête ne modifie pas les données, elle les sélectionne simplement.

Bien sûr, il est plus intéressant d'utiliser les requêtes pour sélectionner plusieurs éléments en
même temps!

Créer une nouvelle couche à partir d'une sélection

Il est possible de créer une nouvelle couche shapefile à partir d'une sélection.

Votre département du Nord étant toujours sélectionné, faites un clic droit sur la couche de
départements dans la table des matières et choisissez :Sauvegarder la sélection sous... 
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Cliquez sur Parcourir pour choisir à quel endroit sera sauvegardée la nouvelle couche, et
sous quel nom, dept59 par exemple

cochez la case Ajouter les fichiers sauvegardés à la carte

et cliquez sur OK

La nouvelle couche est automatiquement ajoutée à QGIS. Elle ne contient qu'un seul
département, celui du Nord.

Quelques opérateurs

Dans l'exemple ci-dessus, nous avons utilisé l'opérateur = pour notre requête. Il en existe d'autre,
comme par exemple les opérateurs mathématiques inférieur à et supérieur à, multiplier, diviser...

Ajoutez la couche communes_NordPasDeCalais située dans le dossier
TutoQGIS_06_Requetes/donnees.

Fermez la table attributaire de la couche de départements et ouvrez celle de la couche de
communes. Cette table comporte une colonne POPULATION avec la population de chaque
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commune en milliers d'habitants.

Nous allons faire une requête pour sélectionner les communes de + de 10 000 habitants.
Ouvrez la fenêtre de requête pour la couche de communes :

Cliquez sur Champs et valeurs pour voir la liste des champs, puis double-cliquez sur le
champ POPULATION

Dans la case Expression, tapez > 10 (puisque la population est en milliers d'habitants)

Il est également possible d'aller chercher l'opérateur > dans la liste des opérateurs, dans la
colonne de gauche. Il faut ensuite taper la valeur 10 à la main.

Une fois votre requête tapée : "POPULATION" > 10 , cliquez sur le bouton Sélection pour voir
le résultat :

En cliquant deux fois sur le nom de colonne POPULATION pour classer la population par ordre
décroissant, on peut lire que la commune de Lille est la plus peuplée avec 225 800 habitants.

Pouvez-vous dire rapidement quelle est la commune la plus peuplée ?
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La ligne Opérateurs visible dans la fenêtre de sélection n'en comporte que quelques uns; vous
pouvez tous les retrouver dans la catégorie Opérateurs de la colonne de gauche. En cliquant sur
un opérateur, vous pouvez lire l'aide dans la partie de droite :

Parmi ces opérateurs se trouvent par exemple LIKE et ILIKE. L'opérateur LIKE permet de
comparer une chaîne de caractère à une autre chaîne qui peut utiliser le caractère joker %.

Ce caractère peut remplacer un ou plusieurs caractères : par exemple, 'A%' peut correspondre à
Ardèche, Allier...
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Sélectionnons les communes dont le nom se termine par 'IN' !

Ouvrez la fenêtre de sélection pour la couche de communes. Écrivez la requête suivante :
"NOM_COMM" LIKE '%IN' (soit en la tapant à la main soit en double-cliquant sur les diGérents
éléments).

Notez que, pour du texte, si le caractère % n'est pas utilisé, les opérateurs = et LIKE sont
équivalents.

L'opérateur ILIKE est équivalent à LIKE mais ne tient pas compte de la casse (majuscules ou
minuscules).

Entre deux requêtes, pour être sûr de repartir à zéro, utiliser l'outil tout désélectionner.

Combiner plusieurs critères

Comment faire s'il l'on veut sélectionner par exemple les communes de + de 10 000 habitants
dont le nom se termine par 'IN' ?

Il s'agit ici de combiner deux critères. Deux opérateurs permettent cela : AND (et) et OR (ou).

Avec l'opérateur AND, tous les critères doivent être remplis
Avec l'opérateur OR, il suffit qu'un seul des critères  soit rempli

Quelle requête utiliser pour sélectionner les communes de moins de 10 000 habitants
dont le nom commence par A ?
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Quelques exemples à tester

Pouvez-vous sélectionner ? ...

(plusieurs requêtes sont parfois possibles pour un même résultat)

"NOM_COMM" LIKE 'A%' and "POPULATION" < 10000 : cette requête sélectionne 104 communes.

"NOM_COMM" LIKE 'LILLE' OR "NOM_COMM" LIKE 'TOURCOING' OR "NOM_COMM" LIKE 'ROUBAIX' :
cette requête sélectionne 3 communes. L'opérateur OR doit être utilisé car les communes ne peuvent
satisfaire qu'un seul des critères à la fois (une commune ne peut s'appeler Lille et Roubaix en même
temps).

Quelle requête utiliser pour sélectionner les communes de Lille, Roubaix et Tourcoing ?

"NOM_COMM" = 'ARRAS' : une commune sélectionnée

La commune d'Arras ?

"INSEE_COM" = '62041' : une commune sélectionnée

La commune de code INSEE 62041 ?

"NOM_DEPT" LIKE 'NORD' : 650 communes sélectionnées

Les communes du département du Nord ?

"NOM_COMM" LIKE '%OO%' : 10 communes sélectionnées

Les communes dont le nom contient 'OO' ?

"NOM_COMM" LIKE 'M%IN' : 4 communes sélectionnées

Les communes dont le nom commence par 'M' et se termine par 'in' ?

"POPULATION" >= 10 AND "POPULATION" <= 50 : 71 communes sélectionnées

Les communes dont la population est comprise entre 10 000 et 50 habitants inclus ?

"NOM_DEPT" LIKE 'NORD' AND ( "NOM_COMM" LIKE '%W%' OR "NOM_COMM" LIKE '%OO%') AND
"POPULATION" <= 10 : 55 communes sélectionnées

Les communes du département du Nord, dont le nom contient ou 'w' ou 'oo', et dont la
population est inférieure ou égale à 10 000 habitants ?
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V I . 2 Sélectionner des éléments en fonction de leur
position par rapport à d'autres : requêtes spatiales

Faire une requête spatiale simple
Quelques opérateurs

Nous venons de voir comment sélectionner des éléments en fonction des données de la table
attributaire ; nous allons voir ici comment sélectionner des éléments en fonction de leur position
par rapport aux éléments d'une autre couche.

Contrairement aux requêtes attributaires, les requêtes spatiales mettent donc le plus souvent
deux couches en jeu : une couche dans laquelle sera faite la sélection, et une couche de référence.

On peut par exemple, à l'aide d'une couche de points et d'une couche de polygones, sélectionner
tous les points situés dans les polygones.

Faire une requête spatiale simple

Ouvrez un nouveau projet QGIS et ajoutez-y la couche communes_NordPasDeCalais.

En vous connectant au dux WFS http://ws.carmen.developpement-
durable.gouv.fr/WFS/24/eolien (cf. partie III.2.3), ajoutez également au projet la couche
eoliennes.

Le but va être ici de sélectionner toutes les communes du Nord-Pas-de-Calais sur lesquelles
sont implantées une ou plusieurs éoliennes.

Rendez-vous dans le .menu Vecteur → Requête spatiale → Requête spatiale 
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Sélection des entités sources depuis :  il s'agit de la couche dans laquelle sera faite la
sélection, sélectionnez la couche de communes

Où l'entité : sélectionnez l'opérateur Contient

Entités références de : il s'agit de la couche par rapport à laquelle seront sélectionnés
les éléments, sélectionnez la couche d'éoliennes

Cliquez sur Appliquer et patientez un peu...
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117 communes sur 1545 contiennent une éolienne ou plus.

Dans la partie droite de la fenêtre de requête spatiale sont listées les objets répondant à la
requête; il est possible de zoomer sur chacun de ces objets en cochant la case Zoom sur
l'objet puis en cliquant sur une ligne.

Il est également possible dans cette fenêtre de créer une couche temporaire à partir de
la sélection, en cliquant sur l'icône Créer une couche depuis la sélection .

Cette couche sera uniquement sauvegardée dans le projet ; pour la sauvegarder
définitivement, clic droit sur son nom, sauvegarder sous...
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Quelques opérateurs

Dans l'exemple ci-dessus, nous avons utilisé l'opérateur Contient. Il en existe d'autres ; ils varient
en fonction de la nature des couches source et de référence (point, ligne, polygone).

Opérateurs de requête spatiale disponibles en fonction des types des couches de de départ
et de référence.

Couche de départ :

Couche de référence :

A l'intérieur

Chevauche

Croise

Contient

Est disjoint

Est égal

Intersecte

Touche

Par exemple, un point peut se trouver à l'intérieur d'un polygone mais une ligne ne peut se
trouver à l'intérieur d'un point.

Ajoutez la couche dept59 créée dans la partie VI.1.2.

Connectez-vous au dux WFS http://services.sandre.eaufrance.fr/geo/zonage (cf. partie
III.2.3) et ajoutez la couche COURDO1 correspondant aux cours d'eau de + de 100 km.

En utilisant différents opérateurs, pouvez-vous dire ?...

Entre deux requêtes, n'oubliez pas de tout désélectionner :

En sélectionnant les éoliennes disjointes des communes (4/440), ou bien les éoliennes à l'intérieur
des communes (436/440), on peut en déduire que 4 éoliennes sont en-dehors d'une commune.

S'il y a des éoliennes qui ne sont pas dans une commune du Nord-Pas-de-Calais ?

En sélectionnant les communes intersectant les cours d'eau (482/1545), ou bien les communes
disjointes des cours d'eau (1063/1545), on peut en déduire que 482 communes sont traversées par
un cours d'eau.

Combien de communes sont traversées par un cours d'eau ?

En sélectionnant les communes à l'intérieur du département du Nord, 650/1545 communes sont

Combien le département du Nord comporte-t-il de communes ?
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sélectionnées.
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VI.3 Combiner des requêtes

Combiner deux requêtes attributaires
Combiner deux requêtes spatiales
Combiner requêtes spatiales et attributaires

Comment faire quand on souhaite combiner plusieurs requêtes, par exemple sélectionner les
communes traversées par un cours d'eau et ayant une population de + de 10 000 habitants ?

Combiner deux requêtes attributaires

Pour combiner deux requêtes attributaire (par exemple les communes de + de 10 000 habitants
du département du Pas-de-Calais), nous avons vu dans la partie VI.1.4 qu'il est possible d'utiliser
les opérateurs AND et OR.

Il est également possible de faire deux requêtes successives.

Ouvrez un nouveau projet QGIS, ajoutez-y la couche communes_NordPasDeCalais.

Ouvrez la table attributaire de cette couche puis la fenêtre de requête attributaire.

Sélectionnez tout d'abord les communes de + de 10 000 habitants :

"POPULATION" > 10

Tapez ensuite la requête suivante, pour sélectionner les communes du Pas-de-Calais...

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 143/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/6_3_sup10000hab.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


"NOM_DEPT" = 'PAS-DE-CALAIS'

...Mais cette fois-ci, au lieu de cliquer sur Sélection, sélectionnez dans la liste Sélectionner
depuis la sélection :

Ainsi, cette deuxième requête s'appliquera uniquement aux communes déjà sélectionnées : les
communes du Pas-de-Calais seront sélectionnées parmi les communes de + de 10 000
habitants.

Combiner deux requêtes spatiales

Comment faire maintenant pour combiner deux requêtes spatiales, par exemple pour
sélectionner les communes avec éolienne et cours d'eau ?

Utilisez cette fois pour la deuxième requête le bouton Enlever de la sélection  : les communes du
Pas-de-Calais seront désélectionnées et il ne restera de sélectionnées que les communes de + de 10
000 habitants du Nord.

Pouvez-vous au moyen des mêmes 2 requêtes ("POPULATION" > 10 et "NOM_DEPT" =
'PAS-DE-CALAIS') sélectionner les communes de + de 10 000 habitants du département du
Nord ?
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Connectez-vous au dux WFS http://ws.carmen.developpement-
durable.gouv.fr/WFS/24/eolien et ajoutez la couche eoliennes.

Connectez-vous au dux WFS http://services.sandre.eaufrance.fr/geo/zonage et ajoutez la
couche COURDO1 correspondant aux cours d'eau de + de 100 km.

Menu Vecteur → Requête spatiale → Requête spatiale  : sélectionnez les 
.

Une fois cette requête eGectuée, la case selected geometries (117 dans notre cas) est
automatiquement cochée. En laissant cette case cochée, la requête suivante ne portera que
sur les communes avec éoliennes. Il ne vous reste donc plus qu'à sélectionner les communes
avec cours d'eau :

communes avec
éolienne(s) 
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Au final, les 28 communes sélectionnées sont donc celles avec éolienne et cours d'eau :

Combiner requêtes spatiales et attributaires

Le principe est le même que précédemment. Sélectionnons par exemple les communes de moins
de 100 habitants avec éolienne.
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Commencez par sélectionner au moyen d'une requête attributaire les communes de moins de
100 habitants : "POPULATION" < 0.1. Onze communes sont sélectionnées.

Ensuite, au moyen d'une requête spatiale, sélectionnez parmi ces communes celles avec
éoliennes :

Au final, une seule commune reste sélectionnée : Canteleux dans le Pas-de-Calais.

Il est aussi possible de procéder à l'inverse : sélectionner d'abord les communes avec éoliennes
puis parmi celles-ci celles de moins de 100 habitants.

Désélectionnez toutes les communes.

Au moyen d'une requête spatiale, sélectionnez toutes les communes avec éolienne : 117
communes sont sélectionnées.

Il ne reste plus ensuite qu'à sélectionner en utilisant l'option Depuis la sélection  les
communes de moins de 100 habitants : la commune de Canteleux reste la seule sélectionnée.

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 147/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/6_3_communes_inf100hab_eolienne.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


VII. Créer, supprimer, renommer et calculer des champs

Dans les parties V.1 et V.3, nous avons vu comment choisir les champs qui seront ajoutés à une
couche lors de sa création, et comment remplir des champs case par case.

Nous allons voir ici comment ajouter, supprimer et renommer et changer l'ordre des champs
pour une couche existante, et comment calculer automatiquement des valeurs dans un
champ.

Notions abordées :

Création de champs
Suppression de champs
Renommer des champs
Modifier l'ordre des champs
Calcul des valeurs d'un champ

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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VII.1 Création et suppression de champs à partir de la
table attributaire

Quels sont les champs présents dans une table ?
Créer un nouveau champ
Supprimer un champ existant

Quels sont les champs présents dans une table ?

Ouvrez un nouveau projet QGIS, ajoutez la couche communes_NordPasDeCalais_calcul.

Pour voir les champs de la table attributaire de cette couche, vous pouvez bien sûr ouvrir la
table attributaire, mais vous pouvez également ouvrir les propriétés de la couche, rubrique
Champs :

Cette fenêtre vous permet de voir d'un seul coup d'œil la liste des champs, leur type : String
(texte), Int (nombre entier) ou Real (nombre décimal), le mode d'édition (cf. partie V.3.2) ...

Créer un nouveau champ

Nous allons ajouter deux champs à la couche communes_NordPasDeCalais_calcul, CODE_DEPT
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et CODE_REG, destinés à contenir par la suite le code de département et le code de région.

Ouvrez la table attributaire de la couche communes_NordPasDeCalais_calcul. Passez en
mode édition pour cette couche (cf. partie V.2.1).

Cliquez sur l'icône Nouvelle colonne en haut de la table attributaire :

La fenêtre suivante s'ouvre :

Nom : Tapez CODE_DEPT

Commentaire : ce champ peut contenir un commentaire, laissez-le vide

Type : ce champ peut contenir les valeurs suivantes : texte, nombre entier, nombre
décimal et date. Choisissez texte (on pourrait aussi choisir le type nombre entier, mais
texte est souvent préférable pour les identifiants)

Largeur : Dans le cas d'un champ type texte, cette valeur représente le nombre
maximum de caractères que pourra contenir le champ. Tapez 3, pour prévoir le cas des
départements d'outre-mer.

Cliquez sur OK ; le champ est ajouté à la table, rempli pour l'instant de valeurs nulles.

Procédez de la même manière pour ajouter un champ CODE_REG :
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Quittez le mode édition en enregistrant les modiDcations. Ces champs seront remplis dans la
partie VII.3.

Supprimer un champ existant

Nous allons supprimer le champ INSEE_COM (ne vous inquiétez pas, nous recréerons un champ
code INSEE à partir du code de département et de commune, dans la partie VII.3).

Passez à nouveau en mode édition pour la couche communes_NordPasDeCalais_calcul.

Cliquez sur l'icône Supprimer la colonne  en haut de la table attributaire :

La fenêtre suivante apparaît :

Sélectionnez le champ INSEE_COM puis cliquez sur OK.

Notez qu'il est possible de sélectionner plusieurs champs dans cette fenêtre.

Le champ est supprimé. Quittez le mode édition en enregistrant les modifications.
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VII.2 Une extension pratique : le gestionnaire de table

Installation de l'extension du gestionnaire de table
Gérer les champs avec le gestionnaire de table

Installation de l'extension du gestionnaire de table

L'extension Gestionnaire de table (Table Manager) permet de créer et supprimer des champs,
ainsi que de renommer et changer l'ordre des champs, ce qui n'est pas possible directement dans
la table attributaire.

Comment installer cette extension ?

Rendez-vous dans le :

Vérifiez que vous êtes dans la rubrique Tout
Tapez table dans la partie Rechercher
Cliquez sur Table Manager dans la liste des extensions
Puis sur Installer l'extension en bas à droite de la fenêtre

Table Manager est maintenant visible dans la liste des extensions installées. Fermez la fenêtre.

Menu Extensions → Installer/Gérer les extensions 
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Gérer les champs avec le gestionnaire de table

Sélectionnez la couche communes_NordPasDeCalais_calcul dans la table des matières.

Lancez le gestionnaire de table : soit via l'icône de la barre d'outils Vecteur, soit via le
.

Le gestionnaire de table permet la création de nouveaux champs via le bouton Insérer. Une fois
un champ sélectionné dans la liste, il est possible de le supprimer, renommer ou de changer sa
position par rapport aux autres champs.

A tout moment, l'onglet Aperçu de la table  permet de prévisualiser la table une fois vos
changements effectués.

Pour sauvegarder vos modiDcations, deux possibilités : le bouton Enregistrer sauvegarde
directement les modifications, le bouton Enregistrer sous... crée une nouvelle couche.

Nous allons simplement modiDer l'ordre des champs pour remonter CODE_DEPT et
CODE_REG : sélectionnez CODE_REG et cliquez sur Vers le haut  jusqu'à ce que le champ soit
en deuxième position, derrière ID_GEOFLA. Faites également remonter CODE_DEPT en
troisième position.

Cliquez sur Enregistrer : une fenêtre apparaît vous demandant si vous souhaitez conserver ou
non le style de la couche. Choisissez Oui ou Non, au choix (Oui conservera le style actuel de la

menu Vecteur → Table Manager → Gestionnaire de table 
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couche, Non générera un nouveau style au hasard).
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VII.3 Calcul de champs

Comment fonctionne la calculatrice de champ ?
Calcul de géométrie : l'exemple de la surface

Calcul de la surface
Vérification

Quelques exemples supplémentaires de calculs
Opérations mathématiques : calcul de densité
Opérations sur du texte : extraction des codes et noms de régions et départements
Opérations sur du texte : concaténation

Il est possible de calculer automatiquement les valeurs d'un champ au moyen de la calculatrice de
champ, un peu à la manière d'une requête attributaire.

Comment fonctionne la calculatrice de champ ?

Toujours dans le même projet QGIS, avec uniquement la couche
communes_NordPasDeCalais_calcul, ouvrez sa table attributaire.

Passez en mode édition. Cliquez sur l'icône Ouvrir la calculatrice de champs parmi les icônes
de la table attributaire :

La fenêtre suivante s'ouvre :
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1 : si cette case est cochée, seules les lignes sélectionnées seront modifiées.

2 : cocher cette case pour créer un nouveau champ.

3 : cocher cette case pour mettre à jour un champ existant.

4 : Liste des opérateurs et fonctions disponibles pour le calcul de champ.

5 : Si un opérateur ou une fonction est choisi en 4, l'aide correspondante apparaît dans cette
partie.

6 : Liste des opérateurs les plus couramment utilisés.

7 : Expression servant à calculer les valeurs du champ.

8 : Ici, une fois l'expression remplie, vous pourrez voir un aperçu du résultat du calcul.
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Comme vous avez pu le constater, le mode de fonctionnement de la calculatrice de champ est
assez similaire à celui d'une requête attributaire (cf. partie VI.1).

Calcul de géométrie : l'exemple de la surface

Calcul de la surface

Nous allons ici calculer la surface de chaque département en km 2.

Choisissez Créer un nouveau champ, nommez le SURF_KM2, choisissez le type décimal,
une longueur de 10 et une précision de 2 (2 chiffres après la virgule)

Dans la liste des fonctions, dans la rubrique géométrie, double-cliquez sur la fonction
$area puis rajoutez dans la case expression / 1000000 (par défaut, la surface est
calculée en unités de la couche, donc en m² puisque cette couche est projetée en
Lambert 93)
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Au final, l'expression est donc $area / 1000000

cliquez sur OK

Vérification

Vous pouvez vérifier votre calcul au moyen de l'outil Mesurer une aire  :

Sélectionnez une commune, mesurez son aire en faisant un clic droit sur le dernier sommet
pour terminer, choisissez dans la table l'option Ne montrer que les entités sélectionnées  et
comparer l'aire que vous avez mesuré et l'aire du champ SURF_KM2.

Les deux aires devraient être sensiblement égales.

Quelques exemples supplémentaires de calculs

La calculatrice de champs oGre beaucoup de fonctions que nous ne passerons pas toutes en
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revue ; nous verrons simplement quelques exemples pour vous donner un aperçu des possibilités.

Opérations mathématiques : calcul de densité

L'objectif sera ici de calculer la densité en habitants par km 2 de chaque commune, à partir de la
population et la surface.

Si ce n'est pas déjà fait, ouvrez la table attributaire de la couche
communes_NordPasDeCalais_calcul et passez en mode édition. Ouvrez la calculatrice de
champs :

Choisissez l'option Créer un nouveau champ, nommez-le DENSITE, type Nombre
décimal, Longueur 10 et précision 2

La densité se calcule en divisant la population par la surface. Si la population est en nombre
d'habitants et la surface en km2, alors la densité sera en nombre d'habitants par km 2.

Savez-vous comment calculer la densité à partir de la population et la surface ?
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Dans la liste des fonctions , rubrique Champs et valeurs, double-cliquez sur
POPULATION, ajoutez * 1000 à la main dans le cadre Expression puisque la population
est en milliers d'habitants, le diviseur / puis double-cliquez sur le champ SURF_KM2

Au final, l'expression est "POPULATION" * 1000 / "SURF_KM2"

Cliquez sur OK : le champ densité est ajouté et calculé :

Opérations sur du texte : extraction des codes et noms de régions et départements

La couche communes_NordPasDeCalais_calcul comporte deux champs DEPT et REGION remplis
par exemple par 59 - NORD  pour le département et 31 - NORD-PAS-DE-CALAIS  pour la région.

Le but est ici d'extraire le code de la région et du département à partir de ces deux champs. Nous
avons déjà créé les champs CODE_DEPT et CODE_REG précédemment, il ne reste plus qu'à les
remplir !

Si ce n'est pas déjà fait, ouvrez la table attributaire de la couche
communes_NordPasDeCalais_calcul et passez en mode édition. Ouvrez la calculatrice de
champs :
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Choisissez Champ de mise à jour existant puis CODE_DEPT dans la liste déroulante,
puisqu'il ne s'agit pas de créer un nouveau champ

Dans la liste des fonctions , allez dans la rubrique Chaîne (texte) et cliquez sur la
fonction left : vous pouvez lire l'aide à droite. Cette fonction extrait les caractères les plus
à gauche d'un texte.

La fonction left nécessite deux paramètres : le texte d'où seront extraits les caractères
(ici, le champ DEPT) et le nombre de caractères à extraire (ici, 2 puisque le code de
département est codé sur 2 caractères)

L'expression est donc left( "DEPT", 2)

Cliquez sur OK : le champ CODE_DEPT est mis à jour :
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Comment faire pour maintenant extraire le nom du département du champ DEPT ?

La fonction right permet d'extraire les caractères les plus à droite d'un texte. Le problème est que
le nom du département étant variable, le nombre de caractères à extraire l'est aussi.

Mais il est possible de calculer ce nombre de caractères à extraire en fonction de la longueur
totale du texte : en eGet, ce nombre sera toujours égal à la longueur totale - 5 . Cinq correspond
au nombre de caractères qui ne font pas partie du nom de département (« 59 - » par exemple).

L'expression est donc :

right ( "DEPT" , length ( "DEPT") - 5 )

length ( "DEPT") - 5  étant le nombre de caractères à extraire du champ DEPT.

Au final, les paramètres de la calculatrice de champs sont donc les suivants :
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Opérations sur du texte : concaténation

Le but sera ici de recréer le code INSEE des communes, à partir du code de département et du
code de commune. Par exemple, la commune de Winnezeele a pour code département 59 et pour
code commune 662 : son code INSEE est 59662.

VériDez que la couche de communes du Nord-Pas-de-Calais soir bien en mode édition, ouvrez
la calculatrice de champ :

Pour le code région, il faut mettre à jour le champ CODE_REG avec l'expression left( "REGION", 2) .
Pour le nom de région, il faut créer un nouveau champ NOM_REG et le remplir en utilisant
l'expression right ( "REGION" , length ( "REGION") - 5 ) .

Bien sûr, vous pouvez faire plus simple et utiliser les expressions '31' pour le code, et 'NORD-PAS-
DE-CALAIS' pour la région, puisque toutes les communes appartiennent ici à la même région !

Pouvez-vous de la même manière extraire les codes et noms de région ? Y a-t-il plusieurs
manières de procéder ?
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Créez un nouveau champ, nommé CODE_INSEE, de type Texte et de longueur 10

Dans la liste des champs, double-cliquez sur CODE_DEPT (créé précédemment), puis
cliquez sur l'opérateur de concaténation de chaîne ||, et double-cliquez pour terminer
sur le champ CODE_COMM

L'aperçu du réultat doit être par exemple 59662

Cliquez sur OK. Le champ CODE_INSEE est créé et mis à jour :
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Il est aussi possible d'utiliser la formule concat ( "CODE_DEPT", "CODE_COMM" ), pour le même résultat.
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VIII. Lier des données de deux sources diRérentes : les
jointures

Nous allons aborder ici la notion de jointure : comment partir de deux couches de données, ou
d'une couche et d'un tableau, pour au Dnal n'obtenir qu'une seule couche avec toutes les données
qui nous intéressent ?

Notions abordées :

Jointure attributaire
Jointure spatiale

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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VIII.1 Lier des données en fonction de leurs attributs :
jointures attributaires

Comment fonctionne une jointure attributaire ?
Application : population au Bhoutan
Quelques exemples supplémentaires

Jointure d'une couche et d'une table : recensement de la population au Kenya
Jointure de deux couches : entrées de cinéma et célibat en France

Comment fonctionne une jointure attributaire ?

Dans un logiciel SIG, une jointure attributaire consiste à lier à une couche des données provenant
d'une table ou d'une autre couche. On se base pour cela sur les données attributaires.

Un champ de la couche de départ et un champ de la table contenant les données à joindre servent
de champs clé. Ces champs doivent être de même type (texte, nombre) et contenir les mêmes
données. Le logiciel se base sur le contenu de ces champs pour déterminer quel élément de la
table est lié à quel élément de la couche.
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Dans l'illustration ci-dessus, les données de départ sont :

une couche de polygone avec les régions du bhoutan. La table attributaire comporte le nom
et le code de chaque région, mais pas leur population.

un tableau avec le code de chaque région et sa population en 1995

Les données de la table sont jointes aux données du shapeDle, en se basant sur le code région :
champ CODEREGION pour le shapefile et champ REG_CODE pour le tableau.

Au final, on obtient une couche shapefile des régions du Bhoutan, avec en données attributaires
les données de la couche de départ et les données du tableau, donc la population.

Il arrive qu'un élément de la couche de départ corresponde à plusieurs éléments de la table.
DiGérentes stratégies sont alors possibles selon les logiciels et le type de champ : ne prendre en
compte que les données du premier élément lié, calculer la moyenne des données...

Application : population au Bhoutan

Ouvrez un nouveau projet QGIS et ajoutez-y la couche des régions du Bhoutan [↗]
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regions_bhutan.shp.

Ajoutez également au projet la table pop_bhutan.csv : pour cela, procédez comme pour
ajouter une couche shapefile mais choisissez Tous les fichiers comme format de fichier :

L e format CSV [↗] est un format texte contenant des colonnes séparées par un caractère délimiteur,
habituellement la virgule, le point-virgule ou la tabulation.

Vous devez donc avoir dans QGIS ces deux données (notez l'icône de tableau pour le CSV) :

Ouvrez les deux tables attributaires.

Allez dans les propriétés de la couche regions_bhutan, rubrique Jointure :

Le champ clé pour regions_bhutan est CODEREGION et le champ clé pour pop_bhutan est
REG_CODE.

A votre avis, pour pouvoir eGectuer une jointure entre les 2 tables, quels seront les 2
champs clés ?

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 170/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/8_1_ajout_csv.png
http://fr.wikipedia.org/wiki/Comma-separated_values
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


Cliquez sur le symbole  pour ajouter une jointure :

Choisissez les données à joindre : pop_bhutan et les champs clés. Cliquez sur OK pour créer la
jointure : la ligne correspondante apparaît dans la fenêtre des propriétés.

Ouvrez la table attributaire de la couche regions_bhutan.shp : les données de la table ont été
ajoutées (champ pop_bhutan_POPEST95).
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Cependant, la couche n'a pas été modiDée, la jointure n'est que temporaire. Pour sauvegarder
définitivement la jointure, il faut sauvegarder la couche sous un autre nom.

Notez également que les champs joints devront être renommés, car ils prennent par défaut le
nom de leur table d'origine suivi du caractère « _ » et du nom du champ.

Quelques exemples supplémentaires

Jointure d'une couche et d'une table : recensement de la population au Kenya

Ouvrez un nouveau projet QGIS. Ajoutez-y la couche KEN_adm2.shp et le Dchier CSV
County_Urbanization-2009.

Faites la jointure.

Pour que tous les enregistrements soit joints, vous pouvez modiDer à la main les noms des
districts qui posent problème dans le Dchier CSV, en l'ouvrant avec un éditeur de texte, et
refaire la jointure.

Jointure de deux couches : entrées de cinéma et célibat en France

Ouvrez un nouveau projet QGIS. Ajoutez-y les couches depts_celib15ansplus_2009 et
depts_entrees_cinema_2011.

Il est possible de faire la jointure en utilisant le nom du district : champ NAME_2 pour KEN_adm2
et champ County pour County_Urbanization-2009.csv.

Le champ étant un nom et non un code, il est possible que des lignes ne soient pas jointes si les
noms sont orthographiées de manière légèrement différente.

Ouvrez les deux tables attributaires. A votre avis, sur quels champs faire la jointure ? Quels
problèmes cela pourrait-il poser ?

Quatre districts n'ont pas de données jointes : Trans-Nzoia, orthographié "Trans Nzoia" dans le
Jchier CSV, Elgeyo-Marakwet, orthographié "Elgeyo Marakwet" dans le Jchier CSV, Nithi,
orthographié "Tharaka Nithi" dans le Jchier CSV et Kwale, orthographié "Kwale " (avec un espace à
la fin) dans le fichier CSV.

Combien de lignes n'ont pas été jointes ? Pourquoi ?

Il est possible de faire la jointure sur les champs ID_GEOGLA, ou CODE_DEPT, ou bien NOM_DEPT.
Evitez le champ NOM_DEPT, au cas où les noms de départements soient orthographiés de manière

Ouvrez les deux tables attributaires. A votre avis, sur quels champs faire la jointure ? Quels
problèmes cela pourrait-il poser ?
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Joignez les données attributaires d'une couche à l'autre couche.

différente dans les deux couches (accents, majuscules).
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VIII.2 Lier des données en fonction de leur position :
jointures spatiales

Comment fonctionne une jointure spatiale ?
Application : départements et chef-lieux
Quelques exemples supplémentaires

Écoles secondaires du Kenya
Jointure de deux couches de polygones : un comportement étonnant

Comment fonctionne une jointure spatiale ?

Pour faire une jointure, il est possible de se baser sur la position des éléments et non plus sur
leurs données attributaires : il s'agit alors d'une jointure spatiale.

Ce type de jointure ne peut se faire qu'entre deux couches SIG, de type point, ligne ou polygone. Il
est possible par exemple de partir d'une couche de polygones et d'une couche point, et de lier à
chaque polygone les données attributaires du point contenu par ce polygone.

Notez bien que comme pour une jointure attributaire, les données qui seront jointes sont toujours
les données attributaires.
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Dans l'exemple ci-dessus, les deux couches de départ sont une couche de département et une
couche de chef-lieux. Les données attributaires des chef-lieux (leur nom, code et coordonnées)
sont jointes aux départements en se basant sur leur position : chaque département récupère les
données du chef-lieu intersectant ce département.

Notez que QGIS ne propose pas le choix de l'opérateur spatial : ce sera toujours une intersection.

Application : départements et chef-lieux
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Le but va être ici, comme dans l'illustration ci-dessus, de joindre les données attributaires des
chef-lieux aux départements.

Ouvrez un nouveau projet QGIS, ajoutez les deux couches depts_france et cheflieux_france.

Rendez-vous dans le menu 
:

Indiquez une couche vecteur :  choisissez la couche à laquelle joindre les données; ici,
les départements.

Joindre la couche vecteur :  choisissez la couche avec les données à joindre ; ici, les chef-
lieux.

Résumé de l'attribut :  cette rubrique permet de choisir comment faire au cas où
plusieurs entités sont concernées par la jointure. Comme il n'y a qu'un seul chef-lieu par
département, choisir l'une ou l'autre option aura dans notre cas le même résultat.

Fichier de sortie :  cliquez sur Parcourir pour sélectionner l'emplacement et le nom
(depts_join_cheflieux par exemple) de la couche qui sera créée

Table en sortie :  cette option est importante dans le cas où des entités de la couche de
départ n'ont pas de correspondance dans la couche à joindre. Dans notre cas, chaque
département ayant un chef-lieux, les deux options sont équivalentes.

Cliquez sur OK, patientez... Un message apparaît vous demandant si vous souhaitez ajouter la

Vecteur → Outils de gestion de données → Joindre les attributs par
localisation 
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nouvelle couche au projet, acceptez.

Ouvrez la table attributaire de la nouvelle couche. Pour chaque département, il est maintenant
renseigné le nom et le code du chef-lieu, ainsi que ses coordonnées.

Notez qu'au contraire des jointures attributaires, la jointure spatiale crée directement une nouvelle couche, les
données ne sont pas jointes de manière temporaire.

Quelques exemples supplémentaires

Écoles secondaires du Kenya

Le but sera ici, à partir d'une couche du district de Nakuru et d'unecouche de points représentant
les écoles secondaires de ce district, de déterminer combien d'école compte chaque zone du
district.

Dans un nouveau projet QGIS, ajoutez les couches KEN_adm4_Nakuru et
kenya_ecoles_nakuru.

Choisissez les paramètres de la jointure spatiale pour prendre un résumé des entités
intersectées :
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Le nombre d'écoles dans la zone sera automatiquement calculé à partir du moment où vous
cochez la case Prendre un résumé des entités intersectées . L'outil oblige également à
cocher au moins une case : choisissez la somme, ainsi, pour chaque zone, la somme de tous les
champs de type nombre de toutes les écoles de la zone sera calculée.

Cochez également la case Conserver tous les enregistrements : ainsi, même si une zone ne
comporte aucune école, elle ne sera pas supprimée de la couche résultat.

Lancez la jointure, ajoutez la nouvelle couche.

En lisant les informations par exemple de la zone de Bahati, on peut lire que cette zone
comporte 22 écoles :

Jointure de deux couches de polygones : un comportement étonnant

Ouvrez un nouveau projet QGIS, ajoutez les couches regions_france_geofla et depts_france.

Que se passe-t-il si l'on essaye de trouver par une jointure spatiale le nombre de départements
de chaque région ?

Testez-le, avec les mêmes paramètres que pour les écoles secondaires du Kenya : vous devriez
obtenir les nombres de départements suivants par région :
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A part pour la Corse, ces nombres sont erronés; en eGet, il semble que la jointure ait pris en
compte pour une région non seulement les départements à l'intérieur de la région mais
également les départements adjacents.

Comment cela se fait-il ? Nous avons vu que l'opérateur utilisé pour la jointure spatiale est
l'intersection. Si on sélectionne une région au hasard, puis qu'on eGectue une requête spatiale via
le menu Vecteur → Requête spatiale → Requête spatiale , le résultat est correct : seuls les
départements de la région sélectionnée sont sélectionnés.

Par contre, si l'on eGectue cette même requête spatiale via le menu Vecteur → Outils de
recherche → Sélection par localisation, les départements adjacents sont également
sélectionnés.

On peut donc en déduire que le module de jointure spatiale fonctionne de la même manière que
le module de sélection par localisation. Historiquement, le module de sélection par localisation est
apparu le premier, le module de requête spatiale, plus perfectionné, venant ensuite. De la même
manière, peut-être le comportement de la jointure spatiale sera-t-il amené à évoluer dans les
futures versions de QGIS.
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IX. Analyse spatiale

Dans cette partie, nous allons aborder un domaine particulièrement utile des SIG : comment
croiser spatialement des données, ou créer des données à partir d'autres données.

Nous verrons quelques exemples de traitements possibles sur des données vecteur et raster (pour
un rappel de ce qu'est une donnée vecteur ou raster : cf. partie I.1.2b).

Notions abordées :

découpage d'une couche vecteur
intersection de deux couches
création de zones tampon
découpage d'une couche raster
création de courbes de niveau à partir d'un MNE
calcul de pente à partir d'un MNE
Calcul de la valeur d'un point en fonction d'un raster

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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IX.1 Analyse spatiale : quelques exemples d'opérations sur
des données vecteur

Découper des données par d'autres données
Premier essai...
...Et correction du problème

Création d'une zone tampon autour d'un cours d'eau
Qu'est-ce qu'une zone tampon ?
Sélection d'un cours d'eau
Création d'une zone tampon autour de la sélection

Données communes entre deux couches : intersection
Qu'est-ce qu'une intersection ?
Intersection entre communes et zone tampon

Nous aborderons ici quelques traitements possibles sur des données vecteur. Il en existe bien sûr
beaucoup d'autres !

Découper des données par d'autres données

Le but sera ici de découper des cours d'eau pour ne garder que ceux dans notre zone d'étude, en
l'occurrence les départements de Côtes d'Armor et d’Île-et-Vilaine.

Premier essai...

Ouvrez un nouveau projet QGIS. Ajoutez les couches COURS_D_EAU_NTFL2 et
communes_22_35_osm.

Le but sera donc de découper les cours d'eau par les communes, pour ne garder que les
parties à l'intérieur des communes. Cette opération crée une nouvelle couche.

Rendez-vous dans le :Menu Vecteur → Outils de géotraitement → Découper 
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Couche vectorielle de saisie : choisir la couche à découper, en l'occurrence les cours
d'eau

Couche de découpage : choisir la couche servant de masque de découpe, en
l'occurrence les communes

Fichier de sortie :  cliquez sur Parcourir, choisissez l'endroit où la couche sera créée, et
son nom : COURS_D_EAU_dep22_35

La case Ajouter le résultat au canevas de la carte  est présente depuis la version 2.2 de
QGIS. Cochez-la si possible.

Cliquez sur OK

Les cases Utiliser uniquement les valeurs sélectionnées permettent, comme leur nom l'indique, de ne
prendre en compte que certaines entités, que ce soit pour la couche à découper ou le masque de découpe.

Ajoutez la nouvelle couche si ce n'est pas fait automatiquement.

Que se passe-t-il ? La nouvelle couche ne semble contenir aucune entité, ce que vous pouvez
vérifier en ouvrant la table attributaire. Supprimez cette couche.

...Et correction du problème

Comme vous vous rappelez, nous avons vu dans la partie II.4.2 que certaines opérations
nécessitent que toutes les couches soient dans le même SCR. Est-ce bien le cas ici ?

Passez la couche de cours d'eau en RGF93 Lambert 93 (EPSG 2154) , puisqu'il s'agit du système
o@ciel français, le NTF Lambert 2 étant obsolète : nommez la nouvelle couche

La couche COURS_D_EAU_NTFL2 est en système NTF, projection Lambert 2 (EPSG 27572), et la
couche communes_22_35_osm en système RGF93, projection Lambert 93 (EPSG 2154).

Dans quel SCR sont vos deux couches ?
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COURS_D_EAU_RGF93L93. Référez-vous si besoin à la partie II.4.2.

Supprimez la couche COURS_D_EAU_NTFL2. Vous avez donc dans votre projet deux couches,
une de cours d'eau et une de communes, toutes deux dans le même SCR : RGF93 Lambert 93.

Procédez à nouveau au découpage, avec comme couche de saisie COURS_D_EAU_RGF93L93 et
comme couche de découpage communes_22_35_osm.

Nommez la nouvelle couche COURS_D_EAU_dep22_35 et sauvegardez-là au même endroit que
précédemment, afin de remplacer la couche avec 0 entités.

Patientez... et ajoutez la nouvelle couche :

Cours d'eau découpés en bleu, cours d'eau non découpés en rouge.

Contrairement à une requête spatiale, le découpage modiDe les entités en les découpant
suivant les limites de la couche de découpage. Une requête se borne à sélectionner par
exemple les cours d'eau à l'intérieur des communes, ou intersectant les communes.
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Sélection des cours d'eau intersectant les communes (en jaune) par une requête
spatiale.

Création d'une zone tampon autour d'un cours d'eau

Qu'est-ce qu'une zone tampon ?

Une zone tampon (aussi appelée « buGer ») est une zone épousant la forme des objets d'une
couche, d'une largeur donnée. Si elles sont tracées autour de points, les zones tampons seront
des cercles. Autour de lignes et de polygones, ce sera des polygones de forme variable. Une zone
tampon peut servir par exemple à modéliser une zone inondable, un périmètre de sécurité, une
zone d'achalandage...
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L'objectif est ici de créer une zone tampon d'1 km autour du cours d'eau du Trieux. Cette zone
pourra représenter par exemple une zone inondable, ou bien une zone s'interposant entre rivière
et cultures.

Sélection d'un cours d'eau

Vous pouvez soit cliquer sur le numéro de la ligne où le toponyme est « le Trieux » (pour la trouver
plus facilement, cliquez sur l'intitulé de colonne Toponyme pour classer les lignes par toponyme),
soit utiliser une requête attributaire  : "Toponyme" = 'le Trieux'.

Comment faire pour sélectionner le cours d'eau dont le toponyme est « le Trieux » ?
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Le cours d'eau du Trieux sélectionné

Création d'une zone tampon autour de la sélection

Pour créer la zone tampon : :menu Vecteur → Outils de géotraitement  → Tampon(s) 
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Couche vectorielle de saisie : il s'agit de la couche autour de laquelle sera créée la ou
les zones tampons, donc ici la couche de cours d'eau COURS_D_EAU_dep22_35

Utiliser uniquement les valeurs sélectionnées : vériDer que
cette case soit bien cochée (elle l'est par défaut à partir du
moment où une sélection existe dans la couche), aDn de ne
créer de zone tampon qu'autour du Trieux

Segments pour l'approximation :  plus cette valeur est
élevée, plus les contours de la zone seront « arrondis ». Une
valeur de 10 sera suffisante dans notre cas

Distance tampon :  la couche étant projetée en Lambert 93,
son unité est le mètre. Taper donc 1000 pour obtenir une
zone d'une largeur de 1km. L'option Champ de distance
tampon permet quant à elle de faire varier la largeur de la
zone en fonction des valeurs d'un champ ; nous ne
l'utiliserons pas ici

Union des résultats du tampon :  cette case permet de
fusionner toutes les zones tampon qui seront créées. Dans la
mesure où une seule zone sera créée ici, la cocher ou
décocher ne changera rien au résultat

Fichier de sortie :  cliquez sur Parcourir, choisir le nom :
Trieux_Tampon1km_RGF93L93 par exemple) et l'emplacement de la couche qui sera
créée

Cliquez sur OK, ajoutez la nouvelle couche : vous devez obtenir un résultat similaire à celui de
l'illustration ci-dessus.
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Données communes entre deux couches : intersection

Qu'est-ce qu'une intersection ?

L'intersection entre deux couches crée une troisième couche, avec uniquement les parties
communes aux deux couches.

La zone hachurée correspond à l'intersection entre le rectangle et le
cercle.

Intersection entre communes et zone tampon

Rendez-vous dans le :menu Vecteur → Outils de géotraitement  → Intersection 

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 189/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/9_1_inters_principe.svg
illustrations/tous/9_1_inters_fenetre.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


Couche vectorielle de saisie : choisir la couche de communes. Ne pas cocher la case «
Utiliser uniquement les entités sélectionnées » puisqu'il s'agit
d'intersecter toutes les communes

Couche d'intersection : choisir la couche contenant la zone tampon.
Idem, ne pas cocher la case « Utiliser uniquement les entités
sélectionnées »

Fichier de sortie :  cliquez sur Parcourir, choisir le nom
(intersection_communes_tampon par exemple) et l'emplacement de
la couche qui sera créée

Cliquez sur OK, ajoutez la couche.

Vous devez obtenir une couche similaire à celle de l'illustration.

Ouvrez la table attributaire de cette couche : notez que les champs des deux
couches sont présents.
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IX.2 Analyse spatiale : quelques exemples d'opérations sur
des données raster

Découpage d'un raster
Création de courbes de niveaux
Création d'une couche de pente à partir de l'altitude

Projection d'un raster
Calcul de pente à partir du raster projeté

Vous verrez ici quelques manipulations sur un raster d'altitude, appliquées au modèle d'élévation
numérique (MNE) de la Jamaïque (pour savoir ce qu'est un MNE : cf. partie III.1.2).

Découpage d'un raster

Le but sera ici de découper un raster pour ne garder que la zone qui nous intéresse. Cette
manipulation permet d'alléger les données et les futurs traitements.

Ouvrez un nouveau projet QGIS. Ajoutez la couche raster  srtm_21_09.tif située dans
TutoQGIS_09_AnalyseSpat/donnees.

Le but va être de ne garder que la partie du MNE correspondant à la Jamaïque, en éliminant les
parties de Cuba et des îles Caïman.

Rendez-vous dans le :Menu Raster → Extraction → Découper 
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Fichier source : sélectionnez srtm_21_09

Fichier en sortie : cliquez sur Sélection..., choisissez où la nouvelle couche sera créée,
et son nom : srtm_jamaique

Valeur nulle : laissez la case décochée

Mode de découpage :  choisissez Emprise

Vérifiez que la case Charger dans la carte une fois terminé  soit bien cochée

Il faut ensuite dessiner l'emprise à garder, toujours dans l'outil de découpage. Dessinez
un rectangle autour de l'île de la Jamaïque :

Cliquez ensuite sur OK.

Une fois l'opération terminée, fermez la fenêtre de l'outil de découpage. Le nouveau raster ne
comprend que la Jamaïque.
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Notez qu'il est également possible de découper un raster suivant une couche de polygones, en
utilisant l'option couche de masquage . Vous pouvez aussi directement rentrer à la main les
coordonnées de l'emprise à conserver.

Création de courbes de niveaux

Les courbes de niveaux sont des lignes imaginaires joignant tous les points situés à la même
altitude. Nous allons créer des courbes de niveau distantes de 100 mètres à partir du MNE de la
Jamaïque.

Rendez-vous dans le :

Fichier source : sélectionnez srtm_jamaique

Fichier de sortie pour les contours :  cliquez sur Sélection..., sélectionnez
l'emplacement de la couche qui sera créée, tapez son nom : jamaique_courbes_100m
par exemple

Intervalle entre les lignes de contour :  tapez 100

Nom d'attribut :  il s'agit du nom du champ qui contiendra l'altitude de la courbe.
Cochez la case, et laissez la valeur ELEVATION par exemple

Pour finir, cochez la case Charger dans la carte une fois terminé , et cliquez sur OK.

Menu Raster → Extraction → Création de contours 
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Une couche de lignes a été créée. Chaque ligne possède en attribut son élévation, qui varie ici de
100 à 2200 mètres.

Création d'une couche de pente à partir de l'altitude

Il est également possible de créer à partir d'un raster d'altitude un raster de pente : chaque pixel
aura la valeur de la pente en ce point. Pour en savoir plus sur la manière dont est calculée la
pente, vous pouvez vous référer à l'aide d'ArcGIS [↗] sur ce point.

La pente est calculée en fonction de la distance horizontale et de la
hauteur. Dans notre cas, la hauteur est en mètres, et la distance
horizontale en degrés. Les deux unités étant diGérentes, le calcul de
pente donnera des valeurs aberrantes.

La première étape est donc de projeter notre raster, pour obtenir des
unités identiques verticalement et horizontalement.

Projection d'un raster

Quelle projection utiliser pour notre raster ?

En règle générale, il y a deux possibilités quand on cherche une projection pour un pays : utiliser
une projection nationale, ou bien une projection UTM.

Pour savoir s'il existe dans QGIS des projections nationales pour la Jamaïque, vous pouvez faire
une recherche dans les SCR proposés.
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Cliquez sur l'icône de sphère tout en bas à droite de la fenêtre de QGIS :

Tapez jamaica dans la rubrique Filtre : plusieurs réponses sont proposées, dont 3 SCR
projetés. Une rapide recherche internet semble indiquer que le SCR JAD2001 est le plus récent
(source : http://www.jamaicancaves.org/jad2001.htm [↗]). C'est donc ce SCR que nous
utiliserons.

Sélectionnez JAD2001 (code EPSG:3448) et cliquez sur OK.

Nous venons de changer le SCR du projet, mais pas celui de notre raster (pour rappel : cf. partie
II.3).

Une étape préliminaire avant de projeter le raster : ouvrez les propriétés du raster, rubrique
Métadonnées, et dans le bas de la fenêtre, en faisant déDler les propriétés, recherchez
Aucune valeur de données. Vous devriez avoir -32768, notez cette valeur. C'est celle utilisée
pour les pixels « sans valeur » (qui ont donc en réalité la valeur -32768), en-dehors de l'île.
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Ensuite, pour changer le SCR du raster : :

Fichier source : sélectionnez srtm_jamaique dans la liste

Fichier en sortie : cliquez sur Sélection..., choisissez l'emplacement de la couche qui
sera créée et tapez son nom : srtm_jamaique_JAD2001 par exemple

SCR source :  vériDez que cette case soit cochée, et que le SCR actuel de la couche
(WGS84, code EPSG:4326) soit bien sélectionné

SCR cible :  cochez cette case, et cliquez sur Sélection pour rechercher le SCR JAD2001
code EPSG:3448

Données sans valeur :  tapez la valeur notée précédemment : -32768

Charger dans la carte une fois terminé :  cochez cette case

Laissez les autres paramètres par défaut, cliquez sur OK.

Patientez... La nouvelle couche est ajoutée, vous pouvez vériDer dans ses propriétés (rubrique
Général) que son SCR est bien le JAD2001.

Menu Raster → Projections → Reprojection 
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Supprimez les autres couches, pour ne garder dans le projet que la couche
srtm_jamaique_JAD2001.

Calcul de pente à partir du raster projeté

Rendez-vous dans le :Menu Raster → Analyse → MNT/DEM (Modèles de terrain) 
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Fichier source : sélectionnez srtm_jamaique_JAD2001

Fichier en sortie : cliquez sur Sélection... et sélectionnez l'emplacement de la couche
qui sera créée, tapez son nom : pente_jamaique_JAD2001

Mode : choisir Pente dans la liste déroulante

Cochez la case Charger dans la carte une fois terminé

Laissez les autres paramètres par défaut (pour plus d'infos sur les méthodes de
Zevenberger & Thorne et Horn : http://www.macaulay.ac.uk/LADSS/documents/DEMs-
for-spatial-modelling.pdf [↗], pp. 12 et 13).
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Cliquez sur OK, patientez... la couche s'affiche :

Ici, les pixels sombres représentent des pentes faibles et les pixels clairs de fortes pentes.

En cliquant sur un pixel avec l'outil Identi@er les entités, vous pouvez connaître la
valeur de la pente pour ce pixel :

Ici, le pixel a une pente de 13,5° environ.
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IX.3 Analyse spatiale : croisement de données vecteur et
raster

Préparation des données : un seul SCR pour tous
Trouver l'outil : installation d'une extension
Calcul de pente pour chacun des points d'une couche

Pour compléter ce chapitre, voici un exemple d'analyse mettant en jeu données vecteur et raster :
en partant d'une couche de pente, et d'une couche de points représentant des échantillons, nous
allons calculer la valeur de la pente pour chacun des échantillons.

Préparation des données : un seul SCR pour tous

Ouvrez un nouveau projet QGIS, ajoutez-y la couche créée en IX.2.3
pente_jamaique_JAD2001.tif.

Ajoutez également la couche echantillons_jam fournie dans le dossier
TutoQGIS_09_AnalyseSpat/donnees.

Sauvegardez la couche echantillons_jam avec le SCR JAD2001 EPSG:3448, sous le nom
echantillons_jam_JAD2001. Référez-vous si nécessaire à la partie II.4.2. Ajoutez cette couche à
QGIS.

Trouver l'outil : installation d'une extension

Comment faire pour donner à chacun des points sa valeur de pente ?

Il ne semble pas y avoir d'outil correspondant dans les menus vecteur et raster de QGIS. L'étape
suivante est donc de faire une recherche parmi les extensions disponibles (ou bien dans un
moteur de recherche, avec par exemple « qgis raster point value » comme mots clés).

La couche pente_jamaique_JAD2001.tif est en JAD2001 EPSG:3448  et la couche
echantillons_jam en WGS84 EPSG:4326.

Dans quel(s) SCR sont ces deux couches ?

Il est possible soit de changer le SCR du raster, soit de changer le SCR du vecteur. Néanmoins, le
temps de calcul est généralement moins long lorsqu'il s'agit de modiJer le SCR d'une couche
vecteur, en particulier pour une couche de points.

Comment vous-y prendriez-vous pour passer ces deux couches dans le même SCR ?
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Rendez-vous dans le menu Extension → Installer/gérer les extensions  :

Dans la rubrique En obtenir plus, tapez sampling dans la partie Dltre : plusieurs extensions
sont trouvées. Lisez leurs descriptifs ; Point sampling tool  semble correspondre à notre
besoin. Installez cette extension.

Fermez la fenêtre du gestionnaire d'extensions.

Calcul de pente pour chacun des points d'une couche

Point sampling tool est accessible soit via l'icône correspondante, soit via le menu
.

Onglet General :

Extension → Analyses → Point sampling tool 
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Layer containing sampling points :  vériDez que echantillons_jam_2001 soit bien
sélectionnée dans la liste

Layer with @elds/bands to get values from :  il s'agit des couches dans les attributs
seront repris dans la nouvelle couche. Faites bien attention à sélectionner les deux
couches, pour garder à la fois les identifiants des points et leur pente

Output point vector layer :  cliquez sur Parcourir, sélectionnez l'emplacement où la
couche de points sera créée, tapez son nom : echantillons_jam_pente_JAD2001

Add created layer to the TOC :  vériDez que cette case soit cochée pour ajouter
directement la couche créée à QGIS

Avant de cliquer sur OK, passez à l'onglet Champs :
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Si vous avez bien sélectionné les deux couches dans l'onglet général, vous voyez ici les champs
de ces deux couches : id pour les points, et la pente pour le raster. Vous pouvez renommer les
champs qui seront créés : renommez par exemple pente_jama en pente.

Pour terminer, cliquez sur OK, fermez la fenêtre de l'extension.

VériDez que la nouvelle couche contienne bien les mêmes 22 points
qu'echantillons_jam_2001.

Ouvrez sa table attributaire : les 2 champs id et pente sont présents. La pente est renseignée
pour chacun des points.
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X. Représenter des données et le mettre en page

Nous verrons ici comment représenter des données dans QGIS : quels types de cartes sont
possibles, quelles en sont les limites, et comment mettre en page une carte.

Notions abordées :

symboles proportionnels
cartes choroplèthes
cartes en semis de points
mise en page de cartes (composeur d'impression)

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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X . 1 Représenter des données : diRérentes méthodes
adaptées à diRérents cas

Représenter des quantités ou des effectifs : carte en symboles proportionnels
Créer une couche de points à partir d'une couche de polygones
Faire varier la taille de points en fonction d'un champ

Représenter des variables relatives à des surfaces : cartes choroplèthes
Créer un champ de densité de population
Faire varier la couleur des communes en fonction du champ densité

Représenter des quantités ou des effectifs : cartes en semis de points

Il existe de nombreuses manières de représenter les données, nous en verrons seulement
quelques unes ici.

A partir d'une couche de communes et leur population, nous allons voir diGérentes manières de
visualiser cette population.

Ouvrez un nouveau projet QGIS, ajoutez la couche COMMUNE.SHP située dans le dossier
TutoQGIS_10_representation/donnees.

Représenter des quantités ou des eRectifs : carte en symboles
proportionnels

Les cartes en symbole proportionnels permettent la représentation de quantités ou d'eGectifs par
des symboles, généralement des cercles. La surface des symboles sera proportionnelle à la
quantité ou l'effectif.

Créer une couche de points à partir d'une couche de polygones

Dans QGIS, la visualisation de données sous forme de cercles proportionnels nécessite une couche
de points. A partir de la couche de communes, nous allons créer les centroïdes (barycentres) des
communes.

Menu Vecteurs → Outils de géométrie → Centroïdes de polygones
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Couche vecteur de polygones en entrée : choisir la couche COMMUNE

Fichier de points en sortie :  cliquez sur Parcourir, allez à l'emplacement où vous voulez
créer la couche de centroïdes et donnez-lui un nom : communes_centroides

Cliquez sur OK

La couche de centroïdes est ajoutée à QGIS : un point a été créé par commune.

Faire varier la taille de points en fonction d'un champ

Il est ensuite possible de faire varier la taille des centroïdes des communes en fonction d'un
champ, ou d'une expression :

Ouvrez les propriétés de la couche de communes → rubrique Style → bouton Avancé  tout
en bas à droite :
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Appliquez les changements ; si les cercles sont trop gros, 2 possibilités :

réduire la taille du symbole
dans le champ de proportion, au lieu de sélectionner POPULATION, sélectionnez -
expression- et tapez par exemple POPULATION / 10

Le mode Expression est disponible depuis la version 2.2 de QGIS.

En jouant sur ces 2 paramètres, vous devriez pouvoir obtenir une visualisation correcte de la
population à l'échelle d'un département ou d'une région (à l'échelle du pays, cela nécessiterait
d'agréger les cercles entre eux pour un meilleur rendu). Vous avez à votre disposition la couche
DEPARTEMENT dans le dossier TutoQGiS_10_Reprentation/donnees.

Comme vous l'avez peut-être remarqué, QGIS a@che les cercles dans l'ordre de la table ; il peut
donc arriver que de petits cercles soient masqués par de plus gros cercles. Pour corriger cela :
Propriétés de la couche de centroïdes → rubrique Général → Constructeur de requête

Tapez la requête : 1=1 ORDER BY POPULATION DESC

Malheureusement, QGIS ne gère pas la légende pour ce type de cartes. Il existe pour cela un outil
disponible ici : http://www.qgis.nl/2012/02/03/legenda-maken-met-legendsvg/?lang=en [↗]

Vous aurez noté que si QGIS permet une visualisation des données sous forme de cercles
proportionnels, cela reste peu adapté à la production de cartes, notamment à cause de l'absence
de légende.

Cliquez sur ce bouton → Champ de proportion → POPULATION
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Représenter des variables relatives à des surfaces : cartes
choroplèthes

Une carte choroplèthe est une carte en aplats de couleurs. Les régions sont colorées selon une
mesure statistique telle que la densité de population ou le revenu par habitant. Ce type de carte
ne peut donc être utilisé pour représenter des quantités ou des eGectifs. Les variables continues
doivent être discrétisées pour produire des classes.

Créer un champ de densité de population

La première étape consistera pour nous à créer un champ densité de population, rempli en
fonction de la population et la surface.

Ouvrez la table attributaire de COMMUNE, passez en mode édition et ouvrez la calculatrice de
champ.

Calculez dans un nouveau champ nommé densite de type décimal la densité de population en
nombre d'habitants par km² .

Quittez le mode édition.

Par exemple ( "POPULATION" * 1000 ) / ( "SUPERFICIE" / 100 ), ou encore ( "POPULATION" *
1000 ) / ( $area / 1000000 )

Sachant que la population est exprimée en milliers d'habitants et la superDcie en hectares,
quelle formule utiliser pour cela ?
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Faire varier la couleur des communes en fonction du champ densité

Maintenant que ce champ est créé et à jour, il est possible de faire varier la couleur des communes
en fonction de la densité.

Pour faire varier la couleur des communes en fonction de la densité :

Propriétés de la couche COMMUNE → rubrique Style

Sélectionnez le style Gradué en fonction de la colonne densite.

Choisissez un nombre de classes et une méthode de discrétisation.

Cliquez sur Classer et appliquez les changements.

Pour un meilleur rendu, vous pouvez supprimer les bordures des communes en cliquant sur
Modification... puis sur Remplissage simple → Style de la bordure → Pas de crayon .

Pour voir l'effectif de chaque classe, clic droit sur le nom de la couche → Montrer le décompte
des entités.

Testez différents modes de discrétisation et nombres de classes.
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Représenter des quantités ou des eRectifs : cartes en semis de
points

Une carte en semis de points permet, à partir d'un maillage surfacique, de représenter des
quantités ou eGectifs par des points placés aléatoirement au sein de chaque polygone. Le nombre
de ces points est proportionnel à la quantité ou l'effectif lié au polygone.

Nous allons créer ces points aléatoires en fonction du champ POPULATION. Ce champ étant
décimal avec un chiGre après la virgule, nous allons le multiplier par 10 pour obtenir des nombres
entiers (il n'est pas possible de créer 0,7 points dans un polygone...).

Ajoutez un champ nommé POP10, de type entier, égal à 10 fois le champ POPULATION.
N'oubliez pas de quitter le mode édition une fois l'opération terminée.

Pour créer les points aléatoires :

menu Vecteur → Outils de recherche → Points aléatoires
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Couche en entrée : COMMUNE

Taille d'échantillon : utiliser la valeur du champ POP10

Fichier de sortie : cliquez sur Parcourir, sélectionnez l'emplacement et tapez le nom de
la couche qui sera créée : points_aleatoires_communes par exemple

Ajouter le résultat au canevas de la carte

OK, patientez, l'opération est un peu longue... et fermez la fenêtre une fois terminé.

Ajustez le style de la couche, par exemple à l'échelle du pays :
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Nous avons vu ici trois manières de représenter une même donnée : la population des
communes. Il en existe beaucoup d'autres.

Dans le chapitre suivant, nous aborderons la mise en page de cartes aDn par exemple de pouvoir
les intégrer dans un article : ajout d'un titre, d'une légende... et export au format image ou
vectoriel. L'export au format vectoriel vous permettra de retravailler la carte dans un logiciel de
dessin vectoriel.
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X.2 Mettre en page une carte

Préparation de la mise en page
Mise en page : le composeur d'impression

Créer une carte sur une page au format de votre choix
Paramétrer la légende
Paramétrer l'échelle
Ajout d'éléments supplémentaires : titre, logo, flèche nord...
Exporter la carte

Sauvegarder une mise en page

Une fois vos données représentées de manière satisfaisante, il peut être utile d'en faire une carte.
Cette partie n'a pas pour but d'expliquer les bonnes et mauvaises pratiques en matière de
cartographie, mais se bornera à décrire quelques fonctionnalités du mode mise en page de QGIS.

L'exercice consistera ici à mettre en page une carte de la densité de population par communes
(carte choroplèthe) en France.

Préparation de la mise en page

Commencez par ajouter toutes les couches dont vous avez besoin, et supprimez toutes les
couches inutiles.

Choisissez le style de chacune des couches.

N'oubliez pas également de choisir un SCR adapté pour votre projet (projeté si vous souhaitez
créer une échelle en mètres par exemple) (cf. Modifier le SCR du projet).

Mise en page : le composeur d'impression

Le mode mise en page se nomme composeur d'impression dans QGIS. C'est dans le composeur
d'impression que vous pourrez ajouter une échelle, un titre etc. à votre carte.

Tapez un titre, par exemple densité communes.

Le principe du composeur d'impression est simple : l'onglet Composition permet de Dxer les
paramètres de la page (format A4, paysage ou portrait...), et l'onglet Propriétés de l'objet  les
paramètres de l'objet actuellement sélectionné.

Menu Projet → Nouveau composeur d'impression
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Créer une carte sur une page au format de votre choix

La première étape consiste à déterminer les dimensions de la page dans l'onglet composition. S'il
s'agit d'une Dgure destinée à être intégrée dans un rapport, vous pouvez très bien choisir une
taille personnalisée, par exemple 15 x 15 cm.

Dans l'onglet Composition → Options du papier , choisissez Personnalisation au lieu de A4.
Fixez ensuite la largeur et la hauteur à 150 mm.

Cliquez ensuite sur l'icône Ajouter une nouvelle carte (ou menu Mise en page →
Ajouter une carte).

Dessinez un rectangle n'importe où sur la page, de la taille que vous voulez. Puis rendez-vous
dans l'onglet Propriétés de l'objet, rubrique Position et taille, et Dxez X et Y à 0 et la largeur et
hauteur à 150 mm pour que la carte coïncide avec la page.

La carte ainsi créée est synchronisée avec les données visibles dans QGIS  : si vous changer le
style d'une des couches dans la fenêtre principale de QGIS et revenez au composeur, la carte aura
été mise à jour (si besoin en cliquant sur le bouton actualiser).

Pour centrer la carte  : cliquez sur l'icône Déplacer le contenu de l'objet  et faites
glisser le contenu de la carte.

Pour zoomer et dézoomer : modifiez l'échelle dans les propriétés de la carte.
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Paramétrer la légende

Pour ajouter une légende : icône Ajouter une nouvelle légende , puis cliquez
n’importe où sur la carte.

La légende reprend celle de la couche dans QGIS : si vous modiDez les étiquettes de la légende
dans la propriété de la couche, la légende du composeur prendra en compte ces modifications.

Dans la fenêtre principale de QGIS, ouvrez les propriétés de la couche, rubrique Style. Vous
pouvez :

Modifier les bornes des classes en double-cliquant sur une ligne dans la colonne valeur

Modi@er l'étiquette des classes  en double-cliquant sur une ligne dans la colonne
étiquette

Revenez ensuite dans le composeur et cliquez sur votre légende avec l'outil
Sélectionner / Déplacer un objet .
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Pour prendre en compte les modiDcations que vous venez d'eGectuer, dans l'onglet propriétés
de l'objet, rubrique Objets de légende , cliquez sur le bouton Mettre à jour l'objet.

Vous pouvez également modi@er les étiquettes directement dans la légende , en
cliquant sur une ligne puis sur le bouton d'édition.

Il est possible de cacher par exemple le titre de la couche : dans la deuxième colonne de la
ligne du nom de la couche, choisissez Cachée au lieu de Sous-groupe.

Voici une dernière astuce (à vous d'en trouver d'autres !) pour faire un retour à la ligne , dans
le titre par exemple. Dans la case Activer le retour à la ligne après , tapez un caractère dont
vous ne vous servez habituellement pas, par exemple $. Ce caractère ne sera pas représenté
mais provoquera un retour à la ligne.

Dans la case Titre, tapez le titre souhaité pour votre légende, avec un $ quand vous souhaitez
passer à la ligne : Densité population$nb habitants / km² par exemple.

Le $ provoquera également une retour à la ligne pour les autres objets de la légende (étiquettes, nom de la
couche...).

N'hésitez pas à explorer les autres rubriques des propriétés de la légende.

Un exemple de légende :
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Paramétrer l'échelle

Pour ajouter une échelle : outil Ajouter une nouvelle échelle graphique  puis cliquez
sur la carte.

Comme pour la légende, il est possible de régler assez Dnement les diGérents paramètres de
cette échelle.

Par exemple, si vous voulez une échelle en Km, indiquez d'abord l'unité des de votre projet : le
mètre (votre projet doit utiliser un SCR projeté), puis tapez 1000 dans la case Unités de carte
par unité de l'échelle graphique.

Vous pouvez également régler le nombre de segments de l'échelle, et la largeur du trait :

DiGérents styles d'échelle peuvent être choisis dans la rubrique Propriétés principales de
l'échelle :
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Voici quelques exemples d'échelle :

  

Ajout d'éléments supplémentaires : titre, logo, flèche nord...

Pour ajouter du texte, par exemple un titre, les sources, l'auteur... : outil Ajouter une
étiquette.

Dans les propriétés de cet objet, vous pouvez ensuite modifier le texte, la police, la couleur...

Si vous voulez ajouter une image, par exemple un logo : outil Ajouter une image  puis cliquez
sur la carte.

Dans les propriétés principales, choisissez ensuite une image sur votre ordinateur :

Par convention, le Nord est situé en haut de votre carte. Ajouter une dèche Nord si tel est bien le
cas n'est donc pas indispensable et peut même alourdir inutilement votre carte et donc nuire à sa
lisibilité.

Peut-être avez-vous néanmoins besoin d'une dèche Nord, par exemple si le Nord n'est pas en
haut de votre carte ?

Dans ce cas, utilisez également l'outil Ajouter une image  et choisissez comme image un
symbole de dèche Nord. Pour cela, vous pouvez utiliser la bibliothèque de symboles de QGIS,
dans la rubrique Rechercher dans les répertoires.
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Il est possible d'ajouter de nouveaux symboles au format SVG à cette bibliothèque, au moyen du bouton
Ajouter...

Pour synchroniser votre dèche Nord avec votre carte, aDn que cette dèche indique toujours le
Nord : cocher la case Synchroniser avec la carte dans la rubrique Image rotation.

Pour régler la rotation de la carte, dans les propriétés principales de la carte, réglez le paramètre Map
rotation.

Vous pouvez également ajouter une deuxième carte à votre page, qui servira par exemple de
carte de situation.

Ajouter une carte, réglez son emprise et son échelle, et allez dans la rubrique Aperçu des
propriétés de cette carte, pour visualiser l'emprise de votre première carte :
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Il peut être nécessaire de choisir les bonnes couches pour une des cartes dans QGIS, mettre à jour cette carte
dans le composeur puis cocher la case Verrouiller les couches pour cette carte avant de faire la même
chose pour l'autre carte.

De manière générale, si vous avez plusieurs cartes, la manière la plus facile de les gérer est peut-être de créer
un groupe de couches par carte dans QGIS, quitte à dupliquer certaines couches.

Exporter la carte

Vous êtes satisfait de votre carte ? Voici venu le moment de l'exporter !

Vous pouvez soit l' exporter au format image  (PNG, JPG) pour l'intégrer directement dans un
rapport par exemple, soit l'exporter au format vectoriel  SVG ou PDF pour la retravailler dans un
logiciel de dessin type Inkscape ou Adobe Illustrator. Vous pouvez également l'imprimer
directement !

Pour exporter au format image  : vous pouvez tout d'abord paramétrer la résolution à
laquelle votre carte sera exportée : onglet Composition, Options du papier :
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On considère généralement qu'une résolution de 300 dpi est sugsante pour une impression. Pour en savoir
plus sur ce qu'est la résolution d'une image :
http://fr.wikipedia.org/wiki/R%C3%A9solution_%28imagerie_num%C3%A9rique%29 [↗]

Pour ensuite exporter votre mise en page au format image : à partir du composeur,
menu Composeur → Exporter comme image...

De nombreux formats sont disponibles : PNG, JPEG, TIFF, EPS...

Pour exporter au format SVG  : à partir du composeur, menu Composeur → Exporter
au format SVG...

Pour imprimer la carte : à partir du composeur, menu Composeur → Imprimer...  ou
bien Ctrl + P

L'export au format SVG peut poser quelques problèmes, en particulier pour gérer la transparence.
L'export au format PDF peut parfois être plus pratique pour ensuite retoucher la carte dans un
logiciel de dessin.

Un exemple de carte réalisée dans QGIS :
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A noter également, l'existence d'un module permettant la génération d'atlas  (il s'agit du
troisième onglet dans le composeur d'impression). Ce module est décrit dans le manuel QGIS [↗],
ou bien ici [↗] (en anglais).

Sauvegarder une mise en page

Dans QGIS, les mises en page sont sauvegardées dans les projets QGS. Pour sauvegarder votre
mise en page, il vous suffit donc de sauvegarder votre projet.

Dans la fenêtre principale de QGIS, rendez-vous dans le menu Projet → Sauvegarder sous... .

Choisissez un emplacement : dossier TutoQGIS_10_Representation/projets par exemple, et
un nom : carte_densite_01 par exemple.
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XI. Automatisation de traitements

Cette onzième partie vous permettra d'aller plus loin dans votre utilisation de QGIS. Le but est ici
de voir comment automatiser des traitements sous QGIS : par exemple, au lieu de découper une
couche par une autre au moyen de l'outil découper, vous avez 30 couches à découper par une
même autre.

Nous allons utiliser 3 méthodes différentes pour cela.

Notions abordées :

Exécution d'un outil "par lot"
Modeleur de traitement (graphical modeler)
script Python

Les données pour cette partie ainsi qu'une version PDF du tutoriel sont accessibles dans la
rubrique téléchargement.
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X.1 Traitement de base pour une seule couche

Il s'agit ici d'un rappel de la manipulation à eGectuer pour découper une couche par une autre ;
c'est ce traitement que nous allons ensuite automatiser.

Lancer QGIS et ouvrir le projet visualisation.qgs situé dans
TutoQGIS_11_automatisation/projets.

Vérifier que toutes les couches aient bien le même SCR.

Pour découper la couche de routes par la commune : menu Vecteur → Outils de
géotraitement → Découper

Une nouvelle couche est créée, qui ne contient que les portions de routes à l'intérieur de la
commune.

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 225/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/11_01_decouper_fenetre.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


XI.2 Exécuter un outil « par lot »

L'outil de découpage utilisé en XI.1 est accessible via le menu vecteur. Vous pouvez également
utiliser la version disponible dans la boîte à outils Traitements. Cette boîte à outils rend accessible
un grand nombre d'algorithmes, issus de QGIS ou d'autres logiciels SIG ou de télédétection, tels
que Grass, SAGA, OrfeoToolbox...

Pour activer cette boîte à outils : menu .

L'outil QGIS Clip se trouve dans Géotraitements QGIS → Vector overlay tools .

Vous pouvez également taper Clip dans la partie Rechercher en haut de la boîte à outils.

Il peut être plus pratique de choisir le mode Advanced interface dans la liste déroulante en bas de la boîte.

Si vous double-cliquez sur l'outil pour le lancer, une fenêtre similaire à celle utilisée en XI.1
s'ouvre (fermez cette fenêtre sans lancer l'outil).

Il est également possible d'utiliser l'outil en mode « par lot » : clic droit sur Clip, Exécuter par
lot. Dans la fenêtre qui s'ouvre, chaque ligne correspond à une instance de l'outil . Chaque
colonne correspond à un paramètre : la 1ère colonne à la couche en entrée, la 2ème à la

Traitement → Boîte à outils 
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couche de découpage (masque), la 3ème à la couche qui sera créée.

Pour remplir chacune des colonnes :

Input layer : cliquer sur les … de la première ligne → 
et cochez les 4 couches OSM à découper (si ces couches n'étaient pas chargées

dans QGIS, utiliser l'option Sélectionner depuis le système de fichiers).

Clip layer : comme précédemment, cliquer sur les … de la première ligne →
Sélectionner depuis les couches ouvertes  et cocher SAINTE_RADEGONDE. La
première ligne est maintenant remplie. Pour remplir toutes les lignes de manière
identique : double-cliquez sur l'en-tête de colonne Clip layer.

Clipped : cliquer sur les …, rendez-vous dans le dossier où vous voulez créer les
nouvelles couches, tapez decoupe_.shp et positionnez le curseur entre le « _ » et le « . »
et cliquer sur . Dans la fenêtre suivante : choisir Remplir avec les valeurs du
paramètre, Input Layer, aDn que le nom de chaque couche qui sera créée soit
complété par le nom de la couche OSM de départ.

Au final, vous devez obtenir quelque chose de similaire à ceci :

Cliquer sur Run, patienter… Les 4 couches sont créées et ajoutées à QGIS. Il est possible
qu'elles soient toute nommées « Clipped ». Dans ce cas, vous pouvez les supprimer et les
rajouter.

Tous les outils de la boîte Traitements sont exécutables par lot.

Sélectionner depuis les couches
ouvertes 

Enregistrer 

Tutoriel QGIS UMR 5185 ADESS, CNRS - http://www.ades.cnrs.fr/tutoqgis/ 227/240

Ce tutoriel est mis à disposition selon les termes de la Licence Creative Commons Attribution 4.0 International

illustrations/tous/11_02_lot_complet.png
http://www.ades.cnrs.fr/tutoqgis/
http://www.ades.cnrs.fr/
http://creativecommons.org/licenses/by/4.0/deed.fr
http://creativecommons.org/licenses/by/4.0/deed.fr


XI.3 Construire et utiliser un modèle

Création d'un modèle
Création du premier paramètre en entrée : couche à découper
Création du deuxième paramètre en entrée : masque de découpe
Création du premier algorithme : découpage
Création du second algorithme : modification du SCR

Enregistrement et édition du modèle
Application

Découpage et reprojection d'une couche
Découpage et reprojection de plusieurs couches (utilisation « par lot »)

Les modèles sont surtout utiles pour chaîner plusieurs traitements. Par exemple, imaginons que
notre but soit non seulement de découper une couche par une autre, mais ensuite de changer le
SCR de la couche découpée pour la passer en WGS84 par exemple. Il est possible de créer un
modèle enchaînant les deux outils.

Dans la boîte à outils Traitements, rubrique Modèles puis Outils, double-cliquez sur Créer un
nouveau modèle.

La fenêtre qui s'ouvre comporte une partie à gauche avec 2 onglets, Entrées et Algorithmes, qui
vont vous servir à créer le modèle, et une partie vide à droite où votre modèle sera représenté.

Notre modèle comportera 2 paramètres en entrée : une couche vecteur qui sera découpée et une
couche vecteur qui servira de masque de découpe. L'outil de découpage va utiliser ces deux
paramètres en entrée pour créer une nouvelle couche temporaire. Cette couche temporaire sera
utilisée comme paramètre d'entrée pour l'outil de reprojection, qui produira la couche finale.
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Création d'un modèle

Création du premier paramètre en entrée : couche à découper

Dans l'onglet Entrées, double-cliquez sur Vector layer :

Nom du paramètre : input layer
Type de forme : N'importe lequel, puisque cette couche peut aussi bien être de type
point, ligne ou polygone
Requis : oui, ce paramètre est obligatoire

Le paramètre est ajouté au modèle sous forme d'une boîte violette. Vous pouvez éditer ses
caractéristiques en cliquant sur l'icône de crayon de cette boîte.
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Création du deuxième paramètre en entrée : masque de découpe

Dans l'onglet Entrées, double-cliquez à nouveau sur Vector layer :

Nom du paramètre : mask layer
Type de forme : polygone
Requis : oui, ce paramètre est obligatoire

Création du premier algorithme : découpage

Dans l'onglet Algorithmes, double-cliquez sur l'outil Clip (Géotraitements QGIS → Vector overlay
tools → Clip) :
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Description : Clip
Couche en entrée : input layer
Couche de découpage : mask layer
Découpé<OutputVector> : ne rentrez rien dans cette partie, pour que la couche créée
soit temporaire

L'algorithme apparaît sous forme d'une boîte blanche ; de même, vous pouvez éditer ses
caractéristiques en cliquant sur l'icône de crayon de cette boîte.

Création du second algorithme : modification du SCR

Toujours dans la fenêtre du modeleur de traitement, onglet Algorithmes, double-cliquez sur
l'outil Reproject layer (Géotraitements QGIS → Vector general tools → Reproject layer) :
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Description : Reproject layer
Couche en entrée : 'Découpé' créé par l'algorithme 'Clip'
Target CRS : laissez EPSG:4326, ce qui correspond au WGS84
Reprojected<OutputVector> : result

Enregistrement et édition du modèle

Vous devriez obtenir quelque chose de similaire à ceci :
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Pour sauvegarder ce modèle, tapez d'abord son nom en haut à gauche de la partie droite de
la fenêtre (clip and project  par exemple) et le nom de son groupe en haut à droite de la partie
droite de la fenêtre (tests par exemple).

Cliquez ensuite sur l'icône de disquette et sauvegardez le modèle dans le répertoire par défaut
: processing/models dans le dossier qgis. Notez que les modèles ont l'extension .model.

Pour éditer un modèle à partir de la boîte à outils de traitements, clic droit sur son nom,
Editer modèle.
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Application

Découpage et reprojection d'une couche

L'objectif est de découper une couche de routes par une commune, pour ne garder que les routes
à l'intérieur de cette commune, la couche obtenue devant être en WGS84.

Ajoutez à QGIS les couches OSM_routes et SAINTE_RADEGONDE situées dans le dossier
TutoQGIS_11_Automatisation/donnees.

Lancer le modèle clip and project  : vous pouvez soit cliquer sur l'icône d'engrenages du
modeleur de traitement si ce modèle est en cours d'édition, soit à partir de la boîte à outils
traitements : Modèles → tests → clip and project .

Les 2 couches sont en RGF93 Lambert 93, code EPSG 2154 (cf. partie II.3.2 : SCR d'une couche ).

Dans quel SCR sont ces deux couches ?
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input layer : OSM_routes

mask layer : SAINTE_RADEGONDE

result : cliquez sur les ..., choisir Enregistrer dans un @chier..., choisir l'emplacement et
nommez la future couche OSM_route_radegonde_wgs84

cochez la case Ouvrir le @chier en sortie après l'exécution de l'algorithme  pour que
la couche soit automatiquement ajoutée à QGIS

VériDez le SCR de la couche obtenue, ainsi que son contenu : elle ne doit comporter que les
routes à l'intérieur de la commune de Sainte-Radégonde (en gris foncé dans la Dgure ci-
dessous).
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Découpage et reprojection de plusieurs couches (utilisation « par lot »)

Le but est ici de découper et reprojeter plusieurs couches, sans avoir à lancer plusieurs fois le
modèle.

A partir de la boîte à outils de traitements, clic droit sur le modèle clip and project, Exécuter
par lot. Remplissez les différents paramètres, en vous aidant éventuellement de la partie XI.2.

Vérifiez les couches obtenues.
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XI.4 Comprendre et lancer un script Python

Lancer une commande Python dans QGIS
Ouvrir un script Python
Paramétrer le script
Lancer le script

Chaque manipulation que nous faisons dans QGIS via l'interface graphique (ajouter une couche,
découper une couche etc.) peut également être faite sous forme d'une ligne de commande dans le
langage Python [↗].

Par exemple, pour ajouter la couche SAINTE_RADEGONDE.shp, située dans le dossier
/mnt/travail/temp, vous pouvez soit l'ajouter à la main comme nous l'avons fait jusqu'ici, soit taper
la commande Python suivante :

qgis.utils.iface.addVectorLayer("/mnt/travail/temp/SAINTE_RADEGONDE.shp",
"SAINTE_RADEGONDE", "ogr")

Ce qui revient à lancer l'outil d'ajout de couche vecteur addVectorLayer de QGIS, avec 3
paramètres :

l'emplacement de la couche : /mnt/travail/temp/SAINTE_RADEGONDE.shp
le nom avec lequel la couche sera affichée dans QGIS : SAINTE_RADEGONDE
le nom du fournisseur de données : ogr car QGIS utilise en interne une bibliothèque [↗]
nommée ogr pour accéder aux shapefiles

Nous allons ici ouvrir un script Python existant qui découpe et reprojette en WGS84 toutes les
couches shapeDles présentes dans un même dossier. Sans rentrer dans le détail, nous verrons
comment est constitué ce script, comment le paramétrer et le lancer.

Lancer une commande Python dans QGIS

Rendez-vous dans le menu Extension → Console Python .

La console s'ouvre en bas de la fenêtre de QGIS. Dans cette console, vous pouvez taper des
commandes Python qui seront exécutées une à une.

Tapez print ('hello !') en bas de la console :
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Puis appuyez sur la touche entrée. Vous devriez voir votre commande, suivie du résultat, en
haut de la console :

Vous venez d’utiliser la commande Print, qui permet d'a@cher du texte dans la console. Vous
pouvez également tester la commande citée plus haut pour ajouter une couche vecteur :

qgis.utils.iface.addVectorLayer("/mnt/travail/temp/SAINTE_RADEGONDE.shp",
"SAINTE_RADEGONDE", "ogr")

En adaptant le chemin vers la couche.

Il est possible de travailler uniquement en lançant ainsi des commandes une à une ; seulement, les
commandes utilisées ne seront pas sauvegardées et ne pourront donc être réutilisées sans tout
retaper à la main (même s'il est possible de faire déDler les dernières commandes utilisées en
appuyant sur la touche flèche haut du clavier).

Ouvrir un script Python

Pour sauvegarder et réutiliser facilement votre travail, le plus simple est d'utiliser ce qu'on appelle
un script. Il s'agit simplement d'un Dchier texte comportant une suite de commandes, et qui porte
l'extension PY puisqu'il s'agit d'un script Python.

Cette formation n'étant pas une formation Python, nous nous contenterons d'ouvrir un script
existant plutôt que d'en créer un nous-mêmes.
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Pour ouvrir un script : cliquez sur l'icône Ahcher l'éditeur  de la console : l'éditeur de script
s'ouvre.

Dans l'éditeur, cliquez sur l'icône Ouvrir fichier (celle du haut) et allez chercher le script
clip_and_reproject.py situé dans TutoQGIS_11_Automatisation/scripts.

N'hésitez pas à agrandir la partie consacrée à la console dans QGIS, au détriment de la fenêtre
de visualisation des données.

Lisez le contenu du script. Les lignes commençant par un # sont des commentaires : leur
contenu ne sera pas pris en compte, ils sont uniquement utiles pour mieux comprendre le
script.

L'objectif n'est pas de comprendre dans le détail tout ce que fait ce script, mais de comprendre
globalement ce qui s'y passe, notamment au moyen des commentaires. Il s'agit ici d'un script
faisant le même travail que le modèle que vous avez réalisé en XI.3 en mode par lot, à savoir
découper plusieurs couches par une même couche et reprojeter les couches obtenues en WGS84.

Paramétrer le script

Au début du script, vous trouverez ces lignes :

Il s'agit des paramètres en entrée et sortie du script :

input folder : le dossier où sont situées les couches à découper
mask layer : la couche qui servira de masque de découpe
output folder : le dossier où seront enregistrées les couches créées
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A vous de modifier ces paramètres suivant l'emplacement des données sur votre ordinateur !

Sur Windows, les chemins seront de la forme 'C:/…' par exemple.

Lancer le script

Pour lancer le script, cliquez sur l'icône Exécuter le script  en bas de l'éditeur (il est
possible que cette icône soit masquée et qu'il faille agrandir la console pour la voir
apparaître).

Vérifiez que tout ait bien fonctionné.

Quelles modifications apporter au script pour que :

Ligne 57, remplacer 'EPSG:4326' par 'EPSG:27572'. Vous pouvez également remplacer ligne 55
'_wgs84.shp' par '_ntfl2.shp' (il s'agit du suffixe qui sera ajouté au nom de la nouvelle couche).

les couches soient reprojetées non plus en WGS84 mais en NTF / Lambert zone II (code
EPSG 27572) ?

Dans la boîte à outils de traitements → géotraitements QGIS → Vector Overlay Tools, lancez l'outil
d'intersection et allez sur l'onglet Aide, rubrique Console usage. Notez le nom de l'algorithme ; puis
ligne 39 remplacez qgis:clip par ce nom : qgis:intersection.

au lieu de l'outil Clip de découpage, ce soit l'outil Intersection qui soit utilisé ?
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